EMC Information

FEDERAL COMMUNICATIONS COMMISSION INTERFERENCE STATEMENT

This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is operated in a commercial environment. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instruction manual, may cause harmful interference to radio communications. Operation of this equipment in a residential area is likely to cause harmful interference in which case the user will be required to correct the interference at his own expense.

FCC Caution: Any changes or modifications not expressly approved by the party responsible for compliance could void the user's authority to operate this equipment.

Warning: Operation of this equipment in a residential environment could cause radio interference.

KCC Statement

유선 제품용 / A 클래스 기기 (업무용 방송 통신 기기)
이 기기는 업무용 (A 클래스) 전자파적합기기로서 관제자 또는 사용자는 이 점을 주의하시기 바라며, 가정 외의 지역에서 사용하는 것을 목적으로 합니다.

RoHS

This product is RoHS compliant.

Safety

This product has been classified as Information Technology Equipment.
User Information

Online Registration
Be sure to register your product at our online support center:

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>International</td>
<td><a href="http://eservice.aten.com">http://eservice.aten.com</a></td>
</tr>
</tbody>
</table>

Telephone Support
For telephone support, call this number:

<table>
<thead>
<tr>
<th>Region</th>
<th>Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>International</td>
<td>886-2-8692-6959</td>
</tr>
<tr>
<td>China</td>
<td>86-400-810-0-810</td>
</tr>
<tr>
<td>Japan</td>
<td>81-3-5615-5811</td>
</tr>
<tr>
<td>Korea</td>
<td>82-2-467-6789</td>
</tr>
<tr>
<td>North America</td>
<td>1-888-999-ATEN ext 4988</td>
</tr>
<tr>
<td></td>
<td>1-949-428-1111</td>
</tr>
</tbody>
</table>

User Notice
All information, documentation, and specifications contained in this manual are subject to change without prior notification by the manufacturer. The manufacturer makes no representations or warranties, either expressed or implied, with respect to the contents hereof and specifically disclaims any warranties as to merchantability or fitness for any particular purpose. Any of the manufacturer's software described in this manual is sold or licensed as is. Should the programs prove defective following their purchase, the buyer (and not the manufacturer, its distributor, or its dealer), assumes the entire cost of all necessary servicing, repair and any incidental or consequential damages resulting from any defect in the software.

The manufacturer of this system is not responsible for any radio and/or TV interference caused by unauthorized modifications to this device. It is the responsibility of the user to correct such interference.

The manufacturer is not responsible for any damage incurred in the operation of this system if the correct operational voltage setting was not selected prior to operation. PLEASE VERIFY THAT THE VOLTAGE SETTING IS CORRECT BEFORE USE.
Product Information

For information about all ATEN products and how they can help you connect without limits, visit ATEN on the Web or contact an ATEN Authorized Reseller. Visit ATEN on the Web for a list of locations and telephone numbers:

<table>
<thead>
<tr>
<th>Region</th>
<th>Website</th>
</tr>
</thead>
<tbody>
<tr>
<td>International</td>
<td><a href="http://www.aten.com">http://www.aten.com</a></td>
</tr>
<tr>
<td>North America</td>
<td><a href="http://www.aten-usa.com">http://www.aten-usa.com</a></td>
</tr>
</tbody>
</table>
Contents

EMC Information ........................................... ii
Safety ....................................................... ii
User Information ........................................... iii
  Online Registration .................................... iii
  Telephone Support ..................................... iii
Product Information....................................... iv
Contents ..................................................... v
About this Manual ......................................... x
Terminology ................................................ xi
Conventions ................................................. xii
Package Contents .......................................... xiii
  VK0100 .................................................... xiii
  VK0200 .................................................... xiii
  VK1100 .................................................... xiii
  VK2100 .................................................... xiii

1. Introduction
  Overview ................................................. 1
  Benefits .................................................. 3
    Intelligent Control .................................. 3
  Features ................................................ 5
    ATEN Control Box .................................... 5
    ATEN Control Pad ..................................... 6
    ATEN Configurator ................................... 7
    ATEN Control System App ............................ 7
    ATEN Keypads ......................................... 8
  Requirements ........................................... 9
  Accessories ............................................. 10

2. Hardware Setup
  ATEN Control Box ....................................... 11
  Panel Components ...................................... 11
    VK2100 Front View .................................... 11
    VK2100 Rear View ..................................... 13
    VK1100 Front View ................................... 14
    VK1100 Rear View ..................................... 16
  Rack Mounting the ATEN Control Box .................... 17
    VK2100 ................................................ 17
    VK1100 ............................................... 18
  Control Box Connections ................................ 19
12 VDC Power Output ........................................... 23
Relay ............................................................... 27
IR / Serial ......................................................... 28
One IR Transmitter ............................................. 29
Two IR Transmitters ........................................... 29
Digital I/O .......................................................... 30
RS-232 ............................................................. 32
RS-232 / 422 / 485 ............................................... 33
Ethernet ............................................................ 34
ATEN Control Pad ............................................... 35
Panel Components .............................................. 35
LED Indications ................................................. 37
Installing the Control Pads .................................... 38
Installation Steps ............................................... 38
RS-232 Serial Connection .................................... 43
Relay Connections .............................................. 44
Digital Input Device ............................................ 45
Ethernet ............................................................ 46
Accessories .......................................................... 47
ATEN Expansion Box .......................................... 47
ATEN Keypad ...................................................... 48
Overview .......................................................... 48
Component ........................................................ 49
LED Indications .................................................. 50
Layout Examples ............................................... 51
Installing ATEN Keypad ....................................... 52

3. Browser Operation
Overview .......................................................... 57
Logging In .......................................................... 57
Dashboard .......................................................... 58
Settings ............................................................. 59
Licenses for Mobile Control .................................. 61
Storage .............................................................. 62
Access .............................................................. 63
Monitor .............................................................. 65
Network ............................................................ 66
Connections ....................................................... 67
Schedule ........................................................... 68
Security ............................................................. 69
## 4. ATEN Configurator (VK6000)

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview</td>
<td>71</td>
</tr>
<tr>
<td>Installation</td>
<td>71</td>
</tr>
<tr>
<td>Getting Started Tasks</td>
<td>74</td>
</tr>
<tr>
<td>Main Page</td>
<td>76</td>
</tr>
<tr>
<td>Menu Bar</td>
<td>78</td>
</tr>
<tr>
<td>Project</td>
<td>84</td>
</tr>
<tr>
<td>Device</td>
<td>86</td>
</tr>
<tr>
<td>Device Configuration List</td>
<td>87</td>
</tr>
<tr>
<td>Adding Devices to ATEN Configurator</td>
<td>88</td>
</tr>
<tr>
<td>Left Sidebar</td>
<td>90</td>
</tr>
<tr>
<td>Properties</td>
<td>91</td>
</tr>
<tr>
<td>Controller Properties</td>
<td>91</td>
</tr>
<tr>
<td>Expansion Box (Expander)</td>
<td>93</td>
</tr>
<tr>
<td>Serial Device Properties</td>
<td>94</td>
</tr>
<tr>
<td>I/O Device Properties</td>
<td>96</td>
</tr>
<tr>
<td>IR/Relay Device Properties</td>
<td>97</td>
</tr>
<tr>
<td>Ethernet Device Properties</td>
<td>98</td>
</tr>
<tr>
<td>Library</td>
<td>100</td>
</tr>
<tr>
<td>Device Library</td>
<td>101</td>
</tr>
<tr>
<td>Design</td>
<td>102</td>
</tr>
<tr>
<td>Overview</td>
<td>102</td>
</tr>
<tr>
<td>Left Sidebar</td>
<td>103</td>
</tr>
<tr>
<td>Viewer</td>
<td>103</td>
</tr>
<tr>
<td>Pages</td>
<td>103</td>
</tr>
<tr>
<td>Adding a Viewer</td>
<td>104</td>
</tr>
<tr>
<td>Configuring the Viewer</td>
<td>109</td>
</tr>
<tr>
<td>Object Properties</td>
<td>112</td>
</tr>
<tr>
<td>Page Objects</td>
<td>112</td>
</tr>
<tr>
<td>Object Properties for Mobile Devices</td>
<td>113</td>
</tr>
<tr>
<td>Buttons</td>
<td>113</td>
</tr>
<tr>
<td>Groups</td>
<td>117</td>
</tr>
<tr>
<td>Labels</td>
<td>118</td>
</tr>
<tr>
<td>Slide Bars 1</td>
<td>119</td>
</tr>
<tr>
<td>PowerPoint Control and Media Control Templates</td>
<td>121</td>
</tr>
<tr>
<td>Image</td>
<td>122</td>
</tr>
<tr>
<td>Layering Images</td>
<td>123</td>
</tr>
<tr>
<td>Dial Kit</td>
<td>124</td>
</tr>
<tr>
<td>Frame &amp; Line</td>
<td>126</td>
</tr>
<tr>
<td>Object Properties for ATEN Keypad / Control Pad</td>
<td>127</td>
</tr>
<tr>
<td>Button / Slider Bar / Dial Kit Actions</td>
<td>130</td>
</tr>
<tr>
<td>Understanding Button/Slider Bar/Dial Kit Actions</td>
<td>130</td>
</tr>
<tr>
<td>Configuring Button/Slider Bar Actions</td>
<td>132</td>
</tr>
<tr>
<td>Functions</td>
<td>133</td>
</tr>
</tbody>
</table>
Device Functions .............................................. 135
Applications of Device Functions ............................ 137
  Example: Configuring actions of dial keys .................. 137
Advanced Functions .......................................... 138
Applications of Advanced Functions ........................ 140
  Set Flag .................................................... 140
  Condition .................................................. 141
  Change Button State ...................................... 146
  Change Label .............................................. 148
  Change Group Button State ................................ 149
  Change Slider Bar Level ................................... 150
  Change Button Name ...................................... 151
Graphic Library ............................................... 153
  Background Color ....................................... 153
  Button .................................................... 153
  Icon ....................................................... 154
Device Interface ............................................. 154
Library ......................................................... 155
Flag ........................................................... 156
Monitor ......................................................... 158
  Understanding Monitor .................................... 158
  Condition Types .......................................... 160
  Functions .................................................. 163
  Creating an IF Monitor .................................... 164
  Creating a Switch Monitor ................................ 167
  Creating a Bypass Monitor ................................ 170
  Creating a While Loop Monitor ............................ 171
  Creating a Professional Monitor ......................... 172
Macro ........................................................ 176
Scheduled Events ............................................ 178
Variables ...................................................... 179
  Understanding Variables ................................ 179
  Creating a Variable for Devices that Return Feedback Messages ............................................. 180
  Creating a Variable for Devices that Do Not Return Feedback Messages ................................ 182
Upload ......................................................... 185
Viewing Controller Information ............................. 188

5. ATEN Database Generator
Overview ...................................................... 189
Accessing the Database Generator .......................... 189
My Library ..................................................... 191
Appendix

Safety Instructions ................................................. 245
   General .................................................................. 245
   Rack Mounting ....................................................... 247
Specifications ............................................................. 248
   VK2100 .................................................................. 248
   VK1100 .................................................................. 250
   VK0100/VK0200 ....................................................... 252
CAD and Panel Cutout Diagrams ................................. 254
   VK0100 .................................................................. 254
   VK0200 .................................................................. 258
   VK108JS ................................................................. 262
   VK112EU ................................................................. 266
Datapoint Types .......................................................... 270
Windows OS Button Limitation ................................. 273
Technical Support ....................................................... 274
   International .......................................................... 274
Limited Warranty ........................................................ 275
About this Manual

This user manual is provided to help you get the most from your ATEN Control System. It covers all aspects of installation, configuration, and operation of the ATEN controllers, configuration software, and their accessories, including:

<table>
<thead>
<tr>
<th>Product Category</th>
<th>Model Code</th>
<th>Product Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>ATEN Configurator</td>
<td>VK6000</td>
<td>ATEN Configurator</td>
</tr>
<tr>
<td>ATEN Control Box</td>
<td>VK1100</td>
<td>ATEN Compact Control Box</td>
</tr>
<tr>
<td></td>
<td>VK2100</td>
<td>ATEN Control Box</td>
</tr>
<tr>
<td>ATEN Control Pad</td>
<td>VK0100</td>
<td>8-Button Control Pad (US, 1 Gang)</td>
</tr>
<tr>
<td></td>
<td>VK0200</td>
<td>12-Button Control Pad (EU, 2 Gang)</td>
</tr>
<tr>
<td>ATEN Keypad</td>
<td>VK108US</td>
<td>8-Button Keypad (US, 1 Gang)</td>
</tr>
<tr>
<td></td>
<td>VK112EU</td>
<td>12-Button Keypad (EU, 2 Gang)</td>
</tr>
<tr>
<td>ATEN Extension Box</td>
<td>VK224</td>
<td>4-Port Serial Expansion</td>
</tr>
<tr>
<td></td>
<td>VK236</td>
<td>6-Port IR/Serial Expansion Box</td>
</tr>
<tr>
<td></td>
<td>VK248</td>
<td>8-Channel Relay Expansion Box</td>
</tr>
<tr>
<td></td>
<td>VK258</td>
<td>8-Channel Digital I/O Expansion Box</td>
</tr>
</tbody>
</table>

An overview of the information found in the manual is provided below.

Chapter 1, Introduction

Introduces you to the ATEN Control System. Its purpose, features, and benefits are presented, and panel components of the Control Box and Control Pad are described.

Chapter 2, Hardware Setup

Provides the necessary steps to setup the ATEN Control System installation, including how to wire the different types of hardware connections.

Chapter 3, Browser Operation

Provides information about Control Box and Control Pad’s web interface and how to use it to remotely configure parts of the ATEN Control System installation.

Chapter 4, ATEN Configurator (VK6000)

Provides a complete description of the ATEN Configurator (VK6000) software and how to use it to configure and operate the ATEN Control System.
Chapter 5, ATEN Database Generator
Provides a complete description of the Database Generator software and how to use it to configure new devices to add to the VK6000 device library.

Chapter 6, Remote PC Control, Explains how to set up your computer for remote control from a licensed device and provide a complete description of the supported control actions.

Chapter 7, ATEN Control System App
Provides a complete description of the ATEN mobile app and how to use it to operate devices connected to the ATEN Control System.

An Appendix
Provides specifications and other technical information regarding the ATEN Control System.
Terminology

<table>
<thead>
<tr>
<th>Terminology</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ATEN Controller, controller</td>
<td>ATEN Controller or controller refers to all models of ATEN Control Box (VK1100 and VK2100) and ATEN Control Pad (VK0100 and VK0200).</td>
</tr>
<tr>
<td>ATEN Control Box, Control Box</td>
<td>ATEN Control Box or Control Box refers to all models of ATEN Control Box, including the VK2100 Control Box and the VK1100 Compact Control Box.</td>
</tr>
<tr>
<td>Viewer, Profile</td>
<td>A Viewer or Profile is a software control interface users customize to control and operate devices in their control system. A Viewer or Profile is configurable using ATEN Configurator and applied to a supported hardware control device, such as a mobile device, ATEN Keypad, or ATEN Control Pad to be able to function.</td>
</tr>
<tr>
<td>Project</td>
<td>A project is a set of configuration for an ATEN Control System, including configuration of one or more controllers, managed devices, and profiles.</td>
</tr>
</tbody>
</table>

Conventions

This manual uses the following conventions:

Monospaced Indicates text that you should key in.

[ ] Indicates keys you should press. For example, [Enter] means to press the Enter key. If keys need to be charded, they appear together in the same bracket with a plus sign between them: [Ctrl+Alt].

1. Numbered lists represent procedures with sequential steps.

• Bullet lists provide information, but do not involve sequential steps.

→ Indicates selecting the option (on a menu or dialog box, for example), that comes next. For example, Start → Run means to open the Start menu, and then select Run.

⚠ Indicates critical information.
**Package Contents**

**VK0100**
The VK0100 package consists of:
- 1 VK0100 8-Button Control Pad (US, 1 Gang)
- 1 Button Pack
- 6 Terminal Blocks
- 1 Faceplate
- 1 User Instructions*

**VK0200**
The VK0200 package consists of:
- 1 VK0200 12-Button Control Pad (EU, 2 Gang)
- 1 Button Pack
- 6 Terminal Blocks
- 1 Faceplate
- 1 User Instructions*

**VK1100**
The VK1100 package consists of:
- 1 VK1100 Compact Control Box
- 4 Terminal Blocks
- 1 Power Cord
- 1 User Instructions*

**VK2100**
The VK2100 package consists of:
- 1 VK2100 Control Box
- 1 Rack Mount Kit
- 9 Terminal Blocks
- 1 Power Cord
- 1 User Instructions*
Note:

- Read this manual thoroughly and follow the installation and operation procedures carefully to prevent any damage to the ATEN controller and other connected devices.
- The product firmware may have been updated with new features after the release of this manual. For an up-to-date user manual, visit: http://www.aten.com/global/en/
Chapter 1
Introduction

Overview

The ATEN Control System, incorporating the ATEN Control Box/ATEN Control Pad (controller), the ATEN Configurator software (VK6000), and the ATEN Control System App is a standard Ethernet-based management system that connects all hardware devices in a room or large facility to provide centralized control of devices directly and effortlessly via a mobile device. The ATEN controller works as the main controller that provides great connectivity to all sorts of hardware devices commonly seen in a room. After connecting the hardware, the ATEN Configurator (VK6000) provides simple setup of the devices with easy step by step configuration. The ATEN Control System App then connects you to the controller from any iOS, Android or Windows mobile device / tablet computer which empowers you with mobility to control all the hardware devices, in different rooms, whenever and however you like.

ATEN Control Box/Control Pad easily deploys into an existing installation and integrates seamlessly with ATEN VanCryst pro-AV products and nearly any other hardware devices found in a room, including AV equipment, lighting, conference systems, air conditioning, motion sensors, power switches and many more. The controller serves as the central platform where hardware devices are connected – to be monitored, managed, and controlled directly via a tailor-made GUI from any iOS, Android, or Windows mobile device.

The VK6000 Configurator software facilitates quick setup and control of the devices in a few easy steps via an intuitive GUI. The VK6000 walks you through configuring the hardware, designing the control interface, and uploading this configuration to the controller. To provide control of the connected devices, you can create and customize a Viewer, a control interface for mobile devices and via the ATEN Control System App from any iOS, Android or Windows mobile device. Through an Ethernet connection, the ATEN Control System App enables you to edit and download Viewers from the controller via a point-n-tap user interface. Each Viewer is a customized control interface that grants you quick access to target and control hardware.
devices. Use of any Viewer is protected with password authentication to ensure secure access.

The ATEN Control System is perfectly applicable in meeting rooms, conference centers, boardrooms, classrooms or any room that requires central and mobile control of a variety of hardware devices through a streamlined management system with optimum efficiency and performance.
Benefits

**Intelligent Control**
The ATEN Control System makes the interactions between your hardware devices smarter. Pre-programmed actions and triggers can provide a fully automated series of advanced operations that allow your devices to respond to each other intelligently, making your whole solution run smarter and smoother.

**Optimized Performance**
The ATEN Control System has optimized the communication protocols that not only maintain a near-zero response time but also feature data encryption for extra protection.

**Simplified Setup**
No matter how large the room or how complicated the hardware, the ATEN Control System can be deployed in 3 easy steps: connect the hardware, configure the system and upload Viewers via a smart mobile app. Through an intuitive GUI, the process for setting up the controls for every room is simple and customizable, via straightforward predefined commands and macros, that do not require you to have complicated programming skills.

**Effortless Expandability**
With a range of expansion boxes available, the ATEN Control System installation can grow to accommodate additional Serial, Relay and IR devices. Furthermore, the ATEN Library has 10,000+ device drivers and grows as you add new devices to the existing database via the Database Generator, making it expandable and easily manageable, whatever the size or scope of the installation.

**User Centered Convenience**
An advanced, single-software solution creates an intuitive interface for any mobile device, while specific needs are customizable by selecting from an extensive library of actions and design elements to customize the control panel.
In addition, the ATEN Control System provides various support services that include driver downloads, database generation and upgrade tools – to help system integrators build easy-to-control environments effortlessly.

**On-the-Go Control**

Intuitive system control can start with one room and scale up to multiple rooms in the same area or across regions. Toggling between Viewers on an iOS, Android or Windows mobile device facilitates control of different rooms with simple point-n-tap operations. In addition, multiple mobile devices can be authorized with access to control the same room or multiple rooms, providing you with flexible, enhanced mobility, and tight security.
Chapter 1. Introduction

Features

ATEN Control Box

- Supports various connection interfaces:

<table>
<thead>
<tr>
<th>Interface</th>
<th>VK2100 Control Box</th>
<th>VK1100 Compact Control Box</th>
</tr>
</thead>
<tbody>
<tr>
<td>Serial Port</td>
<td>6</td>
<td>0</td>
</tr>
<tr>
<td>IR/Serial Port</td>
<td>4</td>
<td>2</td>
</tr>
<tr>
<td>Relay Channel</td>
<td>4</td>
<td>4</td>
</tr>
<tr>
<td>I/O Channel</td>
<td>4</td>
<td>-</td>
</tr>
<tr>
<td>Ethernet Port</td>
<td>1</td>
<td>1</td>
</tr>
</tbody>
</table>

- DC outputs for power supply connections
- VK2100: equipped with 4 DC outputs
- VK1100: equipped with 1 DC output
- 1 x USB port for easy Viewer upload
- IR Learning function for adding IR device drivers
- Supports native KNX IP for building management systems
- Telnet, TCP, UDP, ONVIF, PJLink, HTTP, and HTTPS compliant
- Supports project file backup
- Supports up to 8 ATEN Keypads
- Web GUI for easy system configuration
- 2 free licenses for mobile control*
- Supports SSH communication for data monitoring
- Rack-mountable

Note: If you need more than two licenses for mobile control, contact your local sales representative.
ATEN Control Pad

- Supports various connection interfaces:
  - 2 RS-232 serial ports
  - 2 relay channels
  - 1 digital input port
  - 1 Ethernet port
- Designed to mount in 2-gang EU type and MK type junction boxes (for VK0200)
- Fully customizable layout
  - VK0100: 14 layout variations using 4 to 8 buttons
  - VK0200: 125 layout variations using 6 to 12 buttons
- Customizable button text engraving service
- System LED indicators for quick connection status check
- Dual-color LEDs for clear indication in dark environments
- Redundant power supplies (DC power and PoE)
- Supports native KNX IP for building management systems
- Telnet, TCP, UDP, ONVIF, PJLink, HTTP, and HTTPS compliant
- Supports project file backup
- Web GUI for easy system configuration
- Supports SSH communication for data monitoring

Note: To control your setup using a mobile device, contact your local sales representative to purchase licenses for mobile control.
Chapter 1. Introduction

**ATEN Configurator**
- Simple Viewer setup with easy configuration steps via intuitive GUI
- Customizable GUI to be used on mobile devices and PC
- Supports ControlAssist that allows PC control (PC shutdown, media files, PowerPoint files)*
- Built-in Database Generator for device driver setup and overall device management.
- Built-in ATEN Library comprising 10,000+ device drivers and complete ATEN VanCryst product drivers
- Event scheduling
- Two-way communication enables user-defined event monitoring to automatically trigger the next actions
- Test tool to verify commands in action before uploading the Viewer to the ATEN controller
- Simulator to simulate and review the customized GUI before uploading

**Note:** For details on the supported PC control actions, see Supported PC Control Actions, page 225.

**ATEN Control System App**
- Allows administrators central control of multiple rooms via Viewers on a mobile device or tablet computer
- Restrict user access to Viewers via password authentication
- Synchronization of system controls amongst multiple mobile devices and tablet computers
- Any iOS, Android, or Windows mobile device can be used to control the system – no need to purchase costly
**ATEN Keypads**

Fully customizable layout

- VK108US: 14 layout variations using 4 to 8 buttons
- VK112EU: 125 layout variations using 6 to 12 buttons
- System LED indicators for quick connection status check
- Dual-color LEDs for clear indication in dark environments
- Easy ID pairing with ATEN controller for Ethernet communication
- Scalability – an ATEN controller can connect up to 8 Keypads
- Versatile modes support flexible behavior settings for each button
- Intuitive Web GUI for easy configuration
- Redundant power supplies (DC power and PoE)
- Button engraving service
Chapter 1. Introduction

Requirements

Prepare the following equipment and make sure your equipment meets the minimum requirements specified below.

- **Hardware devices to be controlled by your ATEN controller**
  - Bi-directional RS-232/422/485 serial devices
  - One-way IR or serial transmitter hardware devices (for Control Box only)
  - Relay hardware devices
  - Digital input hardware devices (for VK2100 and Control Pad only)
  - Digital output hardware devices (for VK2100 only)
  - Ethernet-controlled PJLink, Telnet, ONVIF, TCP, UDP, HTTP, or HTTPS devices
  - KNX IP interfaces for connecting KNX-compliant devices

- **Cables**
  - One Cat 5e/6 Ethernet cable used to connect the ATEN controller to the local area network
  - (Optional) For serial devices with DB9 connectors, use standard straight-through cables.

- **A computer for configuring your ATEN Control System**
  - Make sure the computer runs Windows 7, 8, 8.1, 10, or any of the later versions.
  - Make sure to install .NET Framework version 4.5 or any of the later versions to the computer before using the ATEN Database Generator.

- (Optional) **Up to 10 mobile devices for remote control**

**Note:** A license is required for each mobile device. For detailed information, see *Licenses for Mobile Control*, page 61.
Accessories

Optionally purchase ATEN accessories to enhance the functionality of your Control System. For more information, visit the ATEN website. Contact your ATEN dealer to purchase these accessories.

<table>
<thead>
<tr>
<th>Model</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2XRT-0004G</td>
<td>Full Range IR Emitter (1.8 m)</td>
</tr>
<tr>
<td>2X-031G</td>
<td>Single Rack Mount Kit for VK1100</td>
</tr>
<tr>
<td>VK108US</td>
<td>8-button Keypad (US, 1 Gang)</td>
</tr>
<tr>
<td>VK112EU</td>
<td>12-button Keypad (EU, 2 Gang)</td>
</tr>
<tr>
<td>VK224</td>
<td>4-Port Serial Expansion Box</td>
</tr>
<tr>
<td>VK236</td>
<td>6-Port IR/Serial Expansion Box</td>
</tr>
<tr>
<td>VK248</td>
<td>8-Channel Relay Expansion Box</td>
</tr>
<tr>
<td>VK258</td>
<td>8-Channel Digital I/O Expansion Box</td>
</tr>
<tr>
<td>SA0141</td>
<td>DB9-F to RJ45-F Adapter</td>
</tr>
<tr>
<td>SA0145</td>
<td>RJ45-F to DB9-M Adapter</td>
</tr>
</tbody>
</table>
Chapter 2
Hardware Setup

1. Important safety information regarding the placement of this device is provided on Safety Instructions, page 245. Please review it before proceeding.

2. Make sure that the power to all devices connected to the installation are turned off. You must unplug the power cords of any computers that have the Keyboard Power On function.

ATEN Control Box

Panel Components

VK2100 Front View

<table>
<thead>
<tr>
<th>No.</th>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Relay LED</td>
<td>The LED lights green to indicate an active device connection (closed loop).</td>
</tr>
<tr>
<td>2</td>
<td>IR/Serial LED</td>
<td>The LED lights green to indicate an active device connection and IR/Serial signals are being transmitted.</td>
</tr>
<tr>
<td>3</td>
<td>I/O LED</td>
<td>The LED lights green to indicate an active device connection and I/O signals are being transmitted.</td>
</tr>
<tr>
<td>4</td>
<td>Serial LED</td>
<td>The LED (1~6) lights green to indicate serial signals are being transmitted.</td>
</tr>
</tbody>
</table>
The LED lights orange to indicate DC output exceeds maximum output.

**Note:** When the LED lights orange, please unplug any of the connected devices to keep its total output under 24W.

7. **IR Receiver / LED**
   - This IR receiver passes the functions of a remote control to the VK2100 in learning mode. The distance between the IR remote and the receiver window should be kept under 10cm with a direct line of sight.
   - The LED blinks green to indicate the unit is ready to receive signals from an IR remote control.

8. **USB Port / LED**
   - This is where a USB device plugs in to upload Viewers to the VK2100.
   - The LED blinks green to indicate that Viewers are being uploaded, and lights green to indicate that the upload was successful.
   - The LED lights orange to indicate Viewers were not successfully uploaded.

9. **Reset Switch**
   - To clear all the configurations except the network settings, press and hold the Reset Switch for 8 seconds.
   - To reset the network settings, press the Reset Switch once.

10. **Power LED**
    - Lights green when the unit is turned on.

<table>
<thead>
<tr>
<th>No.</th>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>5</td>
<td>Ethernet LED</td>
<td>The LEDs provide information about the network connection:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Link:</strong> The LED blinks green to indicate Ethernet signals are being transmitted.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>ACT:</strong> The LED lights green to indicate 100Mbps transmissions.</td>
</tr>
<tr>
<td>6</td>
<td>DC Overload LED</td>
<td>The LED lights orange to indicate DC output exceeds maximum output.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note:</strong> When the LED lights orange, please unplug any of the connected devices to keep its total output under 24W.</td>
</tr>
<tr>
<td>7</td>
<td>IR Receiver / LED</td>
<td>This IR receiver passes the functions of a remote control to the VK2100 in learning mode.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>The distance between the IR remote and the receiver window should be kept under 10cm with a direct line of sight.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• The LED blinks green to indicate the unit is ready to receive signals from an IR remote control.</td>
</tr>
<tr>
<td>8</td>
<td>USB Port / LED</td>
<td>This is where a USB device plugs in to upload Viewers to the VK2100.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• The LED blinks green to indicate that Viewers are being uploaded, and lights green to indicate that the upload was successful.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• The LED lights orange to indicate Viewers were not successfully uploaded.</td>
</tr>
<tr>
<td>9</td>
<td>Reset Switch</td>
<td>• To clear all the configurations except the network settings, press and hold the Reset Switch for 8 seconds.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• To reset the network settings, press the Reset Switch once.</td>
</tr>
<tr>
<td>10</td>
<td>Power LED</td>
<td>Lights green when the unit is turned on.</td>
</tr>
</tbody>
</table>
# Chapter 2. Hardware Setup

## VK2100 Rear View

<table>
<thead>
<tr>
<th>No.</th>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Grounding Terminal</td>
<td>The grounding wire attaches here.</td>
</tr>
<tr>
<td>2</td>
<td>Power Socket</td>
<td>This is a standard 3-pin AC power socket. The power cord from an AC source plugs in here.</td>
</tr>
<tr>
<td>3</td>
<td>Power Switch</td>
<td>This is a standard rocker switch that powers the unit on and off.</td>
</tr>
<tr>
<td>4</td>
<td>DC Output Ports</td>
<td>Four outputs provide a total power output of 24W /2A max.</td>
</tr>
<tr>
<td>5</td>
<td>Relay Channels</td>
<td>Four channels; normally open, isolated relays with a contact rating of 24VDC, 2A max.</td>
</tr>
<tr>
<td>6</td>
<td>IR / Serial Ports</td>
<td>Four IR ports that can also be configured as RS-232 TX ports. pin1: Signal / pin2: Ground.</td>
</tr>
<tr>
<td>7</td>
<td>I/O Channels</td>
<td>Four channels that can be configured as digital input or digital output ports.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Digital Input: 0-24VDC programmable input range or contact closure with +12VDC pull-up</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Digital Output: 250mA sink from 12VDC</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Pin1~4: Signal / Pin5: Ground</td>
</tr>
<tr>
<td>8</td>
<td>RS-232 Serial Ports</td>
<td>Two RS-232 ports with TX/RX functions supported.</td>
</tr>
<tr>
<td>9</td>
<td>RS-232/422/485 Serial Ports</td>
<td>Four ports with supported RS-232/422/485 conversion by pin assignment and RTS/CTS flow control. The RS232, RS422, or RS485 connection is defined by pin. For pin assignments, see page 33.</td>
</tr>
<tr>
<td>10</td>
<td>Ethernet Port</td>
<td>This RJ-45 port is used for the network connection. If no IP address is assigned within 30 seconds, the default IP settings will be used: IP: 192.168.0.60 / mask: 255.255.255.0</td>
</tr>
<tr>
<td>11</td>
<td>Controller ID Switch</td>
<td>This 16-segment switch is used to set an ID for the controller.</td>
</tr>
</tbody>
</table>
### VK1100 Front View

<table>
<thead>
<tr>
<th>No.</th>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Relay LED</td>
<td>The LED lights green to indicate an active device connection (closed loop).</td>
</tr>
<tr>
<td>2</td>
<td>IR/Serial LED</td>
<td>The LED lights green to indicate an active device connection and IR/Serial signals are being transmitted.</td>
</tr>
<tr>
<td>3</td>
<td>Serial LED</td>
<td>The LED (1~2) lights green to indicate serial signals are being transmitted.</td>
</tr>
</tbody>
</table>
| 4   | Ethernet Link / ACT LED | The LEDs provide information about the network connection:  

- **Link**: The LED blinks green to indicate Ethernet signals are being transmitted.  
- **ACT**: The LED lights green to indicate 100Mbps transmissions.  |
| 5   | DC Output Overload LED | The LED lights orange to indicate DC output exceeds maximum output.  

**Note**: When the LED lights orange, please unplug any of the connected devices to keep its total output under 12W. |
| 6   | IR Receiver / LED | This IR receiver passes the functions of a remote control to the VK1100 in learning mode. The distance between the IR remote and the receiver window should be kept under 10cm with a direct line of sight.  

- The LED blinks green to indicate the unit is ready to receive signals from an IR remote control. |
## Chapter 2. Hardware Setup

<table>
<thead>
<tr>
<th>No.</th>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
</table>
| 7   | USB Port / LED    | This is where a USB device plugs in to upload Viewers to the VK1100.  
    |                   | • The LED blinks green to indicate that Viewers are being uploaded, and lights green to indicate a successful upload of Viewers.  
    |                   | • The LED lights orange to indicate that Viewers were not successfully uploaded.                                                           |
| 8   | Controller ID Switch | This 16-segment switch is used to set an ID for the controller.  
    |                   |                                                                                                                                               |
| 9   | Reset Switch      | • To clear all the configurations except the network settings, press and hold the Reset Switch for 8 seconds.  
    |                   | • To reset the network settings, press the Reset Switch once.  
    |                   |                                                                                                                                               |
| 10  | Power LED         | Lights green when the unit is turned on.                                                                                                     |
VK1100 Rear View

<table>
<thead>
<tr>
<th>No.</th>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Power Socket</td>
<td>This is a standard 3-pin AC power socket. The power cord from an AC source plugs in here.</td>
</tr>
<tr>
<td>2</td>
<td>Power Switch</td>
<td>This is a standard rocker switch that powers the unit on and off.</td>
</tr>
<tr>
<td>3</td>
<td>Relay Channels</td>
<td>Four channels; normally open, isolated relays with a contact rating of 24VDC, 2A max.</td>
</tr>
<tr>
<td>4</td>
<td>DC Output Ports</td>
<td>One output provides a total power output of 12W max.</td>
</tr>
<tr>
<td>5</td>
<td>IR / Serial Ports</td>
<td>Two IR ports that can also be configured as RS-232 TX ports. pin1: Signal / pin2: Ground.</td>
</tr>
<tr>
<td>6</td>
<td>RS-232/422/485 Serial Ports</td>
<td>Two ports with supported RS-232/422/485 conversion by pin assignment and RTS/CTS flow control. The RS232, RS422, or RS485 connection is defined by pin. For pin assignments, see page 33.</td>
</tr>
</tbody>
</table>
| 7   | Ethernet Port   | This RJ-45 port is used for the network connection. If no IP address is assigned within 30 seconds, the default IP settings will be used:  
IP: 192.168.0.60 / mask: 255.255.255.0 |
| 8   | Grounding Terminal | The grounding wire attaches here.                                                                                                         |
Rack Mounting the ATEN Control Box

VK2100

The VK2100 can be mounted in a 19" (1U) system rack. To install the device in a rack, do the following:

1. Use the M3 x 8 Phillips head hex screws supplied with the Rack Mount Kit to screw the rack mounting brackets onto the front of the unit.

2. Position the unit in the front of the rack and align the holes in the mounting brackets with the holes in the rack.

3. Screw the mounting brackets to the rack.
Optionally purchase an ATEN Rack Mount Kit to install VK1100 in a 19” (1U) system rack. To install the device in a rack, do the following:

1. Remove the side and bottom screws from the front of the VK1000.

2. Use the two bottom screws removed in step 1 to secure the bottom of the brackets, and two M3X6 hexagon screws (from the rack mount kit) to secure the side of the bracket to the VK1100.

3. Screw the mounting brackets to the rack.
Chapter 2. Hardware Setup

Control Box Connections

Installation of the Control Box is a matter of connecting the appropriate wires. Refer to the installation diagrams on the pages that follow to setup each device and use the instructions below as a guide (each step provides a corresponding page with diagram for the VK2100 and VK1100), and do the following:

Connect the hardware devices to the Control Box using these instructions:

1. Use a grounding wire to ground the unit by connecting one end of the wire to the grounding terminal, and the other end of the wire to a suitable grounded object.

   **Note:** Do not omit this step. Proper grounding helps prevent damage to the unit from surges or static electricity.

2. Use a Cat 5e/6 cable to connect the Control Box’s Ethernet port to the network.

3. Use the Controller ID Switch to assign an ID to this unit.

   **Note:** It is possible to install more than 16 controllers under the same subnet. In which case, the 17th controller and the ones added after that will each be sharing its ID with another controller. If you have any ATEN Expansion Box and/or Keypad connected to controllers using shared IDs, reconfigure the connection mode. For details, see Controller Properties, page 91.

4. Use the DC Output terminals to wire 12VDC power connections using the instructions on page 25.

5. Use the Relay terminals to wire relay device connections using the instructions on page 27.

6. Use the IR/Serial (TX) terminals to wire IR or serial device connections using the instructions on page 28.


8. Use the RS-232 terminals to wire RS-232 serial device connections using the instructions on page 32.

9. Use the DB-9 ports to wire RS-232/422/485 serial device connections using the instructions on page 33.
10. Connect IP-based devices to the same network as the Control Box. Refer to *Ethernet*, page 34 for details.

**Note:**
- For KNX-compliant devices, connect the devices to a KNX IP interface, and then connect the KNX IP interface to the network where the Control Box is installed.
- To check if the KNX functions are supported by the Control Box, see *Specifications*, page 248.

11. Plug the power cord supplied with the package into the Control Box’s 3-prong AC socket and then into an AC power source.
Chapter 2. Hardware Setup

VK2100 Installation Diagram

1. Power Input
2. Ethernet
3. Controller ID Switch
4. Power Output
5. Relay
6. Digital I/O
7. Connect to digital input or digital output devices
8. Connect to RS-232 serial devices
9. Connect to RS232/422/485 devices
10. Connect to 12VDC power supply
11. Connect to IR or RS-232 devices

Connect to network via Cat 5e cable
Connect to RS232/422/485 devices
Connect to IR or RS-232 devices
Connect to digital output devices
Connect to digital input or digital output devices
Connect to switch or motor devices
Connect to 12VDC power supply
Connect to IR or RS-232 devices
Connect to 12VDC power supply
Connect to IR or RS-232 devices
Connect to network via Cat 5e cable
VK1100 Installation Diagram

1. Ground
2. Connect to network via Cat 5e cable
3. Ethernet
4. Connect to IR or RS-232 devices
5. Connect to switch or motor devices
6. Connect to IR or RS-232 devices
7. 12VDC Power Output
8. Connect to provide 12VDC power supply
9. RS-232 / 422 / 485
10. Controller ID Switch is on the VK1100’s front panel.
11. Power Outlet
12 VDC Power Output

One or four (VK1100 / VK2100) ports provide 12VDC of power with a total of 12 or 24 watts. The output can power one or four (VK1100 / VK2100) independent hardware devices, one or four (VK1100 / VK2100) loops for connected relay devices, or one or four (VK1100 / VK2100) digital output devices. If the combined current of the ports exceeds 1A (VK1100) or 2A (VK2100), the DC Power Overload LED lights orange, an alarm beeps three times and the ports are turned off. To return power to the ports, power off the Control Box, unplug all hardware connected to the 12VDC Power Output ports, power on the Control Box, and then plug in the hardware devices, one at a time, ensuring the current does not exceed 1A or 2A.

The diagrams on the next three pages show ports on the VK2100. The VK1100 is the same except that it has fewer 12VDC terminal blocks and no I/O ports.

Independent Power Supply

4 x 12VDC Output Ports

Power Supply: 12VDC, 2A Max
(24W shared by 4 ports)

Connects to
Provides 12VDC power to independent hardware devices.
Relay Power Supply

4 x 12VDC Output Ports

Power Supply: 12VDC, 2A Max
(24W shared by 4 ports)

Connects to

Switch, Screen, Projector Lift,
Lighting, Motorized Equipment,
Motion Device, etc.

Provides 12VDC power
for the relay loop.
Digital Output Power Supply (VK2100 only)

4 x 12VDC Output Ports

Power Supply: 12VDC, 2A Max
(24W shared by 4 ports)

Connects to Switch, Screen, Projector Lift, Lighting and Equipment Control.
Digital Output Dual Power Supply (VK2100 only)

4 x 12VDC Output Ports

Power Supply: 12VDC, 2A Max
(24W shared by 4 ports)

![Diagram of 4 x 12VDC Output Ports]

- Provides 12VDC power for the digital output loop.
- Provides connection to digital output #2.
- Provides connection to digital output #1.
Chapter 2. Hardware Setup

Relay
These four Relay channels provide connections to control hardware devices such as electric screens, projector lifts and other motorized equipment. Each relay is normally open by default.

4 x Relay Channels

Normally Open, Isolated Relays
Contact Rating: 24VDC 2A Max

Connects to
Switch, Screen, Projector Lift, Lighting, Motorized Equipment, Motion Device, etc.
IR / Serial
These two or four (VK1100 / VK2100) ports can be configured to connect IR and RS-232 devices. By default the ports are set to transmit IR signals. Use the ATEN Configurator software to configure the ports for RS-232 signals. The diagram below shows ports on the VK2100. The VK1100 is the same except that it has fewer terminals blocks and the Uni-directional setting is (0 to 5 V).

IR Connection: Connect a transmitter cable to the IR and Ground ports on the Control Box and install the IR transmitter on or near the device's IR receiving port, as shown on page 29.

Serial Connection: Connect the device's receiver (RX) and ground ports to the Serial (TX) and Ground ports on the Control Box. Next configure the same serial port setting on the Control Box and serial device so that they can communicate.
Chapter 2. Hardware Setup

One IR Transmitter

Two IR Transmitters
**Digital I/O**

The four channels on the VK2100 can be used to connect Digital Input or Digital Output hardware devices such as switches, sensors, LEDs and relays. Each channel can be configured as either an Input (VDC), Input (Dry Contact) or Output channel.

**Digital Input (Dry Contact):**
Digital inputs are hardware devices (switches, sensors, monitors) with two circuit signals – open and closed. These two signals provide indicators from sensors or switches of an event. An event can be the on/off power, dry contact, sensor or switch status from a device. This information is used to trigger events and functions through the VK2100.

**Digital Input (VDC):**
Digital input 12VDC hardware devices (temperature, current and monitor sensors) provide voltage signals between 1 and 24. A digital input port detects if a voltage is above/below a specific threshold (1 to 24). If the voltage coming from a hardware device is higher than the set value, the VK2100 will detect the digital input as high. If the voltage coming from a hardware device...
is lower than the set value, the VK2100 will detect the digital input as low. This information is used to trigger events and functions through the VK2100.

**Digital Output:**
Digital output channels provide non-powered dry contact (open and closed) circuit control of hardware devices such as electric screens, projector lifts and other motorized equipment. Devices connected to the Digital Output port must be connected through a **Relay Module**, as shown below.

**4 x Programmable Digital Output Channels**

![Diagram showing 4 x Programmable Digital Output Channels](image)

- **Digital Output:** 250 mA sink from 12 VDC
- **Connects to**
  - **Digital Output:** Switch, Screen, Projector Lift, Lighting and Equipment Control.
RS-232

The two bi-directional RS-232 ports on the VK2100 provide serial control of hardware devices (projectors, matrix switches, etc.) and receive status messages from the connected devices. For bi-directional RS-232 control, the transmit, receive and ground pins must be wired on both the VK2100 and hardware device. Each hardware device requires different wiring. Please consult each hardware device's manual for details.

**2 x Bi-directional RS-232 Ports**

- **Baud Rate:** 300 to 115200 (default: 9600)
- **Data Bit:** 8 (default) or 7
- **Stop Bit:** 1 (default) or 2
- **Parity:** None (default), even or odd

Connects to

- Projector, Matrix Switch, Camera, etc.
Chapter 2. Hardware Setup

RS-232 / 422 / 485

These two or four (VK1100 / VK2100) bi-directional ports provide serial control of hardware devices (projectors, switches, etc.) with programmable pin assignments and receive status messages from the connected devices. The diagram below shows ports on the VK2100. The VK1100 is the same except that it has fewer ports.

Pin Assignments

<table>
<thead>
<tr>
<th>RS-232</th>
<th>RS-422</th>
<th>RS-485</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pin2: RX</td>
<td>Pin1: RX-</td>
<td>Pin3: D+</td>
</tr>
<tr>
<td>Pin3: TX</td>
<td>Pin2: RX+</td>
<td>Pin4: D-</td>
</tr>
<tr>
<td>Pin5: GND</td>
<td>Pin3: TX+</td>
<td></td>
</tr>
<tr>
<td>Pin7: RTS</td>
<td>Pin4: TX-</td>
<td></td>
</tr>
<tr>
<td>Pin8: CTS</td>
<td>Pin5: GND</td>
<td></td>
</tr>
</tbody>
</table>

Connects to
Projector, Matrix Switch, Camera, etc.

Configurable by pin assignment
Baud Rate: 300 to 115200
(default: 9600)
Data Bit: 8 (default) or 7
Stop Bit: 1 (default) or 2
Parity: None (default), Even or Odd
Flow Control: None (default) or RTS/CTS
Ethernet

The RJ-45 port provides an Ethernet connection for GUI access (page 57) and the ability to add up to 25 LAN devices per Control Box or up to 8 LAN devices per Control Pad, as shown below.

1 x Ethernet Port

The RJ-45 port is used to connect the Control Box to the network and access TCP, UDP, PJLink, ONVIF, HTTP, HTTPS, and Telnet devices.

If the network switch does not support DHCP, the installed device will adopt the default IP address, 192.168.0.60.
Chapter 2. Hardware Setup

ATEN Control Pad

Panel Components

VK0100

Front View

Rear View

Side View

VK0200

Front View

Rear View

Side View
<table>
<thead>
<tr>
<th>No.</th>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Buttons and Button LEDs</td>
<td>Indicate the status of the Control Pad and if the function on each button, e.g., lighting or projector, is on or off. For detailed information about device/function status under different LED activities, see LED Indications, page 37.</td>
</tr>
<tr>
<td>2</td>
<td>System LEDs</td>
<td>Contains a LAN and a Link LED to indicate network connection and data transmission status:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- LAN LED lights green to indicate that the Control Pad is connected to network.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Link LED lights green to indicate that the Control Pad is actively transmitting and receiving data.</td>
</tr>
<tr>
<td>3</td>
<td>Reset Switch</td>
<td>- To clear all the configurations except the network settings, press and hold the Reset Switch for 8 seconds.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- To reset the network settings, press the Reset Switch once.</td>
</tr>
<tr>
<td>4</td>
<td>RS-232 Serial Ports</td>
<td>Connect up to two RS-232 serial devices.</td>
</tr>
<tr>
<td>5</td>
<td>Relay Channels</td>
<td>Connect up to two relay devices. Relay contacts are normally open, isolated with a contact rating of 24 VDC, 1A max.</td>
</tr>
<tr>
<td>6</td>
<td>Digital Input Port</td>
<td>Connect to one digital input device that supports programmable input (1 to 5 VDC) or dry contact (pull-up 2k ohms to 5VDC).</td>
</tr>
<tr>
<td>7</td>
<td>Ethernet Port</td>
<td>Connects to an Ethernet cable to provide power and access to the network.</td>
</tr>
<tr>
<td>8</td>
<td>Control Pad ID Switch</td>
<td>Sets an ID for the Control Pad.</td>
</tr>
<tr>
<td>9</td>
<td>DC Power Port</td>
<td>Connects to a 5V DC power adapter.</td>
</tr>
</tbody>
</table>
LED Indications

Refer to the table below for the status descriptions of a Control Pad indicated by button LEDs.

<table>
<thead>
<tr>
<th>Button LED Status</th>
<th>LED Activity</th>
<th>Control Pad Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>A button LED</td>
<td>lights orange</td>
<td>The Control Pad is powered on and the button is currently off.</td>
</tr>
<tr>
<td>A button LED</td>
<td>lights white</td>
<td>The Control Pad is powered on and the button is currently on.</td>
</tr>
<tr>
<td>A button LED</td>
<td>blinks orange and white</td>
<td>The function assigned to the button is being executed.</td>
</tr>
<tr>
<td></td>
<td>repeatedly</td>
<td></td>
</tr>
<tr>
<td>All button LEDs</td>
<td>blink orange and white</td>
<td>The Control Pad is restoring its default settings.</td>
</tr>
<tr>
<td></td>
<td>once</td>
<td></td>
</tr>
<tr>
<td>All button LEDs</td>
<td>blink orange and white</td>
<td>The firmware of the Control Pad is being upgraded.</td>
</tr>
<tr>
<td></td>
<td>repeatedly</td>
<td></td>
</tr>
</tbody>
</table>
Installing the Control Pads

Installation Steps

Follow the steps below to safely install the Control Pad.

VK0100

VK0200
Chapter 2. Hardware Setup

1. Prepare the installation site.
   a) Choose a location where cables are free of interference.
   b) Prepare a recession in the wall to accommodate the Control Pad.
      Download a CAD diagram from the product web page.

2. Connect the Control Pad to serial, relay, and/or digital input devices using
   the supplied terminal blocks.
   For details, see RS-232 Serial Connection, page 43, Relay Connections,
   page 44, Digital Input Device, page 45 respectively.

   Note: To expand connection ports on the Control Pad, install ATEN
   Expansion Boxes.

3. To use PoE, connect the Control Pad to a PoE switch via an Ethernet cable.
   For details, see Ethernet, page 46.

4. If you do not have power sourcing equipment for PoE, contact your local
   sales representative to purchase a power adapter and then follow the steps
   below to prepare the power cord.

   a) Cut the connector end of the power adapter.
   b) Strip 5 mm (0.5 cm) off the insulation cover of the power adapter cable
      to expose the +5V wire and the grounding wire.
   c) Insert the expose +5V wire and the grounding wire tightly into the
      provided 2-pin terminal block connector.

   Note: Use a voltmeter to determine the polarity of an exposed wire.
   d) Plug the power terminal block to the DC power port on the Control Pad.
5. Use the ID Switch to assign an ID to the Control Pad.

**Note:** It is possible to install more than 16 controllers under the same subnet. In which case, the 17th controller and the ones added after that will each be sharing its ID with another controller. If you have any ATEN Expansion Box and/or Keypad connected to controllers using shared IDs, reconfigure the connection mode. For details, see *Controller Properties*, page 91.

6. Power on all the devices. The button LEDs light orange.

7. Assemble the button caps onto the Control Pad.
   a) Assemble button caps of the same row with each other.

   ![Button Caps Assembly](image)

   b) From the top row, attach each row of button caps to the Control Pad by pressing on the hinges.

   ![Button Caps Attachment](image)

   **Caution:** When removing button caps, place your fingers on the top of button caps and then press downwards, as illustrated below. Pressing upwards from the bottom may cause damages to the button caps.
8. Mount the Control Pad to the wall.
   a) Secure the Control Pad to the wall with self-prepared screws.
   b) Install the supplied faceplate to the Control Pad.

   VK0100

   VK0200 (EU)
VK0200 (MK)
RS-232 Serial Connection
The two bi-directional RS-232 ports on the Control Pad provide serial control of hardware devices (projectors, matrix switches, etc.) and receive status messages from the connected devices. For bi-directional RS-232 control, the transmit, receive, and ground pins must be wired on both the Control Pad and hardware device. Each hardware device requires different wiring. Please consult each hardware device's manual for details.

2 x Bi-directional RS-232 Ports

- Baud Rate: 300 to 115200 (default: 9600)
- Data Bit: 8 (default) or 7
- Stop Bit: 1 (default) or 2
- Parity: None (default), even or odd

Connects to
- Projector, Matrix Switch, Camera, etc.
Relay Connections
These four Relay channels provide connections to control hardware devices such as electric screens, projector lifts and other motorized equipment. Each relay is normally open by default.

2 x Relay Channels
Normally Open, Isolated Relays
Contact Rating: 24VDC 1A Max

Connects to
Switch, Screen, Projector Lift, Lighting, Motorized Equipment, Motion Device, etc.
Chapter 2. Hardware Setup

Digital Input Device
The digital input port on the Control Pad can be used to install a digital input device such as a switch or a sensor. The digital input channel can be configured to the VDC mode or the Dry Contact mode.

Digital Input (Dry Contact):
Digital inputs are hardware devices (switches, sensors, monitors) with two circuit signals – open and closed. These two signals provide indicators from sensors or switches of an event. An event can be the on/off power, dry contact, sensor or switch status from a device. This information is used to trigger events and functions through the Control Pad.

Digital Input (VDC):
Digital input 5VDC hardware devices (temperature, current and monitor sensors) provide voltage signals between 1 and 5. A digital input port detects if a voltage is above/below a specific threshold (1 to 5). If the voltage coming from a hardware device is higher than the set value, the Control Pad will detect the digital input as high. If the voltage coming from a hardware device is lower than the set value, the Control Pad will detect the digital input as low. This information is used to trigger events and functions through the Control Pad.
Ethernet
The RJ-45 port provides an Ethernet connection for GUI access (page 57) and the ability to add up to 8 LAN devices per Control Pad, as shown below.

1 x Ethernet Port
The RJ-45 port is used to connect the Control Box to the network and access TCP, UDP, PJLink, ONVIF, HTTP, HTTPS, and Telnet devices.

If the network switch does not support DHCP, the installed device will adopt the default IP address, 192.168.0.60.
Accessories

ATEN Expansion Box
ATEN Expansion Boxes (sold separately) provide additional ports for a flexible expansion of the ATEN Control System. This allows you to add and control additional devices in an environment where more devices are required. With the advantage of an Ethernet-based connection, the expansion boxes are easily connected to the ATEN controller via a LAN connection from a variety of locations across a network. The diagram below provides an example of the VK224 4-Port Serial Expansion Box setup.

Note:
- To add and configure ATEN Expansion Boxes, see Device Configuration List, page 87 and Expansion Box, page 90.
- The available Expansion Box models include:

<table>
<thead>
<tr>
<th>Model</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>VK224</td>
<td>4-Port Serial Expansion</td>
</tr>
<tr>
<td>VK236</td>
<td>6-Port IR/Serial Expansion Box</td>
</tr>
<tr>
<td>VK248</td>
<td>8-Channel Relay Expansion Box</td>
</tr>
<tr>
<td>VK258</td>
<td>8-Channel Digital I/O Expansion Box</td>
</tr>
</tbody>
</table>
ATEN Keypad

Overview
The ATEN Keypad mounts to a wall to provide control of hardware through a Control Box. The setup of the Keypad to the Control System can be illustrated as follows:

Note:
- The following Keypad models are available:

<table>
<thead>
<tr>
<th>Model</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>VK108US</td>
<td>8-Button Keypad (US, 1 Gang)</td>
</tr>
<tr>
<td>VK112EU</td>
<td>12-Button Keypad (EU, 2 Gang)</td>
</tr>
</tbody>
</table>

- You can have your Keypad buttons customized with text engraving. To make the order, go to this link:
Component
The VK108US and VK112EU Keypads share the same hardware layout. For demonstration purpose, VK112EU is used as an example below.

<table>
<thead>
<tr>
<th>No.</th>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
</table>
| 1   | Buttons   | VK108US  
The Keypad can be customized up to 14 different layouts using 4 to 8 buttons.  
VK112EU  
The Keypad can be customized up to 125 different layouts using 6 to 12 buttons. |
| 2   | Button LEDs |  
- Indicate function and Keypad statuses. For detailed information, see *LED Indications*, page 50. |
| 3   | System LED Indicators |  
- LAN: lights green to indicate that the Keypad is connected to LAN.  
- Link: lights green to indicate that the Keypad is connected to the assigned Control Box. |
| 4   | Reset Pushbutton | Press to reset the Keypad to its default network settings. |
| 5   | DC Power | Plug a power adapter into this DC power input. |
| 6   | Keypad ID Switch (blue) | Sets an ID to the Keypad (1~8). |
| 7   | Control Box ID Switch (black) | Sets the ID of the Control Box (1 ~ 16) to which the Keypad connects. |
| 8   | LAN Port |  
- Connects the Keypad to LAN  
- Supplies power (PoE) if a power sourcing equipment is installed. |
LED Indications
Refer to the table below for the status descriptions of a Keypad indicated by button LEDs.

<table>
<thead>
<tr>
<th>Keypad Button</th>
<th>LED Activity</th>
<th>Control Pad Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>One button LED</td>
<td>lights orange</td>
<td>The Keypad is powered on and the button is currently off.</td>
</tr>
<tr>
<td></td>
<td>lights white</td>
<td>The Keypad is powered on and the button is currently on.</td>
</tr>
<tr>
<td></td>
<td>blinks orange and white repeatedly</td>
<td>The function assigned to the button is being executed.</td>
</tr>
<tr>
<td>All button LEDs</td>
<td>blink orange and white repeatedly</td>
<td>The firmware of the Control Pad is being upgraded.</td>
</tr>
<tr>
<td></td>
<td>blink orange</td>
<td>The Keypad is disconnected from the controller.</td>
</tr>
</tbody>
</table>
Chapter 2. Hardware Setup

Layout Examples

VK108US

VK112EU
Installing ATEN Keypad

You can install the Keypad in a wall, podium, or desk. To install the Keypad, follow the steps below:

1. Choose a location free of interference and prepare the installation site. You can install the Keypad to a wall box or directly into the chosen surface.

   - **Using a wall box**

     Use a wall box of appropriate size (2-gang for the VK112EU; 1-gang for the VK108US) and depth (at least 6 cm, 2.36 inches).

   ![VK108US Diagram]

   ![VK112EU Diagram]
Chapter 2. Hardware Setup

Directly into the chosen surface

a) Refer to the Panel Mount Cutout diagram (Specifications, page 248) to find out the length and width of the cutout area and mark the opening on the chosen surface.

b) Cut out the marked area to a depth of at least 6 cm (2.36 inches).

2. Pair the Keypad with a Control Box by adjusting the Keypad ID Switch (blue) to the ID number that the Control Box uses.

Note: One ATEN Control Box can work with up to 8 Keypads.

3. Supply the Keypad with power and network connectivity using one of the following methods. The LAN LED light green to indicate that the Keypad is supplied with power and successfully linked to the network.

- To power the Keypad by PoE, use an Ethernet cable to connect the Keypad to a PoE-enabled Ethernet switch.

- If you do not have a power sourcing equipment, use an Ethernet cable to connect the Keypad to LAN and a power adapter to supply power.
  - Purchase a power adapter for this installation.
  - Follow the steps below to prepare the power adapter and then plug it to the Keypad.
a) Cut the connector end of the power adapter cable.

b) Strip 0.5 cm off the insulation cover of the power adapter cable to expose the two wires, the +5V wire, and the grounding wire. To determine wire polarity, use a voltmeter.

c) Insert the exposed wires into the supplied 2-pin terminal block.

**Note:**

- Make sure to install the Keypad in the same subnet with its assigned Control Box.
- The Keypad adopts the default IP address 192.168.0.60 if the network switch does not support DHCP. To configure the IP address, log in the web interface using the default IP address and the default password (**password**).

4. Secure the Keypad to the installation site and install the button caps and faceplate.

a) Secure the Keypad to the wall box or directly to the chosen site using two screws.

b) Follow the layout created in the Viewer and assemble the button caps onto the Keypad.
    - Assemble button caps of the same row with each other.
• From the top row, attach each row of button caps to the Keypad by pressing on the hinges.

**Caution:** When removing button caps, place your fingers on the top of button caps and then press downwards, as illustrated below. Pressing upwards from the bottom may cause damages to the button caps.

c) Attach the faceplate to the Keypad.

**IMPORTANT:** After installing the Keypad, create a control interface (Viewer) and upload the Viewer to the Control Box. For details, see *Design*, page 100.
Chapter 3
Browser Operation

Overview

The ATEN controller can be configured over a standard TCP/IP connection via its built-in Graphical User Interface (GUI). Because it can be accessed from anywhere over a network or the Internet, operators can easily log in via a web browser. The web interface can be used to upload licenses, set the access key, enable monitors and update the firmware.

Logging In

To access the GUI, type the IP address of the controller into the address bar of any browser. If a Security Alert dialog box appears, accept the certificate – it can be trusted. The Welcome screen appears:

- The default IP address is http://192.168.0.60
- The default access key is: password
- Only one user can log in at a time
- Supports Internet Explorer browsers IE9 and higher
Dashboard

The Dashboard appears when you successfully log in to the Control Box. The Dashboard gives a quick view of each setting and provides a link to each page. Click Manage to configure the settings.

The top bar provides two options:

- Click to enter the Settings page.
- Click to log out of the web console.
Chapter 3. Browser Operation

Settings

The Settings view contains tabs to provide options to configure the controller. The page is divided into two parts, the Interactive Display Panel which is used to configure the options and the Top Bar which provides icons to exit the settings page and log out of the web session.

The Settings page opens on the General tab, as shown below:

![Setting Panel](image)

The General tab contains network, system time, and firmware upgrade settings.

<table>
<thead>
<tr>
<th>Controller Info</th>
<th>Provides network and identification information pertaining to the controller.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Device Name</td>
<td>Sets the device name.</td>
</tr>
<tr>
<td>Controller ID</td>
<td>Displays the controller ID # set on the rear of the unit.</td>
</tr>
<tr>
<td>IP Address</td>
<td>Provides the IP address of the controller.</td>
</tr>
<tr>
<td>MAC Address</td>
<td>Provides the hardware MAC address of the controller.</td>
</tr>
</tbody>
</table>
Date & Time

- **Automatically**
  - **Time Zone**: Select a time zone for the controller. Choose the city that most closely corresponds to where it is located.

**NTP Server Settings**
Assign an NTP server for the controller to synchronize its clock. If the controller has access to the Internet, configure the **Preferred NTP Server** and **Alternate NTP Server** settings. If the controller is installed in a closed network, configure the **Preferred Customer Server IP** and **Alternate Customer Server IP** settings.

- **Preferred NTP Server**: Select an NTP server to provide synchronization services to the controller. Make sure to use an NTP server that is located close to where the controller is installed to minimize propagation delays.

- **Alternate NTP Server**: Select an alternate NTP server to which the controller connects when it is unable to connect to the preferred NTP server.

- **Preferred Customer Server IP**: Select this option to use a private NTP server if the controller is installed in a closed network.

- **Alternate Customer Server IP**: Select this option to set up a substitute server if the controller is unable to connect to the preferred server.

- **Adjust Time**: Sets the interval at which the controller synchronizes its clock with the assigned NTP server.

- **Sync**: Click this button to save your configuration and start synchronizing its clock with the assigned NTP server.

- **Manually**: Use the drop-down lists to set the controller’s time zone, date, and time.

Firmware
Displays the Current Firmware version and option to upgrade.

Click **Update Firmware** to open the Firmware Upgrade window. Click **Browse** to select the firmware upgrade file.

When **Check FW Version** is selected, the system will check the current firmware version against the one being used to upgrade the controller. If the device version is higher than the upgrade version a dialog box informs you and gives you the option to continue or cancel.

After the file has been selected, click **Update** to start the firmware upgrade.
Licenses for Mobile Control

A license is a software permit that an ATEN controller grants to a mobile device for remote control. If you have three licenses for a controller, you can remotely operate the controller using three mobile devices at the same time. Refer to the table below for the number of free licenses and the maximum number of paid licenses each controller supports. To purchase additional copies of license, contact your local sales representative.

<table>
<thead>
<tr>
<th>Licenses</th>
<th>ATEN Control Box (VK1100 / VK2100)</th>
<th>ATEN Control Pad (VK0100 / VK0200)</th>
</tr>
</thead>
<tbody>
<tr>
<td>No. of free licenses</td>
<td>2</td>
<td>0</td>
</tr>
<tr>
<td>Maximum no. of licenses</td>
<td>10</td>
<td>10</td>
</tr>
</tbody>
</table>

You can use the Licenses tab to:

- Find out the total number of licenses, the number of licenses that are available, and those that are in use
- Upload licenses to the ATEN controller
- View license information

![Licenses Tab](image)

**Licenses**

- **In Use**: displays the number of licenses being used by mobile devices.
- **Not in Use**: displays the number of licenses available for use.
- **Total**: shows the number of licenses purchased for the controller.

**Update License**

Clicking **Add** opens the **Add License** window to upload new licenses to the controller. Click **Browse** to locate the license file and Add to upload the license(s).

**Remove**

When a device is accessing the controller, you can click the **Remove** button to disconnect the session.
Storage

The Storage tab displays information about the space available for storing Viewers on the controller.

![Storage Tab Screenshot]

**Storage**

This section shows a graph displaying the percentage of space available on the controller to upload Viewers, as well as:

- **Space Used**: The amount of space currently being used to store Viewers uploaded to the controller.
- **Space Available**: The amount of space currently available to store Viewers on the controller.
- **Total Space**: The total amount of space available to store Viewers on the controller.

**Existing Viewer**

This section lists all the Viewers that are currently stored on the controller with their name and assigned room. Click Remove to delete a single Viewer or Remove All to delete all Viewers from the controller.
Access
The Access tab allows you to configure the access key (password) of the ATEN controller’s web interface and to set a validity period for accessing the ATEN Control System using an activation key.

Access Key
The access key is the password that is required to do the following:

- Log in the ATEN controller’s web interface.
- Upload projects and Viewers from Configurator to ATEN controller (page 185).
- Download Viewers from ATEN controller to mobile devices using ATEN Control System App (page 243).

The following settings are available:

- **Current Access Key, New Access Key, Confirm Access Key:** Use these three fields to set or change the access key. The default access key is **password**.

  **IMPORTANT:** You will be prompted to modify the access key before you can continue with accessing the web GUI or uploading project files.

- **Show on dashboard:** Select this option to show the access key setting on the Dashboard tab.

- **Enable Viewer Access Key:** Select this option to request for the access key when uploading projects and Viewers to the ATEN controller or when downloading Viewers to mobile devices. Once enabled, you can also configure this setting from the Dashboard tab.
**Activation Key**

The activation key is a string of letters and numbers used to assign a validity period of accessing the ATEN Control System.

To set up a validity period for accessing the ATEN Control System:

1. Select **Your access to ATEN Control System will expire in** and type the number of days.
2. Type an activation key. Follow the guidelines below when creating your activation key:
   - Max number of characters: 32
   - Allowed characters: uppercase and lowercase letters, numbers, and underscore
   - Max. number of days: 999 days
3. Type the activation key again to confirm.
4. Click **Save**. The limit is immediately applied. For example:

   ![Activation Key](image)

**Note:** Keep the activation key somewhere secure because it cannot be recovered. In case you forget the activation key, press the reset button/switch for 8 seconds to set the ATEN controller to default. This will reset all configuration of the controller to default and remove any projects and Viewers stored on the ATEN controller.

To disable the validity period, click **Enter Activation Key** to type the activation key provided by the system integrator.
Monitor
The Monitor tab allows you to view and enable the monitors that have been configured for Flags and digital input devices in ATEN Configurator. Check the Show on dashboard box to show the Monitor settings on the Dashboard. Click the slide bar next to the monitor you want to enable or use the drop-down menu to select All On or All Off.

For more information about creating monitors, see Library, page 155.
Network

The Network tab allows you to view and configure the controller’s network settings. Select Manually to set a static IP Address, Subnet Mask, and Default Gateway, or Use DHCP to have the server assign an IP address to the controller.

Note: Make sure to set the ATEN controller’s IP address and Default Gateway to the same subnet.
Connections

The Connections tab allows you to view the connection statuses and IP addresses of licensed devices, ATEN Keypads, and ATEN Expansion Boxes.
Schedule

The Schedule tab lists scheduled events predefined using the ATEN Configurator. You can use this tab to do the following:

- Enable or disable scheduled events.
- Enable or disable scheduled days

For details on setting up scheduled events, see Scheduled Events, page 178.
Security
The Security tab allows you to configure SSL and TSL settings to secure the browsing sessions between your computer and the ATEN controller’s web interface.

- **SSL Certificate:** To enable SSL encryption on the controller, purchase and obtain an SSL certificate from a trusted certifying authority and click **Upload** to apply the certificate.

- **TLS Support:** Each ATEN controller supports TLS 1.0, 1.1, and 1.2 to allow communications with devices supporting different versions of the TLS. If you have any security concerns, disable the **Enable TLS 1.0 and TLS 1.1** setting to only allow communications among devices that support TLS 1.2 and click **Save**.
Overview

The ATEN Configurator (VK6000) is a GUI-based management tool that helps you set up and configure the connected hardware and create control interfaces to be used by mobile devices and ATEN Keypads.

Installation

To install the ATEN Configurator software, do the following:

1. Download ATEN Configurator.
   b) Search for “VK6000”. A list of downloads for VK6000 appear.  
   c) Click ATEN_configurator_software_x.x.xxx.zip to download.

2. Open the downloaded zip file and double-click ATEN_configurator_software_x.x.xxx.exe to run the setup. This screen appears.
3. Click **Next**. This screen appears.

![Screenshot of InstallShield Wizard]

License Agreement

Please read the following license agreement carefully.

**Software End User License Agreement**

You may use our software and services only on the condition that you agree to abide by the following terms. We sincerely recommend that you shall read this Agreement very carefully.

- [ ] I accept the terms of the license agreement
- [ ] I do not accept the terms of the license agreement

4. If you agree with the License Agreement, select **I accept the terms of the license agreement**, and click **Next**. Click **Print** to print the *Software End User License Agreement*. This screen appears.

![Screenshot of Choose Destination Location]

Select folder where setup will install files.

- [ ] Install Win32
- [ ] C:\Program Files\ATEN\VK0000

![Screenshot of InstallShield]

Click **Next** to proceed with the installation.
5. To change the destination location, click **Change**. Click **Next** to proceed using the default location. This screen appears.

6. Click **Install**. When the process is complete, a confirmation message appears.

7. Click **Finish**.
Getting Started Tasks

After you have installed and launched the ATEN Configurator, the Main Page (page 76) appears. You will be guided to create and configure a project using the 4 tabs in the Configurator’s interface, as illustrated below.

**Hint:** You can click the tabs to switch among different pages for configuration.

The steps below provides an overview of the getting started tasks.

1. In the **Project** tab, do the following.
   - Provide information about the ATEN controller that you have set up.
   - (Optional) Provide client information for the specified ATEN controller.
   - Click **Add Controller** if you have more than one controller in the environment.

   For more details, see **Project**, page 84.

   Click **Start Project** to proceed.

2. In the **Device** tab, do the following.
   - Connect each controller with its managed devices by adding them to the controller’s Device Configuration list, enter the connection settings, and specify the physical locations.
   - (Optional) Add another controller and/or Expansion Box to the project by clicking **Add Controller or Expander**.
   - Connect the Extension Box with its managed devices by adding them to the Extension Box’s Device Configuration list.

   For more details, see **Device**, page 86.

   Click **Design** or the **Viewer** tab to proceed.
3. In the **Design** tab, do the following.
   - Create and configure a control interface (Viewer). For more information, see *Design*, page 102.
   - (Optional) Set up scheduled events to automatically carry out specified actions.
   - (Optional) Add additional conditions and actions to buttons using Flags. For details, see *Flag*, page 156.
   - (Optional) Create a sequence of actions for a button by creating a Macro. For details, see *Macro*, page 176.
   - (Optional) Create a Variable for a device setting that is controlled by two or more components in one control interface. For details, see *Variables*, page 179.

4. In the **Upload** tab, upload this Viewer to the controller. For details, see *Upload*, page 185.
Main Page

Double-click the **Configurator.exe** shortcut to open the ATEN Configurator software. The *Project* page appears:

<table>
<thead>
<tr>
<th>No.</th>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Menu bar</td>
<td>The <em>Menu Bar</em> contains categories with options that pertain to different sections of the software. Menu bar items are listed on page 78.</td>
</tr>
<tr>
<td>2</td>
<td>Project Bar</td>
<td>The <em>Project Bar</em> contains four tab and the Library icon. Each tab relates to a step required to set up the project. Each step and the Library can be selected by clicking on the bar. Each step is discussed, starting on page 84, and the Library on page 101.</td>
</tr>
<tr>
<td>3</td>
<td>Interactive Display Panel</td>
<td>This is the main work area. The page that appears here reflects the project tab that is selected.</td>
</tr>
<tr>
<td>4</td>
<td>Library</td>
<td>The Library contains the devices, graphic, flag, macro, and monitor databases. Each section allows you to add custom items or choose from ready made selections.</td>
</tr>
<tr>
<td>5</td>
<td>Toggle Bar</td>
<td>These three icons are used as a toggle to show or hide the right, left and bottom control panel.</td>
</tr>
</tbody>
</table>
Simulator The Simulator button is used to test the Viewer after it is created in Design. The simulator allows you to tryout the interface as it would work on a mobile device but without actually controlling devices. Use the mouse to click through the page links.

<table>
<thead>
<tr>
<th>No.</th>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>6</td>
<td>Simulator</td>
<td>The Simulator button is used to test the Viewer after it is created in Design. The simulator allows you to tryout the interface as it would work on a mobile device but without actually controlling devices. Use the mouse to click through the page links.</td>
</tr>
</tbody>
</table>
Menu Bar

Use the Menu Bar to select options in each project tab. The table below provides a description of each menu item.

<table>
<thead>
<tr>
<th>Menu</th>
<th>Sub-Menu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>File</td>
<td>New Project</td>
<td>Select to create a new project.</td>
</tr>
<tr>
<td></td>
<td>Open Project</td>
<td>Select to browse and open a previously saved project.</td>
</tr>
<tr>
<td></td>
<td>Restore Project from Controller</td>
<td>Downloads a previously backed up project from a controller.</td>
</tr>
<tr>
<td></td>
<td>Close</td>
<td>Closes the current project and returns to the Project tab.</td>
</tr>
<tr>
<td></td>
<td>Save</td>
<td>Select to save changes to the current project.</td>
</tr>
<tr>
<td></td>
<td>Save as</td>
<td>Use this option to save the project as a different name.</td>
</tr>
<tr>
<td>Export Viewer to USB</td>
<td>Export Viewer to USB (Not supported by ATEN Control Pad)</td>
<td>Exports Viewers and an access key to a USB drive. After exporting the data onto a USB drive, plug the USB drive into the Control Box's USB port to upload the Viewer files and the access key. These files can only be read by the Control Box and are not project files that can be opened by the ATEN Configurator software.</td>
</tr>
<tr>
<td></td>
<td>Project Report</td>
<td>Click to save a PDF file that contains detailed information about each part of the current project.</td>
</tr>
<tr>
<td></td>
<td>Import ETS Project</td>
<td>Import an ETS project file for your KNX devices.</td>
</tr>
<tr>
<td></td>
<td>Recent Projects</td>
<td>Select to view a list of recent projects that can be clicked on to open.</td>
</tr>
<tr>
<td></td>
<td>Exit</td>
<td>Select to close the project and exit.</td>
</tr>
</tbody>
</table>
### Menu | Sub-Menu | Description
--- | --- | ---
**Edit** | Undo | Select to undo a change when editing a Viewer in Create & Design Viewer.
| Redo | Select to redo a change when editing a Viewer page in Create & Design Viewer.
| Cut/Copy/Paste | Select to cut, copy or paste text and objects when editing a Viewer page in Create & Design Viewer. When used to copy and paste a button, both the General and Action properties are copied.
| Paste Graphic Only | Select to paste a button’s image but not its Action properties in Create & Design Viewer.
| Delete | Select to delete highlighted text and images when editing a page in Create & Design Viewer.
| Delete Action Only | Select to delete the Action properties of a button in Create & Design Viewer.
| Select All / Deselect All | Use either option to select or unselect all objects when editing a viewer page in Create & Design Viewer.

### Preferences
- **Display Language**: Use to select the language for the interface.
- **SSH Destination**: Click to choose the location of the executable for the SSH Client software. To execute the program, go to the menu bar and select Tools → SSH Client.

### Interface
- **Show Welcome Page**: displays the Welcome screen when the ATEN Configurator software opens.
- **Auto Page Creation**: automatically creates a Viewer page in Create Viewer & Design, for every hardware device that is configured in Select Device & Configuration.
- **Show Password**: displays the characters of the access key in the Edit Access Key dialog box.
- **Automatically check for updates**: automatically checks for updates and notify the user when an update is available.
### Menu

<table>
<thead>
<tr>
<th>Menu</th>
<th>Sub-Menu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>View</td>
<td>These options are available from Create Viewer &amp; Design → Edit Viewer.</td>
<td></td>
</tr>
<tr>
<td>Zoom</td>
<td></td>
<td>Zooms the Viewer page to 25%, 50%, 75%, 100%, 200% or Fit in Window. <strong>Note:</strong> A mouse wheel can be used to zoom the Viewer page in or out.</td>
</tr>
<tr>
<td>Project Information</td>
<td></td>
<td>Select to go to Project Information.</td>
</tr>
<tr>
<td>Device Configuration</td>
<td></td>
<td>Select to go to Select Device &amp; Configuration.</td>
</tr>
<tr>
<td>Viewer Design</td>
<td></td>
<td>Select to go to Create Viewer &amp; Design.</td>
</tr>
<tr>
<td>Project Upload</td>
<td></td>
<td>Select to go to Search &amp; Upload.</td>
</tr>
<tr>
<td>Properties</td>
<td></td>
<td>Select to show/hide the Properties window when editing a Viewer page.</td>
</tr>
<tr>
<td>Align to Grid</td>
<td></td>
<td>Select to automatically align objects with the grid. This places objects in perfect alignment with the grid dots when they are moved. Use Show Grid to display the grid dots. When Align to Grid is not selected, objects can be placed anywhere on the page.</td>
</tr>
<tr>
<td>Show Grid</td>
<td></td>
<td>Select to display the grid dots on the page. Use with the Align to Grid option to set objects in perfect alignment on the page.</td>
</tr>
</tbody>
</table>

### Object

<table>
<thead>
<tr>
<th>Menu</th>
<th>Sub-Menu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Button</td>
<td></td>
<td>Adds a button to the Viewer page.</td>
</tr>
<tr>
<td>Text</td>
<td></td>
<td>Adds a text box to the Viewer page.</td>
</tr>
<tr>
<td>Image</td>
<td></td>
<td>Adds an image to the Viewer page.</td>
</tr>
<tr>
<td>Scroll View</td>
<td></td>
<td>Adds a scroll box to the Viewer page, then double-click it to add buttons. Use the box as a scroll window to easily access a list of buttons on the page.</td>
</tr>
<tr>
<td>Video</td>
<td></td>
<td>Adds a video box which allows you to view video. The video box can be resized using the Properties sidebar or by dragging a small box on the boarder to resize it to the desired shape.</td>
</tr>
<tr>
<td>Slider Bar</td>
<td></td>
<td>Adds a slider bar to the Viewer page. Slider bars are used to adjust the value of a device setting, such as the volume level of an audio device.</td>
</tr>
</tbody>
</table>
### Chapter 4. ATEN Configurator (VK6000)

<table>
<thead>
<tr>
<th>Menu</th>
<th>Sub-Menu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Object</td>
<td>PowerPoint Control Template</td>
<td>Adds a PowerPoint Control template to the Viewer. This control template is used to control PowerPoint files saved in a target computer.</td>
</tr>
<tr>
<td></td>
<td>Media Control Template</td>
<td>Adds a Media Control template to the Viewer. This control template is used to control media files saved in a target computer.</td>
</tr>
<tr>
<td></td>
<td>Line</td>
<td>Adds a line to visually separate objects on the Viewer.</td>
</tr>
<tr>
<td></td>
<td>Frame</td>
<td>Adds a frame to visually frame an object or to group a set of objects in the Viewer.</td>
</tr>
<tr>
<td></td>
<td>Dial Kit</td>
<td>Adds a dial kit to the Viewer. The dial kit can be used for dialing a meeting.</td>
</tr>
<tr>
<td>Group</td>
<td>Group</td>
<td>Select multiple objects and use Group to lock them together. Objects in the group will move together as one.</td>
</tr>
<tr>
<td></td>
<td>Radio Group</td>
<td>Select multiple buttons and use Radio Group to associate them as follows: selecting a button that belongs to the radio group deselects the previously selected radio button within the same group.</td>
</tr>
<tr>
<td></td>
<td>Ungroup</td>
<td>Select grouped objects and use Ungroup to unlock the group.</td>
</tr>
<tr>
<td>Order</td>
<td>Bring to Front</td>
<td>Moves an object to the top position when objects are layered.</td>
</tr>
<tr>
<td></td>
<td>Send to Back</td>
<td>Moves an object to the bottom position when objects are layered.</td>
</tr>
<tr>
<td></td>
<td>Bring Forward</td>
<td>Moves an object up one position when objects are layered.</td>
</tr>
<tr>
<td></td>
<td>Send Backward</td>
<td>Moves an object down one position when objects are layered.</td>
</tr>
<tr>
<td>Menu</td>
<td>Sub-Menu</td>
<td>Description</td>
</tr>
<tr>
<td>-----------</td>
<td>------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Object</td>
<td>Align</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Left</td>
<td>Aligns two or more selected objects to the Left side of the object that is selected last.</td>
</tr>
<tr>
<td></td>
<td>Center</td>
<td>Aligns two or more selected objects to the horizontal position of the object that is selected last.</td>
</tr>
<tr>
<td></td>
<td>Right</td>
<td>Aligns two or more selected objects to the Right side of the object that is selected last.</td>
</tr>
<tr>
<td></td>
<td>Top</td>
<td>Aligns two or more selected objects to the Top side of the object that is selected last.</td>
</tr>
<tr>
<td></td>
<td>Middle</td>
<td>Aligns two or more selected objects to the vertical position of the object that is selected last.</td>
</tr>
<tr>
<td></td>
<td>Bottom</td>
<td>Aligns two or more selected objects to the Bottom side of the object that is selected last.</td>
</tr>
<tr>
<td>Make Same Size</td>
<td>Width</td>
<td>Resizes two or more selected objects to the same width of the object that is selected last.</td>
</tr>
<tr>
<td></td>
<td>Height</td>
<td>Resizes two or more selected objects to the same height of the object that is selected last.</td>
</tr>
<tr>
<td></td>
<td>Both</td>
<td>Resizes two or more selected objects to the same width and height of the object that is selected last.</td>
</tr>
<tr>
<td>Space Evenly</td>
<td>Across Page Width</td>
<td>Spaces two or more selected objects evenly across the width of the page.</td>
</tr>
<tr>
<td></td>
<td>Across Page Height</td>
<td>Spaces two or more selected objects evenly across the height of the page.</td>
</tr>
<tr>
<td></td>
<td>Between Objects Horizontally</td>
<td>Adjusts the horizontal space between three or more selected objects to the average distance between each of the selected objects.</td>
</tr>
<tr>
<td></td>
<td>Between Objects Vertically</td>
<td>Adjusts the vertical space between three or more selected objects to the average distance between each of the selected objects.</td>
</tr>
</tbody>
</table>
### Menu Sub-Menu Description

<table>
<thead>
<tr>
<th>Menu</th>
<th>Sub-Menu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tools</td>
<td>Database Generator</td>
<td>Opens the ATEN Database Generator which is used to manually add and configure hardware devices. This is where you can create custom devices to add to My Device Library. See ATEN Database Generator, page 189, for details.</td>
</tr>
<tr>
<td>Simulator</td>
<td></td>
<td>The Simulator is used to test a Viewer’s interface after it has been created in Design. The simulator allows you to tryout the interface as it would work on a mobile device but without actually controlling devices. Use the mouse to click through the page links.</td>
</tr>
<tr>
<td>SSH Client</td>
<td></td>
<td>This runs the SSH Client software selected under Edit → Preferences → SSH Destination. The SSH Client is used to communicate with the controller.</td>
</tr>
<tr>
<td>Windows</td>
<td>New Page</td>
<td>Click to create a new Viewer page or select a page to open in Create Viewer &amp; Design.</td>
</tr>
<tr>
<td>Help</td>
<td>About</td>
<td>Provides the firmware version and support information for the Configurator software.</td>
</tr>
<tr>
<td></td>
<td>Check for Updates</td>
<td>Checks if ATEN Configurator is up-to-date.</td>
</tr>
</tbody>
</table>
Project

The *Project* tab allows you to enter details about the installation to start the project. Enter the information using the table below as a guide.

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter the project name you are setting up. You can create multiple projects but for most installations only one project is required.</td>
</tr>
<tr>
<td>Add Controller</td>
<td>Click to add controllers to the project. The number added should match the number of controllers installed. A project can have up to 16 controllers.</td>
</tr>
<tr>
<td>Controller ID</td>
<td>Displays the Control Box ID. Make sure to set the Control Box ID Switch on the rear of the Control Box using the ID displayed here so that the project file will be uploaded to the controller set with the same ID.</td>
</tr>
<tr>
<td>ATEN Controller Type</td>
<td>Select the controller model you are installing.</td>
</tr>
</tbody>
</table>
Chapter 4. ATEN Configurator (VK6000)

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of Rooms</td>
<td>Enter the number of rooms each controller will control. Each hardware device you add will be associated with a room. When buttons are configured in the Design tab, you can select a Room under Button Action to filter the Device list so that only hardware in that room appears. This link between the controller, devices and room is how the Viewer knows which devices to control.</td>
</tr>
<tr>
<td>Name</td>
<td>Enter the client name associated with the project.</td>
</tr>
<tr>
<td>Address</td>
<td>Enter the client address associated with the project.</td>
</tr>
<tr>
<td>Phone</td>
<td>Enter the client phone number associated with the project.</td>
</tr>
<tr>
<td>Remove Controller</td>
<td>Click to delete a controller from the project.</td>
</tr>
<tr>
<td>Start Project</td>
<td>Click to begin configuring hardware devices. The Select Device &amp; Configuration tab will open.</td>
</tr>
</tbody>
</table>
Device

The *Device* tab is used to configure controller ports according to the connected hardware device.

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Device Configuration List</td>
<td>This section lists the ports for each controller. Select a Controller, Expansion Box or Room in the left sidebar to display the ports. Each port needs to be configured according to the hardware device connected to it. For details, see <em>Device Configuration List</em>, page 87.</td>
</tr>
<tr>
<td>Left Sidebar</td>
<td>This section lists the Controllers, Expansion Boxes and Rooms. Use the sidebar to add a controller, Expansion Box or Room. When a port is configured with a device, the device appears listed below the room on the sidebar. For details, see <em>Left Sidebar</em>, page 90.</td>
</tr>
<tr>
<td>Properties</td>
<td>This section allows you to add and configure controllers, Expansion Boxes, managed devices, and rooms. For details, see <em>Design</em>, page 102.</td>
</tr>
<tr>
<td>Device Library</td>
<td>Click this icon to open the Library on the <em>Device Library</em> tab which contains a database of hardware devices that can be added to the Device Configuration list. For details, see <em>Device Library</em>, page 101.</td>
</tr>
</tbody>
</table>
Device Configuration List

The Device Configuration page lists the controller ports by type. Click a port to view its Properties (page 90). Double-click a port to open the ATEN Device Library and search for the hardware device to configure the port. Configure each port according to the hardware device connected to it.

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>Lists the ports of the controller.</td>
</tr>
<tr>
<td>Device</td>
<td>Lists the device name entered in Properties.</td>
</tr>
<tr>
<td>Mode</td>
<td>Lists the port’s communication mode. Click an arrow to select options:</td>
</tr>
<tr>
<td></td>
<td>- <strong>Serial</strong>: RS232, RS422, or RS485</td>
</tr>
<tr>
<td></td>
<td>- <strong>I/O</strong>: Input (VDC), Input (Dry Contact) or Output</td>
</tr>
<tr>
<td></td>
<td>- <strong>IR</strong>: IR or RS232</td>
</tr>
<tr>
<td>Room</td>
<td>Lists the room selected for a device. The rooms available depend on the</td>
</tr>
<tr>
<td></td>
<td>number of rooms added to the controller. No drop-down menu appears if there</td>
</tr>
<tr>
<td></td>
<td>is only one room. Each controller must have at least one room. Select the</td>
</tr>
<tr>
<td></td>
<td>room where the device is installed.</td>
</tr>
<tr>
<td>+ Add More Devices</td>
<td>RS422, RS485, LAN and IR ports can cascade additional devices that are</td>
</tr>
<tr>
<td></td>
<td>connected to the first unit. IR ports can cascade 1 device, RS422</td>
</tr>
<tr>
<td></td>
<td>and RS485 ports can cascade up to 2 devices and LAN ports can cascade up to 25 devices.</td>
</tr>
</tbody>
</table>
Adding Devices to ATEN Configurator

Add the devices to be managed by your ATEN controller to the Device Configuration list and configure their settings.

- To add KNX devices, follow the steps below:
  1. Click File and then Import ETS Project. The configurations for your KNX devices appear in the Controller tab on the left-side bar.
  2. In the Controller tab, click on KNX IP Interface and type its IP address and port in the Properties column.

- To add devices that are not KNX compliant, use one of the following methods:
  - Add devices using ATEN Device Library or My Library
    1. In the Device Configuration list, click a port where you have physically installed a device.
    2. Click library. In the pop-up window, click the drop-down list to select ATEN Device Library or My Library, and then double-click an item to add a device. The selected device is added to Device Configuration.
Add devices using the Properties column

Type the name of the device in Properties, and then click Add Device.

Note: If the device is not in the Library, create the device using Database Generator. For details, see Editing / Adding a New Device, page 196.
**Left Sidebar**

**Controller**
The Left Sidebar provides a tree view of the controllers, Expansion Boxes, and rooms. Each controller in the tree view represents a controller with one or more rooms it manages. Selecting a controller allows you to configure its ports. When a port is configured for a device, it appears listed under the Room.

Each controller must have at least one room. When installing multiple controllers in one room, add a room with the same name to each controller.

Each controller name ends with an ID number: VK2100-ID01. Use this number to set the Controller ID Switch on the rear of the controller. This links the controller in the software to the physical device being installed.

Right-click a controller to Add Room or Delete Controller.

**Room**
Each room is associated with a controller and a Viewer so that the information is uploaded to the correct controller to control the hardware devices.

Right-click a room to Delete or Rename the room.

Use the buttons at the bottom of the sidebar to Add Room.

**Expansion Box**
ATEN Expansion Boxes connect over a network to add ports to the controller via its Ethernet port. Clicking Add Controller or Expander opens a window which allows you to select a device to add:
Properties

The Properties panel provides information and configuration fields for controllers, Expansion Boxes, remote devices, or rooms. Click a device or room from the left sidebar or the Device Configuration list to display its properties.

Controller Properties

Click a controller from the left sidebar or the Device Configuration list to configure the following properties.

- **Name**: Type to change the device name.
- **Controller ID**: Sets the controller ID. ATEN Expansion Box and Keypad will connect to a controller with a matching controller ID as set on the Expansion Box or Keypad using the Controller ID Switch.

- **Identify ATEN Expansion Box and Keypad by IP Address**:

  **Note**: Only enable this function if any of the following scenario applies.

  - Need to install more than 16 controllers under the same subnet.
  - Your network switch blocks multicast signals between the controller and Expansion Box/Keypad.

  When enabled, the controller connects to an ATEN Expansion Box/Keypad with matching controller ID and Expansion Box/Keypad IP address.

  To use this function, make sure to do the following.

  - On the Expansion Box/Keypad:
    - Set the controller ID using the Controller ID Switch. When you have more than 16 controllers under a subnet, at least two of the Expansion Boxes and/or Keypads will be assigned with the same controller ID.
    - Set the Expansion Box/Keypad to a fixed IP address.
  - In the project files:
    - In the Devices tab, make sure the controller IDs match the configuration on the Expansion Boxes and/or Keypads.
In the **Devices** tab, enable the **Identify ATEN Expansion Boxes and Keypads by IP address** function the Properties panel. For example, if you have 17 controllers set up under the same subnet, with controller 1 and 17 using ID01, enable the function for both of these controllers.

- Specify the IP address of the Expansion Box/Keypad.

  For Keypad, go to **Design > Viewer Settings**.

![Viewer Settings](image1)

For Expansion Box, go to **Devices** and find the Properties panel.

![Devices Properties](image2)

- **Port**: Specify the port to allow TCP communications from third-party client devices.
Expansion Box (Expander)

When you select an Expansion Box from the left side bar, the properties provides a drop-down menu to set the Expander ID (ID01~ID08) and the option to configure the IP Address.

To add an Expansion Box, click **Add Controller or Expander** on the left sidebar, then use the arrow and select an ATEN Expansion Box to add. The expansion box and ports will be listed on the **Device Configuration** page, as shown below:

<table>
<thead>
<tr>
<th>Type</th>
<th>Device</th>
<th>Mode</th>
<th>Room</th>
</tr>
</thead>
<tbody>
<tr>
<td>Serial 1</td>
<td>None</td>
<td>RS232</td>
<td>Room-1</td>
</tr>
<tr>
<td>Serial 2</td>
<td>None</td>
<td>RS232</td>
<td>Room-1</td>
</tr>
<tr>
<td>Serial 3</td>
<td>None</td>
<td>RS232</td>
<td>Room-1</td>
</tr>
<tr>
<td>Serial 4</td>
<td>None</td>
<td>RS232</td>
<td>Room-1</td>
</tr>
</tbody>
</table>
Serial Device Properties

Click a serial device from the Device Configuration list to configure its properties.

- **Name**: Type to set the device name.
- **Add Device**: Adds devices. You can use either of the following methods to add devices:
  - Type the device name in the Name field and click Add Device.
  - Click the arrow button (following the Add Device button) and select add device from library to open the device library. Double-click a device to bring in its information and settings.
- **Category**: Displays the category of the selected device.
- **Brand**: Displays the brand of the selected device.
- **Model**: Displays the model of the selected device.
- **Version**: Shows the firmware version selected for the device. Use the drop-down menu to select a different firmware version. Click the menu box next to the version number to open a PDF with the version history. The version history and different versions for a device can be manually added/updated via the Database Generator (see step 3 of Editing / Adding a New Device, page 196).
- **Connection Settings**: Click the drop-down lists to configure the baud rate, data bit, stop bit, parity settings, and flow control for the selected serial device.
- **Advance Settings**: Click Advanced to display the following settings.
• **Delay Interval**: Sets a time delay for each command before they are sent to the device.

• **Feedback Timeout**: Sets the maximum interval that the controller allows in between parts of a feedback message. The controller uses this value to identify the end of a message.

• **Keep Connection Alive**: The controller sends a command to the serial device to maintain the connection and avoid timeout issues.
  - **Command**: Type a command to be sent to the selected device.
  - **Interval**: Type the interval at which the controller sends the command.
I/O Device Properties

Click an I/O device from the Device Configuration list and select **Input (VDC)**, **Input (Dry Contact)**, or **Output** to configure its properties.

- **Name**: Type to set the device name.
- **Add Device**: Adds devices. You can use either of the following methods to add devices:
  - Type the device name in the Name field and click **Add Device**.
  - Click the arrow button (following the **Add Device** button) and select **add device from library** to open the device library. Double-click a device to bring in its information and settings.
- **Category**: Displays the category of the selected device.
- **Brand**: Displays the brand of the selected device.
- **Model**: Displays the model of the selected device.
- **Version**: Shows the firmware version selected for the device. Use the drop-down menu to select a different firmware version. Click the menu box next to the version number to open a PDF with the version history. The version history and different versions for a device can be manually added/updated via the Database Generator (see step 3 of **Editing / Adding a New Device**, page 196).
- **Lower Threshold & Upper Threshold**: Set the thresholds according to the hardware device you are connecting and then configure a Monitor (see page 158).
- **Advance Settings**: Click **Advanced** to display the Delay Interval setting.
  - **Delay Interval**: Sets a time delay for each command before they are sent to the device.
**IR/Relay Device Properties**

Click an IR/Relay device from the Device Configuration list to configure its properties.

- **Name:** Type to set the device name.
- **Add Device:** Adds devices. You can use either of the following methods to add devices:
  - Type the device name in the Name field and click **Add Device**.
  - Click the arrow button (following the **Add Device** button) and select **add device from library** to open the device library. Double-click a device to bring in its information and settings.
- **Category:** Displays the category of the selected device.
- **Brand:** Displays the brand of the selected device.
- **Model:** Displays the model of the selected device.

- **Version:** Shows the firmware version selected for the device. Use the drop-down menu to select a different firmware version. Click the menu box next to the version number to open a PDF with the version history. The version history and different versions for a device can be manually added/updated via the Database Generator (see step 3 of **Editing / Adding a New Device**, page 196).

- **Advance Settings:** Click **Advanced** to display the Delay Interval setting.
  - **Delay Interval:** Sets a time delay for each command before they are sent to the device.
Ethernet Device Properties

Click an Ethernet device to configure its properties. Each Control Box supports up to 25 Ethernet devices, and each Control Pad supports up to 8.

- **Name:** Type to set the device name.
- **Add Device:** Adds devices. You can use either of the following methods to add devices:
  - Type the device name in the Name field and click **Add Device**.
  - Click the arrow button (following the **Add Device** button) and select **add device from library** to open the device library. Double-click a device to bring in its information and settings.
- **Category:** Displays the category of the selected device.
- **Brand:** Displays the brand of the selected device.
- **Model:** Displays the model of the selected device.
- **Version:** Shows the firmware version selected for the device. Use the drop-down menu to select a different firmware version. Click the menu box next to the version number to open a PDF with the version history. The version history and different versions for a device can be manually added/updated via the Database Generator (see step 3 of *Editing / Adding a New Device*, page 196).

- **Connection Settings**
  Depending on the selected protocol, some of the following settings may not be required and are not displayed.
- **Protocol Type:** Click to select the protocol for the Ethernet device. The ATEN Control System supports control of devices via telnet, ONVIF, TCP, UDP, HTTP, and HTTPS.
- **IP Address:** Type to assign a fixed IP address to the Ethernet device.
- **Port:** Type to assign a communication port.
- **Username & Password:** Type to set up the login/access credentials for the device.
- **Auth Type:** Sets the authentication type that the device uses.
- **Advance Settings:** Click **Advanced** to display the Delay Interval setting.
  - **Delay Interval:** Sets a time delay for each command before they are sent to the device.
  - **Delay after Login (for telnet only):** Sets a delay (to allow a connection to be established) before the First and Second Commands are sent to the device.
  - **Send command after connection (for telnet and TCP only):** Sends commands to the device after a successful connection has been established.
    - **Format:** Sets the command format.
    - **First Command:** Sets the command.
    - **Second Command:** Sets the second command.
    - **Automatically reconnect if no return message is received:** Select this option to continue reconnection attempts when no return message is received from the device.
  - **Keep Connection Alive (for telnet and TCP only):** The controller sends a command to the device to maintain the connection and avoid timeout issues.
    - **Command:** Type a command to be sent to the selected device.
    - **Interval:** Type the interval at which the controller sends the command.
Library

The Project Bar provides the Library option. Use the Device Library tab (shown below) to configure controller ports according to the connected hardware devices. The Device Library provides an extensive database of hardware devices that can be double-clicked or drag and dropped into the Device Configuration page to configure controller ports. The Device Library is discussed on the next page.

![Device Library Image]
Device Library

The Device Library tab is a database of hardware devices that instantly configure controller ports. Search the library for the device connected to a controller port then add it to configure the port. For devices not in the library, use the ATEN Database Generator to create custom hardware (see page 189). Click Library on the Project bar or double-click a port on the Device Configuration page to open the ATEN Device Library.

- Add a device by clicking Add to Project or by drag & drop.
- To search for a device type keywords into the box and click .
- Click a tab to filter by All, Serial, DO, IR, Relay or Ethernet.
- Click headings to sort by Brand, Device Type, Model or Version.
- Use the drop-down menu to select:
  - ATEN Device Library – ATEN’s database of hardware devices.
  - My Device Library – Devices added from the Database Generator.
  - Create Device – Opens the Database Generator to create custom hardware devices for My Device Library (page 190).
Design

Overview

The Design tab is for creating a Viewer – the user interface that controls the hardware from a mobile device or Keypad. Create a Viewer and add the pages to control the hardware according to the setup you are installing.

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Left Sidebar</td>
<td>The left sidebar lists each Viewer and its pages. The sidebar allows you to add Viewers and pages. These options become available after clicking Done on the Viewer Settings page. For more details, see Left Sidebar, page 90.</td>
</tr>
<tr>
<td>Select Viewer</td>
<td>The Select Viewer section allows you to select a Viewer template for your controller, Keypad, and/or Touch Panel. See Left Sidebar, page 103, for details.</td>
</tr>
<tr>
<td>Library</td>
<td>Click this icon to open the Library which provides access to the Graphic (page 153), Flag (page 156), Monitor (page 158), Macro (page 176), Scheduled Event (page 178), and Variable settings (page 179).</td>
</tr>
<tr>
<td>Simulator</td>
<td>The Simulator button is used to test a Viewer’s interface after it has been created. The simulator allows you to tryout the interface as it would work on a mobile device but without actually controlling devices. Use the mouse to click through the page links.</td>
</tr>
</tbody>
</table>
Left Sidebar

**Viewer**

The Left Sidebar provides a tree view of the Viewers and Pages. Clicking a Viewer opens the Page Overview which is a layout of the Viewer.

Right-click a Viewer to **Delete**, **Rename** or **Edit** the Viewer.

Use **Add Viewer** at the bottom of the sidebar to create a new Viewer.

**Pages**

Each Viewer lists the Home Page with each Viewer Page created for the Viewer under it.

Clicking a Home or Viewer Page on the sidebar opens a new tab where the page can be edited.

Right-click a page to **Delete**, **Rename**, or **Copy** the page and paste it to another Viewer within the same or a different project file. The Copy function replicates the page's visual design without its configurations.

The Home Page cannot be deleted.

Use **Add Page** at the bottom of the sidebar to add a page to the Viewer.
Adding a Viewer

A Viewer is a control interface that you use on mobile devices, ATEN Keypads, ATEN Control Pads, or ATEN Touch Panels to centrally control devices and equipment.

To add a Viewer and/or its associated control pages, follow the steps below.

1. In the Configurator, go to the Design tab. This screen appears. If the Select control device and Viewer page does not appear, click Add Viewer from the left sidebar.
2. Select your device type.

3. Configure the displayed settings for your selected device.

- Mobile Device

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>Use this drop-down menu to select the mobile device that will be used to control hardware devices in a room. This sets the resolution for the Viewer to fit on the mobile device’s screen. Choose a Custom selection to configure a screen size with the Resolution drop-down menu below it. <strong>Note:</strong> If you select Custom Windows Device — the Windows OS has a limitation for adding buttons to Viewers used on Windows mobile devices. See page 253, for details.</td>
</tr>
<tr>
<td>Resolution</td>
<td>Use this drop-down menu to set a custom screen resolution for the mobile device being used to control hardware devices. This option becomes available when you select one of the Custom selections from the Type drop-down menu.</td>
</tr>
<tr>
<td>Display Aspect Ratio</td>
<td>Indicates the aspect ratio used for the selected device.</td>
</tr>
</tbody>
</table>

## Keypad

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Home Page</td>
<td>Select a template for the Viewer’s home page.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Blank</strong>: Creates a custom home page that you design from scratch.</td>
</tr>
<tr>
<td></td>
<td>- <strong>ATEN Themes</strong>: Select any of the ATEN Themes to create a home page and other device pages with graphics. These pages are customizable.</td>
</tr>
<tr>
<td>Model</td>
<td>Specify the Keypad model.</td>
</tr>
<tr>
<td>Number of Keys</td>
<td>Specify the total number of keys for your Keypad.</td>
</tr>
<tr>
<td>Layout</td>
<td>Specify the Keypad layout. This setting should match the physical Keypad layout (see page 51 for details). Depending on the total number of keys the Keypad has, you may have 1 or multiple options for this setting.</td>
</tr>
<tr>
<td>Controller ID</td>
<td>Select the ID number of the Control Box (Controller) that the Keypad will connect through. This ID must match the controller ID Switch (black) set on the Keypad (see page 55).</td>
</tr>
<tr>
<td>Keypad ID</td>
<td>- Select the ID number to match the Keypad ID Switch (blue) set on the Keypad (see page 55). Up to 8 Keypads can connect to one Control Box.</td>
</tr>
<tr>
<td></td>
<td>- (Optional) Type the IP address of the Keypad with which the controller uses to identify and establish connection. Use this feature when you have more than 16 ATEN Expansion Box and/or ATEN Keypad in the project or when the network switch blocks multicast signals between the Keypad and the controller.</td>
</tr>
<tr>
<td>Add Keypad</td>
<td>Click <strong>Add Keypad</strong> to add another Keypad that will connect to the same Control Box and control the same set of devices.</td>
</tr>
</tbody>
</table>

## Control Pad

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Model</td>
<td>Specify the model for the Control Pad.</td>
</tr>
<tr>
<td>Number of Keys</td>
<td>Specify the total number of keys for your Control Pad.</td>
</tr>
</tbody>
</table>
Chapter 4. ATEN Configurator (VK6000)

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Layout</td>
<td>Specify the layout for the Control Pad. This setting should match the physical layout (see page 51 for details). Depending on the total number of keys the Control Pad has, you may have 1 or multiple options for this setting.</td>
</tr>
<tr>
<td>Controller ID</td>
<td>Displays the Control Pad ID.</td>
</tr>
</tbody>
</table>

* Touch Panel

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>Use this drop-down menu to select the Touch Panel that will be used to control hardware devices in a room.</td>
</tr>
<tr>
<td>Resolution</td>
<td>Use this drop-down menu to set a custom screen resolution for the TouchPanel.</td>
</tr>
<tr>
<td>Display Aspect Ratio</td>
<td>Indicates the aspect ratio used for the selected device.</td>
</tr>
<tr>
<td>Home Page</td>
<td>Select a template for the Viewer’s home page.</td>
</tr>
<tr>
<td></td>
<td><strong>Blank</strong>: Creates a custom home page that you design from scratch.</td>
</tr>
<tr>
<td></td>
<td><strong>ATEN Themes</strong>: Select any of the ATEN Themes to create a home page and other device pages with graphics. These pages are customizable.</td>
</tr>
</tbody>
</table>

4. Click **Done** to save the configuration. An overview appears showing all the control pages that the selected Viewer has.
5. (Optional) Add, edit, or remove the pages or adjust the basic settings of the Viewer.

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Duplicate</td>
<td>Click to duplicate the Viewer along with the pages.</td>
</tr>
<tr>
<td>EditPreferences</td>
<td>Click to edit the basic Viewer settings that you configured in step 3.</td>
</tr>
<tr>
<td>Add Page</td>
<td>Click to add a page to the highlighted Viewer in the left sidebar.</td>
</tr>
<tr>
<td>Configure</td>
<td>Click to configure the page. For more information, see Configuring the Viewer, page 109.</td>
</tr>
<tr>
<td>Remove</td>
<td>Click to remove the page.</td>
</tr>
</tbody>
</table>
Configuring the Viewer

After you have added the Viewer and the associated pages, you are ready to configure the page layout and object actions, for example, button actions in the Viewer.

To configure a Viewer, follow the steps below.

1. Use one of the following methods to open the page you wish to configure.
   - Click the page from the left sidebar.
   - Click its associated Viewer from the left sidebar and then click to open a page.

The page opens in a tab. For example:

2. To add more control objects on the page, right-click on the preview, and select an option from the pop-up menu.

**Note:** The Windows OS has a limitation when adding buttons to Viewer pages for use on Windows mobile devices. See *Object Properties*, page 112, for details.
3. Click the element in the preview panel to customize the settings. See the table below for more information.

<table>
<thead>
<tr>
<th>Element</th>
<th>Tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preview panel</td>
<td>Shows a preview of the selected page. You can also do the following on the preview panel:</td>
</tr>
<tr>
<td></td>
<td>• To zoom in and out on the preview, scroll the mouse wheel.</td>
</tr>
<tr>
<td></td>
<td>• To relocate an object, drag and drop the object.</td>
</tr>
<tr>
<td></td>
<td>• To layer an object, right-click the object and set the Order options.</td>
</tr>
<tr>
<td></td>
<td>• To group multiple objects, drag the mouse to select the objects, right-click on any of the objects and select <strong>Group</strong>.</td>
</tr>
<tr>
<td></td>
<td>• To align object, drag the mouse to select the objects, right-click on any of the objects and select <strong>Align</strong>.</td>
</tr>
<tr>
<td></td>
<td>• To set objects in perfect alignment, use the <strong>View</strong> menu options to select <strong>Show Grid</strong> and <strong>Align to Grid</strong>.</td>
</tr>
</tbody>
</table>
### Chapter 4. ATEN Configurator (VK6000)

<table>
<thead>
<tr>
<th>Element</th>
<th>Tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Properties panel</td>
<td>Use the panel to configure selected object properties. For detailed information about object properties, see <em>Object Properties</em>, page 112.</td>
</tr>
<tr>
<td>Library</td>
<td>Use Library to customize the appearance of the page and its buttons. For more information, see <em>Library</em>, page 100.</td>
</tr>
<tr>
<td>Button Action or Slider Bar Action</td>
<td>Use this panel to define the functions of each button and slider bar. For detailed information, see <em>Button / Slider Bar / Dial Kit Actions</em>, page 130.</td>
</tr>
<tr>
<td>Advanced functions</td>
<td>• To add additional conditions and actions to buttons, use the Flag function. For more information, see <em>Flag</em>, page 156.</td>
</tr>
<tr>
<td></td>
<td>• For a button to initiate a sequence of actions, create a Macro. For more information, see <em>Macro</em>, page 176.</td>
</tr>
</tbody>
</table>
Object Properties

This section provides detailed information about properties of control objects on the Viewer. Note that the supported objects and their functions may differ among Viewers for mobile devices, Keypad, and Control Pad.

Page Objects

A number appears at the top right corner of each object. The numbers are assigned in sequence, in the order that the object is added. These numbers help identify a label when configuring a Change Label (page 147) or a button when configuring a Change Button State (page 146).

Each button has a symbol in the top left corner to indicate:
- “A” the button’s actions are configured correctly.
- “!” the button’s actions need to be modified or they will not work.
- Buttons with no symbol indicate that functions have not been added to it.

For details on adding functions, see Button / Slider Bar / Dial Kit Actions, page 130.
Object Properties for Mobile Devices

After you have added a Viewer (page 104) for your mobile device, you can start configuring the pages that the Viewer contains in the Properties panel.

Buttons

The Button properties provide options to configure the appearance of a button, and the confirmation message and progress message before carrying out the associated action.
• **Alignment** – Aligns a group of objects. Select multiple objects for the buttons to become available:

<table>
<thead>
<tr>
<th>Properties</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Alignment Options" /></td>
</tr>
</tbody>
</table>

• **Mode**

Use this drop-down menu to select one of the following button types.

- **Normal** – This is a button that stays the same when pressed.
- **Toggle** – for a button that switches between two images/colors to indicate the button status. This also splits the Commands list under **Button Action** (page 130) – to provide two commands for the button: Toggle ON and Toggle OFF.
- **Press and Release** – for a button that switches between two images/colors when pressed and released. This splits the Commands list under **Button Action** (page 130) to provide two commands for the button: Press and Release.
- **Long Press** for a button that switches between two images/colors when pressed and released. This button continuously re-sends a command to a device as long as it is pressed, at the **Interval** specified (see **Interval**, below) and stops sending the command once the button is released.

**Note:** Use the **Normal** or **Long Press** option to set the image/color of the button based on its status.

• **Appearance**

Click the **Appearance** tab to configure the look of the button.

**Note:** The Appearance settings are applicable to all button modes. However, the **Appearance** tab only exists for Normal and Toggle buttons to categorize different sets of settings.

- **Name** – (optional) type the text you want to use for the button (or slow double-click the button on the Viewer page).
- **Font** – use the drop-down menu to select the font type.
  - **Color** – use the drop-down menu to change the color of the text.
  - **Size** – enter a number (1-200) to set the size of the text for the button.
- **Format** – formats text to **Bold**, **Italic** or **Underline** for the button.
• **Alignment** – click a box to align the text Right, Center or Left; and Top, Middle or Bottom within the button box.

• **Style** – use the drop-down menu to select the style type.
  - **Normal** imports an image to use as the button’s standard background and click **Pressed** to import an image to use when the button is pressed.
  - **Color** allows you to use drop-down menus to select the buttons color for Normal and Pressed.
  - **Transparency** – enter a number (0-100) or use the slider-bar to set the transparency of the button.

• **Send Command Every** (Long Press mode buttons only) – use the drop-down menu to select the amount of time between each command that is sent (repeatedly) to the device while the button is pressed.

• **Position and Size** – X and Y position the button at the coordinates entered. *Width* and *Height* set the size of the button box. Click **Reset Image Size** to reset the button size.
  - **Reset Image Size** – click to reset the button size.
  - **Set Sync Condition** – automatically synchronizes the button setting to the selected variable. To create variables, see **Variables**, page 179.

• **Restrict access to this button on ATEN Control System App with a password:** Limit the use of the selected button by requesting a password when the button is tapped in the Viewer. To enable this function, click this option and type the password in the box below.
  - **Note:** This function is only supported by the Normal and Toggle mode buttons (page 114).

• **Dialog**
  - Click the **Dialog** tab to set up a confirmation message that displays in the Viewer when the button is pressed.

  - **Note:** The Dialog settings are only available for Normal and Toggle buttons.

  • **Confirm the associated action with the following message when the button is pressed** – Click the check box to enable this feature.

  • **Action** – Select a button action (**Toggle On** or **Toggle Off**) to display the confirmation message.

  • **Content drop-down list** – Select one of the following for customization.
Background – Customize the wording for the confirmation message. Type the message in the Name field and optionally customize its font and style.

OK – Customize the wording on the button for carrying out the associated action. Type in the Name field and optionally customize its font and style.

Cancel – Customize the wording on the button for canceling the associated action. Type in the Name field and optionally customize its font and style.

Message
Click the Message tab to set up a progress message that displays while the associated action is being carried out.

Note: The Message settings are only available for Normal and Toggle buttons.

- Confirm the associated action with the following message when the button is pressed – Click the check box to enable this feature.
- Action – Select a button action (Toggle On or Toggle Off) for displaying the progress message.
- Content drop-down list – Select one of the following for customization.
  - Background – Configure the wording for the progress message. Type the message in the Name field and optionally customize its font and style.
  - Progress Bar – Configure the display duration (in seconds), font, and color of the progress indicator.
Groups

You can unify the properties of two or more control components (buttons, slider bars, etc.) at the same time. Depending on the elements that your group of components have, different properties will be open for configuration. Use your mouse to drag and select the components from a page, the properties that are open for configuration appear in the Properties column.

For example, if you want to unify the text that appear on multiple buttons, drag and select these buttons and then configure their properties, as illustrated below.
Labels

The Label properties provide settings for the displayed text and its format.

*Alignment* – Aligns a group of objects. Select multiple objects for the buttons to become available:

- **Name** – enter the text you want to use for the label or slow double-click the label on the Edit page.
- **Font** – use the drop-down menu to select the font type.
- **Color** – use the drop-down menu to change the color of the text.
- **Size** – enter a number (1-200) to set the size of the text.
- **Format** – format text to Bold, Italic or Underline.
- **Alignment** – click a box to align the text Right, Center or Left; and Top, Middle or Bottom within the label box.
- **Border/Line** – select this option to configure the color, format, and width of the display screen border.

*Position and Size* – *X* and *Y* position the label at the coordinates entered. *Width* and *Height* set the size of the label.

*Set Sync Condition* – Displays the value of the selected variable in percentage or its raw form. To create variables, see Variables, page 179.
**Slider Bars**

Right click on a Viewer page and select **Slider Bar** to add a bar. A Slider Bar can control a device, link to another page, or run a macro.
Use the Mode drop-down menu to select the type of slider bar (Basic Slider Bar or Advanced Slider Bar).

Basic Slider Bar

- A slider bar where you enter the minimum and maximum values to calculate the range and levels on a slider bar, and then add one command to configure the Basic Slider Bar’s action (See Slider Value, page 136). Choose options under Value to configure the slider bar’s range.
- **Direction** – sets the bearing of the slider bar.
- **Style** – click the drop-down menus to select the Foreground Color and Background Color for the slider bar.
- **Value** – Sets the total number of levels for the slider bar.
  - ASCII / HEX – click a radio button to select the format for the slider bar values.
  - **Minimum** – enter the lowest level on the bar.
  - **Maximum** – enter the highest level on the bar.
  - **Level** – this represents the number of levels on the slider bar. You can calculate the value of each level with the formula: Maximum Value - Minimum Value / Level = Value Per Level. The Level is automatically calculated according to the Minimum and Maximum values you enter.
- **Position and Size** – depending on whether the bar is set Vertical or Horizontal you can use either the Size: Width or Height box to enter a number to resize the length of the slider bar.
- **Set Sync Condition** – Automatically synchronizes the slider bar to the selected variable. To create a variable, see Variables, page 179.

Advanced Slider Bar

- A slider bar where you set the number of levels and add a command for each level in the bar (see Level, in the table, on page 130). Choose options under Value to configure the slider bar’s range:
- **Direction** – sets the bearing of the slider bar.
- **Style** – click the drop-down menus to select the Foreground Color and Background Color for the slider bar.
- **Value** – Sets the total number of levels for the slider bar. Level – this represents the number of levels on the slider bar. For each level you must add a separate command in the Slider Bar Action – Commands list (see Level, in the table, on page 130).
PowerPoint Control and Media Control Templates

Click a PowerPoint control template or a media control template to configure its position, size, and the PC that controls it.

- **Position and Size** – X and Y position the label at the coordinates entered. *Width* and *Height* set the size of the label.
- **Select Device** – Select the PC that stores the PowerPoint or media files using the drop-down list.
Image

The **Properties** for an image provide options to change and import images to the page. Images can be layered with other objects so that they can be placed as a background or as highlights for buttons (see *Layering Images*, page 123). You can **Group**, **Order**, **Align**, **Make Same Size** or **Space Evenly** from the **Object** menu.

**Note:** For imported images, make sure the file names contain English alphabets and/or numerals only.

- **Style** – shows the image selected. Click inside the box to import an image (*.png, *.jpg, *.jpeg, *.bmp) to the page.
- **Transparency** – enter a number (0-100) or use the slider-bar to set the transparency of the image selected.
- **Position and Size** – $X$ and $Y$ position the image at the coordinates entered. $Width$ and $Height$ set the size of the image.
- **Reset Image Size** – resets the image size.
Layering Images

Images can be layered with other objects, such as labels and buttons, so that they can be placed as a background or as highlight for the page and/or other objects.
Dial Kit

A dial kit template consists of a display screen and a set of dial keys. To configure their appearance, click on the display area or a key.
Chapter 4. ATEN Configurator (VK6000)

- **Font** – use the drop-down menu to select the font for the typed text.
- **Color** – use the drop-down menu to change the color of the text.
- **Size** – enter a number (1-200) to set the size of the text for the button.
- **Format** – formats text to *Bold*, *Italic* or *Underline* for the button.
- **Alignment** – click a box to align the text Right, Center or Left; and Top, Middle or Bottom within the button box.
- **Style** – use the drop-down menu to select the style type.

**Note:** The **image** and **color** settings are only applicable to dial keys.

- **Image** – select this option to import different images for the dial key when it is pressed and not pressed (normal).
  - **Transparency** – enter a number (0-100) or use the slider-bar to set the transparency of the button.
- **Color** – select this option to use different color blocks to indicate a pressed and a normal dial key.
- **Border/Line** – select this option to configure the color, format, and width of the display screen border.
- **Position and Size** – X and Y position the button at the coordinates entered. *Width and Height* set the size of the button box. Click **Reset Image Size** to reset the button size.

**Note:** If you are using the **Call** and **End Call** dials, click the dial key to configure its action. For a detailed procedure, see *Example: Configuring actions of dial keys*, page 137.
Frame & Line

Use frames and lines to visually group or separate control objects in your Viewer. Click a frame or line object to configure its properties.

* **Style** – configure the color, format, and width of the line or border of the frame.
* **Rounder corner** – use the scroll bar or the number box to configure the roundness of the frame corner.
* **Fill** – select this option to fill the frame with the selected color.
* **Position and Size** – $X$ and $Y$ position the frame/line at the coordinates entered. $Width$ and $Height$ set the size of the frame/line.
Object Properties for ATEN Keypad / Control Pad

After you have added a Viewer (page 104) for your Keypad / Control, you can start configuring the Viewer. In the Viewer page, click on a button to configure its settings. The following settings appear in the Properties panel.
• **Mode**

Use this drop-down menu to select one of the following button types.

• **Normal** – This is a button that stays the same when pressed.

• **Toggle** – for a button that switches between two images/colors to indicate the button status. This also splits the Commands list under **Button Action** (page 130) – to provide two commands for the button: Toggle ON and Toggle OFF.

• **Press and Release** – for a button that switches between two images/colors when pressed and released. This splits the Commands list under **Button Action** (page 130) to provide two commands for the button: Press and Release.

• **Long Press** for a button that switches between two images/colors when pressed and released. This button continuously re-sends a command to a device as long as it is pressed, at the **Interval** specified (see **Interval**, below) and stops sending the command once the button is released.

**Note:** Use the **Normal** or **Long Press** option to set the image/color of the button based on its status.

• **Name** – (optional) type the text you want to use for the button (or slow double-click the button on the Viewer page).

• **Font** – use the drop-down menu to select the font type.

• **Color** – use the drop-down menu to change the color of the text.

• **Size** – enter a number (1-200) to set the size of the text for the button.

• **Format** – formats text to **Bold**, **Italic** or **Underline** for the button.

• **Alignment** – click a box to align the text Right, Center or Left; and Top, Middle or Bottom within the button box.

• **Style** – use the drop-down menu to select the style type.

• **Image** – imports an image to use as the button’s standard background and click **Pressed** to import an image to use when the button is pressed.

• **Color** – allows you to use drop-down menus to select the buttons color for Normal and Pressed.

• **Transparency** – enter a number (0-100) or use the slider-bar to set the transparency of the button.

• **Send Command After Holding** – Sets the required time for holding the button to apply the action for which the button is configured.
- **Position and Size** – X and Y position the button at the coordinates entered. *Width* and *Height* set the size of the button box.
- **Set Sync Condition** – Automatically synchronizes the button to the selected variable. To create a variable, see *Variables*, page 179. This option is only available for toggle buttons.
**Button / Slider Bar / Dial Kit Actions**

**Understanding Button/Slider Bar/Dial Kit Actions**

After you have added a button, slider bar, or a dial kit on your Viewer, define the actions it initiates using the Button/Slider Bar Actions panel. To access the panel, click on a button, slider bar, or dial key in the Viewer. The Button/Slider Bar Action panel appears.

The Button/Slider Bar Actions panel consists of the following elements:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Device</td>
<td>Lists the added devices and the advanced functions.</td>
</tr>
<tr>
<td>Room</td>
<td>Select the room that contains the devices the Viewer will control. Use this drop-down menu to select rooms in the KNX system and display KNX devices. The Viewer will only upload to a controller configured with the same Room name (see Left Sidebar, page 90). Select All Rooms to allow the Viewer to control all rooms. Selecting All Rooms will upload the Viewer to all controllers. The Accessible Room defines what Devices are available to configure new Actions in Button/Slider Bar Properties (see page 130). Only Devices listed under the same Room (see page 90) as the Viewer’s Accessible Room will be listed for use in Button/Slider Bar Properties.</td>
</tr>
<tr>
<td>Function</td>
<td>Lists the supported functions for your chosen device or advanced option. Double-click a function to add it to the Command List, which shows a sequence of tasks to be executed when specified conditions are met for the button, slider bar, or dial key. For details on functions, see Functions, page 133.</td>
</tr>
</tbody>
</table>
Chapter 4. ATEN Configurator (VK6000)

### Commands

Lists the commands that initiate when the button or dial key is pressed. *Device* and *Advanced Option* functions can be added and associated in the Commands list together. Commands initiate in the order that they are added to the list. Right-click in the Commands list to use the menu selections: *Move Up*, *Move Down*, *Copy*, *Paste*, *Delete*, *Save as Macro*, or *Test Tool*.

### Toggle ON / Toggle OFF or Press / Release

When the Button *Mode* (page 114) is set to *Toggle or Press and Release*, the Commands list splits to set the two columns:

- **Toggle ON / Press** – lists the commands that initiate when the button is first pressed or pressed and held.
- **Toggle OFF / Release** – lists the commands that initiate when the button is pressed a second time (Toggle), or released (Press and Release). When the button is pressed again, Toggle ON initiates and the cycle repeats.

### Level drop-down menu

The Level drop-down menu appears when an Advanced Slider Bar is selected on the Viewer page. The number of levels in the drop-down menu reflect the *Level* set in the Advanced Slider Bar’s properties (page 120). Use the drop-down menu to select a level and then add a command for each of the Advanced Slider Bar’s levels (see page 136 for details).

### Setting Description

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Commands</td>
<td>Lists the commands that initiate when the button or dial key is pressed. <em>Device</em> and <em>Advanced Option</em> functions can be added and associated in the Commands list together. Commands initiate in the order that they are added to the list. Right-click in the Commands list to use the menu selections: <em>Move Up</em>, <em>Move Down</em>, <em>Copy</em>, <em>Paste</em>, <em>Delete</em>, <em>Save as Macro</em>, or <em>Test Tool</em>.</td>
</tr>
</tbody>
</table>
| Toggle ON / Toggle OFF or Press / Release | When the Button *Mode* (page 114) is set to *Toggle or Press and Release*, the Commands list splits to set the two columns:  
  - **Toggle ON / Press** – lists the commands that initiate when the button is first pressed or pressed and held.  
  - **Toggle OFF / Release** – lists the commands that initiate when the button is pressed a second time (Toggle), or released (Press and Release). When the button is pressed again, **Toggle ON** initiates and the cycle repeats. |
| Level drop-down menu     | The Level drop-down menu appears when an Advanced Slider Bar is selected on the Viewer page. The number of levels in the drop-down menu reflect the *Level* set in the Advanced Slider Bar’s properties (page 120). Use the drop-down menu to select a level and then add a command for each of the Advanced Slider Bar’s levels (see page 136 for details). |
| Move up                  | Use *Move up* to move an action up in the Commands list, or *Move down* to move an action down in the Commands list. |
| Delete                   | Use *Delete* to remove an action from the Commands list. |
| Save as Macro            | Use *Save as Macro* to save the commands in the Commands list as a macro. |
| Test Tool                | Use *Test Tool* to connect to a controller and test the action(s) in the Commands list. |

You can configure a button with *Device* commands (On, Off, Stop, Play, etc.); as a *Macro* to send multiple commands to one or more devices; or as a *Link* to other Viewer pages. *Advanced Options* allow you to add conditions to the commands, as described on the next page.
Configuring Button/Slider Bar Actions

To add one or more actions to a button, slider bar, or dial key, follow the steps below.

1. In the project file, click to select the button, slider bar, or dial key in the Viewer. The Button/Slider Bar Action panel appears.

2. In the Button/Slider Bar Action panel, select a Room.

3. Add commands.

   For details on device functions and advanced functions, see Functions, page 133.
   a) Click a device or an advanced option to display its supported functions.
   b) Double-click a function to add it to the Commands list.
   c) Repeat step 3a and 3b if you wish to initiate a sequence of actions.

4. In the Commands list, double-click the commands to configure them.
Functions

Button/slider bar functions can be understood as device functions and advanced functions.

- **Device functions** – These are functions that the selected controller or a device managed by the controller initiates. The supported device functions vary depending on the device you select in the Device list, as illustrated below. For details on controller functions, see *Device Functions*, page 135.

Controller functions

![Controller Functions Diagram](image)

VM3404H functions

![VM3404H Functions Diagram](image)
Advanced functions – These are functions that involve more than one devices in the project. Use the indicated column to select an advanced function, the available options are listed in the Function list. For details about each advanced function, see Advanced Functions, page 138.
Device Functions

- Each ATEN controller supports the following functions.
  - **Delay** – adds a delay in seconds. Enter a number between 0.1-180.
  - **Relay** – adds an Open, Close, Toggle or Pulse action on the selected controller and Relay port.
  - **DO** – adds an Open, Close, Toggle or Pulse action on the selected controller and Digital Output port.
  - **Wake on LAN** – powers on the specified computer (MAC address) over Ethernet.
  - **Serial Raw (ASCII)** – adds a serial command in the ASCII mode.
  - **Serial Raw (HEX)** – adds a serial command in the HEX mode.
  - **Telnet Raw (ASCII)** – adds a telnet command in the ASCII mode.
  - **TCP Raw (ASCII)** – adds a TCP command in the ASCII mode.
  - **TCP Raw (HEX)** – adds a TCP command in the HEX mode.
  - **UDP Raw (ASCII)** – adds a UDP command in the ASCII mode.
  - **UDP Raw (HEX)** – adds a UDP command in the HEX mode.
  - **HTTP** – adds an HTTP command.
  - **HTTPS** – adds an HTTPS command.

- **Value Types**

  When a device command has multiple values you can double-click it and use the **Show Flag Menu** to select a device setting:

  - **Library Value** – use the drop-down menu to select a device setting for the command. The selection of settings in the drop-down menu can be modified using the Database Generator to edit the command string (see *Editing / Adding a New Device*, page 196).
  - **Flag Variable** – clicking this button allows a Flag with a set of values to be selected for the action. The button’s action will select a setting according to the Flag value. Each value in a Flag can be set to a different device using a Set Flag (as a button to select the device). When that (Set Flag) button is pressed, the Flag value is
set for that particular device, and will be used as the setting for this action, when it’s button is pressed.

* Variables – Select this option to use a Variable in the command. After selecting the option, a drop-down menu containing a list of the Variables that you created appear.

* Slider Value – select this option to configure a Basic Slider Bar’s command. The range and change levels are automatically configured according to the minimum and maximum values set for the Basic Slider Bar. This option only appears when a Basic Slider Bar is selected on the Viewer page and you are adding Slider Bar Action commands.

Note: The Show Flag Menu allows you to use a single Flag for all devices rather than adding a Conditional Flag for each device.

* Dial Value – select this option to use the string of values that has been dialed using the dial kit via Viewer from a mobile device.

* Level – When an Advanced Slider Bar is selected on a Viewer page, the Level drop-down menu appears above the Commands list. A command must be added to each level of an Advanced Slider Bar. To configure each level, use the drop-down menu to select a level and then add a command to it.
Applications of Device Functions

Example: Configuring actions of dial keys.

Out of the 15 keys on a dial kit, only the Call and End Call keys require configuration, the actions for other keys are pre-configured to send out the number or character as indicated on the keys.

Follow the steps below to add an action to the Call key.

1. Click the Call key in the Viewer to display the Button Action panel.
2. Select a device (e.g. a video conferencing system) and double-click to add a function for the key. In this case, it should be a dialing function.
3. Double-click the added command and select Dial Value.
Advanced Functions

Use advanced options for button/slider actions that involve a series of actions (Macro), actions that involve page redirect (Link), or actions that involve change or update of device settings of multiple objects (Set Variable).

**Note:** Associate Set Flag, Condition, Change Button State, or Change Label commands with device commands in the Commands list by dragging and dropping them into a tree view list, which allows them to initiate together (see Applications of Advanced Functions, page 140).

- **Macro** – sends multiple commands to one or more devices. Select to add a macro command from the Function list. To create a macro, add multiple device actions to the Commands list, then click the Save as Macro icon or access the function by clicking the Library icon (page 155).

- **Link** – makes the button into a link that directs you to a Viewer page. Select to add a page link from the Function list. Double-click the page link in the Commands list to select a different page link.

- **Set Variable** – creates a variable to represent a device setting (e.g. speaker volume) that can be used by two or more control objects (e.g. slider bar or buttons) in the Viewer. This function is used when you have more than one Viewer objects controlling the same device.

  **Note:** To complete this setting, go to Properties of the control objects and configure the Set Sync Conditions setting.

- **Set Flag** – sets a flag value to represent the new device status when a command changes a device setting. Set Flags are added to the Commands list after device commands to change the Flag (device status).

- **Condition** – adds one or more conditions that must be met for commands to initiate. The conditions can be based on a Variable or a feedback value (setting value sent from a managed device).

- **Variable conditions** – Use Variable conditions for the controller to carry out actions (commands) when the specified Variable meets the specified conditions. Use Variable If, Variable Else If, and/or Variable Else to fully cover all scenarios in your application. For example, if you want a display a warning message on the Viewer when the volume of a speaker is at its maximum (10 dB), you will need to: (a) Set up a Variable for the speaker volume; (b) Select a Variable If condition; (c) Double-click the condition to set the Variable value to 10; (d) Drag a Change Label command and nest it under the condition you selected in step (a); (e)
Double-click the Change Label command to type the warning message you wish to display when the speaker volume reaches 10 db.

- Feedback conditions – Use feedback conditions for the controller to carry out actions (commands) when the specified feedback value meets the specified conditions. Use **Feedback If**, **Feedback Else If**, and/or **Feedback Else** to fully cover all scenarios in your application.
  
  **Note:** The Else If and Else conditions can only be nested under the If conditions and cannot be used on their own.

- **Change Button State** – this command changes the image of another button when this button is pressed – allowing the image of any other button to change when the command from this button is sent. Change Button State is added to the end of the Commands lists. When adding this to a **Toggle** button it allows the image to switch with the toggle behavior: **Normal** or **Pressed**. In this situation the Change Button State is added to the end of both the **Toggle ON** and **Toggle OFF** Commands lists.

- **Change Label** – this option changes a label’s text with text that you enter manually or with text from a device’s return message. A Manual Change Label can be added to the beginning or end and with a Condition in the Commands list. Adding it to a Condition guarantees the label only changes when the command initiates.

- **Change Group Button State** – this option adds a command that changes the button selected in a **Radio Group** (page 81). Create a Radio Group and then a Function will be listed for it when **Change Group Button State** is selected. Add the **Change Group Button State** to the Commands list of a button and use the drop-down menu to select the button in the Radio Group you want selected.

- **Change Slider Bar Level** – this option adds a command that changes the level of a **Slider Bar**. Create a Slider Bar and then a Function will be listed for it when **Change Slider Bar Level** is selected. Add the **Change Slider Bar Level** to the Commands list of a button and use the drop-down menus to select the **Slider Bar** and **Level** to change.

- **Change Button Name** – this option adds a command that displays specified text on another button when this button is tapped. A typical application of this command is when you want to show the assigned source on an output device as soon as the source is switched.

- **Function** – lists the commands that can be added to the Commands list. Select an option under **Device**, then double-click or drag & drop commands from the **Function** list to add them to the **Commands** list.
Applications of Advanced Functions

Advanced Options allow you to include conditions with commands in the Commands list. Associate Set Flag, Condition, Change Button State or Change Label functions with a command in the Commands list by dragging and dropping them into a tree view listed with the command, so that they initiate in the order listed.

Set Flag

Adds a Set Flag to change a Flag’s value when a command changes a device setting. This sets the Flag value to match the new device setting (e.g. ON or OFF). Always add a Set Flag to a Condition Flag, after the device action(s):

To add a Set Flag:

1. Under Device, select Set Flag.
2. From the Function list, select the Flag.
3. From the Function list, drag and drop the Flag to add it to the end of the Condition Flag, in a tree view list:

4. Double-click Set Flag in the Commands list to use the drop-down menus to set the Flag and Value.
Condition

Adds a condition that must be met before the commands listed with it can initiate. When the button is pressed, the Condition’s set value must equal the Flag or Feedback value for the command(s) to initiate. There are two condition types: Flag and Feedback.

- Flag – Adds a condition based on a Flag’s value. “If Flag equals Value” is true, the condition is met and the commands listed with the Condition will initiate. Always add a Condition Flag at the top of the Commands list, drag and drop the device command(s) and then a Set Flag at the end, in a tree view list:

To add a Condition Flag:
1. Under Device, click Condition.
2. From the Function list, select Flag.
3. Double-click Flag to add the Condition Flag to the Commands list.
4. Double-click the Condition Flag in the Commands list to use the drop-down menus to set the Flag and Value.

![Diagram of Condition Flag setup]
5. From the **Function** list, drag & drop device commands to add them to the **Condition Flag**, in a tree view list:

6. Add a **Set Flag** after the last device command in the **Commands** list:

   - **Feedback** – adds a condition based on the **text** from a serial/telnet/TCP device’s return message. Always add a **Condition Feedback** to a serial/telnet/TCP command, with command(s) added below the Condition Feedback, in a tree view list:

   Receive Time – when a Feedback condition is added to a device command the **wait** to **Receive Time** drop-down menu appears allowing you to set the amount of time to wait before it stops receiving the return message from the device.

   There are three Condition Feedback types:

   - **Equal** – when the text sent from a serial/telnet/TCP device’s return message matches **all of the text** entered for a **Condition Feedback Equals**, the commands listed below it will initiate.
- **Include** – when the text sent from a serial/telnet/TCP device’s return message matches **part of the text** entered for a **Condition Feedback Include**, the commands listed below it will initiate.

- **Bypass** – this option bypasses matching text from the serial/telnet/TCP return message and initiates a **Change Label** command. The label’s text will change to the return message sent from the device (i.e. the **Feedback Result**). A **Change Label** must be added to the **Feedback Bypass** for it to work.

To add a Condition Feedback Equal/Include:

1. Under **Device**, click **Condition**.

2. From the Function list, select **Feedback**.

3. From the **Function** list, drag and drop **Feedback** to add it to the Serial/Telnet/TCP command, in a tree view list:

4. Double-click **If Feedback equals to** in the Commands list and use the drop-down menu to select **equal to** or **include** and enter the **Text**.

Text entered here must match **all** (equal to) or **part** (include) of the text from a serial/telnet/TCP device’s return message for the command(s) to initiate. Use the **ASCII / HEX** drop-down menu to select the format.
5. From the **Function** list, drag & drop device command(s) to add them to the **Feedback Equal/Include Condition**, in a tree view list:

To add a Feedback Bypass Condition with Change Label:

1. Under **Device**, click **Condition**.

2. Select **Feedback** from the Function list.

3. From the **Function** list, drag and drop **Feedback** to add it to the Serial/ Telnet/TCP command, in a tree view list:

4. Double-click **If Feedback equals to** in the Commands list and use the drop-down menu to select **bypass**.

5. Under **Device**, select **Change Label**.

6. From the Function list, select the **Viewer Page** where the label is located.
7. From the Function list, drag and drop the **Viewer Page** to add it to the **Feedback Bypass Condition**, in a tree view list:

8. Double-click **Change Label** in the Commands list and use the drop-down menu to select a label. Labels are identified by number (see page 112).

   ![Diagram showing the process of adding a Viewer Page and changing a label]

The label’s text will change to the serial/telnet/TCP device’s return message.
Change Button State

This option is used to change another button’s image when this button is pressed – allowing the button image to switch depending on the status: Normal or Pressed. Change Button State is added to the end of the Commands lists and should point to a Toggle button. Adding this to a Toggle button allows the image to switch with the toggle behavior: Normal or Pressed.

To add a Change Button State:

1. Under Properties, use the Mode drop-down menu to select a button type.
2. Under Style, click the Normal and Pressed button to select an image/color* for the button’s state.

   **Note:** Use the Style drop-down menu to select Image to import an image file for the button state, or Color to choose a color format for the button state.

3. Add the Toggle ON and Toggle OFF device commands to the Commands lists.
5. In the Function list, select the **Viewer page**.

6. Select the **Toggle ON** radio button, then in the Function list, double-click the **Viewer page** to add it to the end of the **Toggle ON** commands in the Commands list.

7. Select the **Toggle OFF** radio button, then in the Function list, double-click the **Viewer page** to add it to the end of the **Toggle OFF** commands in the Commands list.

8. In each Commands list, double-click the **Change Button State** command to set the **Button and State** (Normal or Pressed).
Change Label

Changes a label’s text with text that you enter manually or with text from a serial/telnet/TCP device’s return message (Feedback Result). A Change Label that uses a return message, must be added to a Feedback Bypass Condition (page 144). A Manual Change Label can be added anywhere in the Commands list. Adding it to a Condition guarantees the label changes only when the command initiates.

To add a Manual Change Label:

1. Under Device, click Change Label.
2. In the Function list, select the Viewer page where the label is located.
3. Double-click or drag and drop the Viewer page to add the Change Label to the Commands list.

4. Add a Change Label to multiple or Toggle ON / Toggle OFF Command lists to have the same label change text for different actions.

5. In the Commands list, double-click Change Label to use the drop-down menu to select a Label and input the Text. This is the text in the label that will appear when the button is pushed.

Repeat the steps to add a Change Label for the reverse action (i.e., On and Off).
Change Group Button State

Adds a command that changes the selection in a Radio Group (see page 81). To use this function, first create a Radio Group and then add a button to the Viewer page. Add a Change Group Button State independently or with a device command:

To add a Change Group Button State:

1. Under Device, select Change Group Button State.
2. From the Function list, select the Viewer Page where the Radio Group is located.
3. From the Function list, drag and drop the Viewer Page to add it to the Commands list:

   ![Diagram of Change Group Button State](image)

4. Double-click Change Group Button in the Commands list and use the drop-down menu to select the Button.
**Change Slider Bar Level**

Adds a command that changes the level of a *Slider Bar*. To use this function, first create a *Slider Bar* on a Viewer page. Add a **Change Slider Bar Level** independently or with a device command.

To add a Change Slider Bar Level:

1. Under **Device**, select **Change Slider Bar Level**.
2. From the **Function** list, select the **Viewer Page** where the Slider Bar is located.
3. From the **Function** list, drag and drop the **Viewer Page** to add it to the **Commands** list:

4. Double-click **Change Slider Bar** in the **Commands** list and use the drop-down menus to select the **Slider Bar** and **Level**.

![Diagram showing the steps to add a Change Slider Bar Level command](image-url)
Chapter 4. ATEN Configurator (VK6000)

Change Button Name

The Change Button Name command is used to display specified text on a selected button when the configured button is tapped. An application of this command is indicating the assigned source for a display device on a Viewer as soon as the source is assigned. This way, you can keep track of the source that is currently showing on a particular display device.

Example:
- Indicate the currently assigned source on a display device (in the Viewer).
- Assume an environment consisting of one monitor and five sources buttons (computer, laptop, camera...etc.), as illustrated below, and that when a source button is tapped, the source will be immediately assigned to the display.

Configuration goal: To have the assigned source printing on the display button (on the Viewer page), configure each source button so that when it is tapped, the following actions (commands) initiate: (1) Display the source to the display; (2) Print the name of the assigned source onto the display device.
1. Click a source button to display the Button Action panel.

2. In the Button Action panel, select **Change Button Name**.

3. From the **Function** list, double-click the Viewer page where the source button is located. In this example, double-click the **Video Wall** option. The Change Button Name command is added.

4. From the **Commands** list, double-click the Change Button Name command and configure the following.
   - Select the ID of the display button to indicate the location of print the text. In this example, it is the video wall’s ID.
   - Type the text you wish to show when the source button is tapped. In this example, enter “PC”.

5. Follow steps 1 to 4 to configure each of the source buttons.
Graphic Library

The Library icon on the Project bar provides a Graphics tab and drop-down menus with ready-to-use graphics for backgrounds, buttons, icons and device interfaces. Device Interface provides entire page layouts that you can use as templates for different types of devices. Double-click or drag and drop graphics to add them to the page. Images can be imported for icons and buttons in various formats (*.png, *.jpg, *.jpeg, *.bmp).

Background Color

Button
Icon

Device Interface
# Library

The **Library** icon on the Project bar offers the following functions. The table below provides an overview of each function.

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Flag</td>
<td>Flags are created to include parameters when settings are changed to indicate the current status. For details, see Flag, page 156.</td>
</tr>
<tr>
<td>Monitor</td>
<td>Monitors allow you to set Conditions for Digital Input (dry contact) and Digital Input (VDC) signals and Flags on a port that will initiate an Action. In addition, you can create <strong>Listen to port</strong> and <strong>Query port</strong> monitors which check a device’s status to initiate actions. For details, see Monitor, page 158.</td>
</tr>
<tr>
<td>Macro</td>
<td>Macros initiate a sequence of actions on one or more hardware devices. For details, see Macro, page 176.</td>
</tr>
<tr>
<td>Schedule</td>
<td>Click to create scheduled events. For details, see Scheduled Events, page 178.</td>
</tr>
<tr>
<td>Variables</td>
<td>Creates a Variable for a device setting (e.g. volume) that is controlled by two or more UI components (e.g. slider bar or buttons) on the Viewer. When the device setting is changed through one of the components, its setting is automatically synced and reflected on all components. For details, see Variables, page 179.</td>
</tr>
<tr>
<td>+</td>
<td>Opens a pop-up window to create a Flag, Monitor, Macro, Schedule, or variable.</td>
</tr>
<tr>
<td>X</td>
<td>Closes the Library window.</td>
</tr>
</tbody>
</table>
**Flag**

Flags are created for control buttons to include parameters for when settings are changed or requests are made to change settings on a device. Flags indicate what the status is and what action to take according to the value. Flags are added as actions to Button Properties as a **Condition** or **Set Flag** value.

*Conditions* tell a button to initiate associated actions if the flag value is true: “If **Flag** equals **Value**” initiate the action. Actions are associated with a condition so that they only initiate if the flag value is correct. That way an ON command is only sent to a device if the current flag value is OFF.

*Set Flag* changes the flag value when a device setting has changed. So that if a device is OFF and the action turns the device ON, adding a “Set Flag 1 to ON” will change the flag value to ON. Now the flag’s value matches the device status so that actions associated with flag Conditions will initiate accordingly.

Create flags for a device and add them as a **Condition** and **Set Flag** value in the Action – Button Properties (see Button / Slider Bar / Dial Kit Actions, page 130).

To create a Flag:

1. Select **Flag** and click `+`. The *New Flag* menu appears.

![New Flag Menu](image)

2. Enter a **Name** and select a radio button to set the flag value.
   - Select **On/Off** and use the drop-down menu to select the **Default Value**.
   - Enter a range (1-100) for the values in the two boxes and use the drop-down menu to select the **Default Value**. Use the drop-down menu to select the format ASCII or HEX.
3. Click + to create more flags or double-click a flag to edit it. The flags will appear in the list, as shown below.

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Flag1</td>
<td>OFF, ON</td>
<td>OFF</td>
</tr>
<tr>
<td>Flag2</td>
<td>0-10 (ASCII)</td>
<td>0</td>
</tr>
<tr>
<td>Flag3</td>
<td>32-48 (HEX)</td>
<td>32</td>
</tr>
<tr>
<td>Flag4</td>
<td>0-10 (ASCII)</td>
<td>5</td>
</tr>
</tbody>
</table>

- **Name** – Lists the Flag names which have been created.
- **Value** – Lists the flag’s values or range of values.
- **Default** – Lists the flag’s default value.
- **X** – Deletes a flag from the list.

4. Select **Condition** or **Set Flag** to add flags as a command in Button Action by selecting a button on a Viewer page (see *Button / Slider Bar / Dial Kit Actions*, page 130).
Monitor

Understanding Monitor

A Monitor allows you to set conditions on a port using Digital Input (VDC) and Digital Input (Dry Contact) signals, return messages, and Flags. When the condition is met, the controller will initiate the desired action. Digital Input (VDC) hardware devices provide voltage signals between 1 and 24. Digital Input (Dry Contact) hardware devices provide open and closed circuit signals. Hardware devices with return messages can be monitored using Listen to port or Query port conditions via text they transmit. These signals provide indicators from sensors or switches of an event. An event can be the temperature, power, dry contact, sensor, switch status, or message from a device. There are two parts to a monitor, the Condition and Action.

Monitor Page Options
There different types of monitors you can create to fulfill different scenarios. All monitors share the following configuration fields:

<table>
<thead>
<tr>
<th>Type</th>
<th>Use this drop-down list to select a monitor type:</th>
</tr>
</thead>
<tbody>
<tr>
<td>If</td>
<td>- select this option for a single condition monitor. “If” the single condition is met, the action initiates. For details, see Creating an If Monitor, page 164.</td>
</tr>
<tr>
<td>Switch</td>
<td>- select this option for multiple conditions that use more than one “If” conditions for the monitor. In this type, if one of the conditions is met, the monitor will initiate the action. For details, see Creating a Switch Monitor, page 167.</td>
</tr>
<tr>
<td>Bypass</td>
<td>- select this option to transmit device feedback message to the selected variable actively listening for a message or by receiving a return message from the specified devices. For details, see Creating a Bypass Monitor, page 170.</td>
</tr>
<tr>
<td>While Loop</td>
<td>- select this option to execute the specified actions at the defined frequency (Query Frequency). For details, see Creating a While Loop Monitor, page 171.</td>
</tr>
<tr>
<td>Professional</td>
<td>- select this option to create variables and load values into these variables using programming script. For details, see Creating a Professional Monitor, page 172.</td>
</tr>
</tbody>
</table>

| Name     | Enter a name for the monitor. |
| Query Frequency | Use this drop-down menu to select how frequently the monitor checks a device for a signal. |
Chapter 4. ATEN Configurator (VK6000)

<table>
<thead>
<tr>
<th>Condition</th>
<th>Use this section to add one or more conditions that will need to be met for the Action to initiate. You can create up to 32 conditions for each monitor. For details, see Condition Types, page 160.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action</td>
<td>Use this section to create the commands that will initiate when the monitor’s conditions are met. For details, see Device Functions, page 135 and Advanced Functions, page 138.</td>
</tr>
<tr>
<td></td>
<td>Click to hide or display the Device and Status/Function columns in the Condition and Action lists so that you can see a complete row of Conditions/Commands.</td>
</tr>
<tr>
<td></td>
<td>Click to move an selected command up or down in the Commands list.</td>
</tr>
<tr>
<td></td>
<td>Click to remove an selected command from the Commands list.</td>
</tr>
</tbody>
</table>
Condition Types

Note that you can create up to 32 conditions for each monitor.

- **Listen to port / Query port**
  - *(Query port only)* Click F(x) to open the drop-down menu to select a device command to send out; or enter a command string; and then the click *Edit Return Message* icon and do as explained below.

- **Edit Return Message**
  - *(Listen to port / Query port)* Next configure the parameters for the return message from the device. This message must match for the condition to be met. In the **Condition** list double-click the command and then click ✏️ to open the *Edit Return Message* window:

  Use the drop-down menu and enter a string of that will represent the characters in a return message from the serial device:
Chapter 4. ATEN Configurator (VK6000)

- **Select string with fixed length**

Use this to set a string of characters that are set within a fixed parameter. Enter a string of characters and use the S to set the start of the string and E to set the end and then click **Apply**. The return message will need to fit the fixed string of characters set in the text box next to the **Drop-Down Menu** (see next page) for the monitor to be triggered.

- **Select string with a non-fixed length**

Use this to set a string of characters where the parameters are variable. Enter a string of characters and use the S to set the start of the string and E to set the end and then click **Apply**. The return message will need to fit the fixed string of characters set in the text box next to the **Drop-Down Menu** (see below) for the monitor to be triggered.

- **Drop-Down Menu**

Above, enter characters that the **Select string with fixed length** or **Select string with non-fixed length** string must match and how they must be matched: **Equal to**, **Not equal to**, **Include**, or **Exclude** for the condition to be triggered.

- **Flag**

Creates a flag condition for the monitor. Use the drop-down menus to set a format (how the flag value must be matched) and the flag value for the condition to be triggered.

- **I/O Input**
Create a trigger signal from a device according to the voltage. Only device with a Digital Input (dry contract) or Digital Input (VDC) port appear in the Status list. Double-click a device in the Status list to add it to the Condition list. Double-click the command in the Condition list to configure the setting:

![IO Input](image)

The High or Low status tells the Monitor to initiate an Action when the device signal is above or below the threshold setting* for the port:

**Digital Input (VDC)**

- High - states that when the voltage signal is above the Upper Threshold to initiate the Action.
- Low - states that when the voltage signal is below the Lower Threshold to initiate the Action.

**Digital Input (Dry Contact)**

According to an open or closed circuit status for the port:

- Open - states that when the circuit is **Open** to initiate the Action.
- Closed - states that when the circuit is **Closed** to initiate the Action.
Chapter 4. ATEN Configurator (VK6000)

Functions

- **Delay** – adds a delay in seconds. Enter a number between 0.1-180.
- **Relay** – adds an Open, Close, Toggle or Pulse action on the selected controller and Relay port.
- **DO** – adds an Open, Close, Toggle or Pulse action on the selected controller and Digital Output port.
- **Wake on LAN** – powers on the specified computer (MAC address) over Ethernet.
- **Serial Raw (ASCII)** – adds a serial command in the ASCII mode.
- **Serial Raw (HEX)** – adds a serial command in the HEX mode.
- **Telnet Raw (ASCII)** – adds a telnet command in the ASCII mode.
- **TCP Raw (ASCII)** – adds a TCP command in the ASCII mode.
- **TCP Raw (HEX)** – adds a TCP command in the HEX mode.
- **UDP Raw (ASCII)** – adds a UDP command in the ASCII mode.
- **UDP Raw (HEX)** – adds a UDP command in the HEX mode.
- **HTTP** – adds an HTTP command.
- **HTTPS** – adds an HTTPS command.
- **TCP Feedback Raw (ASCII)** – adds a feedback in ASCII format to having received a monitored input from a TCP client device.
- **TCP Feedback Raw (HEX)** – adds a feedback in HEX format to having received a monitored input from a TCP client device.
Creating an If Monitor

To create a monitor for a device port with a Condition that initiates an Action, click + from the Library’s Monitor tab, and do the following:

1. Select If from the drop-down menu and enter a name for the monitor.
2. Use the drop-down menu to set the Query Frequency.
3. Select All Conditions or Any Conditions.

These options are only for advanced setups that require multiple events from hardware devices connected to multiple conditions. Most devices only require one signal Status added to the Condition List to initiate an Action. Most installations will not need to use this option, therefore it can be ignored.

- **All Conditions**: Add multiple conditions – all of which must be met for the Action to initiate.
- **Any Conditions**: Add multiple conditions – one of which must be met for the Action to initiate.

4. Under Device, select a Controller from the drop-down menu, and then choose one of the following monitor types. For details, see Condition Types, page 160.
4. ATEN Configurator (VK6000)

- **Listen to port** – to create a monitor that actively listens for a message from the device. Under **Status**, double-click a device port to add it to the **Condition** list.

- **Query port** – to create a monitor that sends out a command to the device until a feedback message is received from the device.

- **Flag** – to create a flag condition for the monitor.

- **I/O Input** – to create a trigger signal from a device according to the voltage.

5. Under **Status**, double-click to add a device port or flag to the **Condition** list. Then double-click the device port or flag in the Condition list to configure the condition settings.

**Note:** To set the controller as a TCP server, use the **TCP Server** option in the Status column, and make sure to type a TCP server port in the controller’s properties settings (page 91).

6. (Optional) Use the Operator option to add additional High or Low conditions (see step 4, page 164).

7. Go to the **Action** section at the bottom of the page to select the hardware **Device** and add the **Function** to the **Commands** list, as explain in the steps that follow.

**Note:** For more information about Functions, see **Button / Slider Bar / Dial Kit Actions**, page 130.
a) First select the hardware under **Devices**.

![Device Selection](image1.png)

b) Under **Function**, double-click a command to add it to the **Commands** list. This **Command** initiates when the **Condition** is met. For details on Functions and Commands, see **Device Functions**, page 135 and **Advanced Functions**, page 138.

![Command Selection](image2.png)

**Note:** If you have configured the controller as a TCP server, add **TCP Feedback Raw (ASCII)** or **TCP Feedback Raw (HEX)** command to provide feedback to the TCP client.
Creating a Switch Monitor

1. Select **Switch** from the drop-down menu and enter a name for the monitor.
2. Use the drop-down menu to set the **Query Frequency**.
3. Use the options to create multiple condition comparisons, as explained below.

<table>
<thead>
<tr>
<th>Type</th>
<th>Use the drop-down menu to select:</th>
</tr>
</thead>
<tbody>
<tr>
<td>If</td>
<td>select this option for a single condition comparison monitor.</td>
</tr>
<tr>
<td>Switch</td>
<td>select this option for multi-condition comparisons that use multiple “If” comparisons for the command.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Name</th>
<th>Enter a unique name for the monitor.</th>
</tr>
</thead>
</table>

| Query Frequency | Use this drop-down menu to select how frequently the monitor checks a device for a signal. Options are: 100 ms - 1 second. |
Drop-Down Menus

Under the **Type** drop-down menu are four addition drop-down menus used to configure the Switch Condition:

- **Controller** – use the first drop-down menu to select the controller for a Switch condition.
- **Listen to port / Query port** – use the second drop-down menu to select the condition type for a Switch condition (see step 4, page 165 for details).
- **Serial Device Port**
  - Use the third drop-down menu to select a serial device port and configure Edit Return Message (to configure, see **Edit Return Message**, page 160).
  - To set the controller as a TCP server, use the TCP Server option in the Status column, and make sure to type a TCP server port in the controller’s properties settings (page 91).
- **Case** – use the fourth drop-down menu to add cases by selecting **Add More Cases** for comparison that need to be met before monitor’s condition will initiate. In the left text box enter a name for the Case, in the right text box enter the character string that the return message should match.

**Action**

Use this section to create commands for the monitor. See **Button / Slider Bar / Dial Kit Actions**, page 130, for details on configuring commands.

Click this icon to switch to the Action list view so that you can see a complete row of the command’s functions. This is a toggle button.

Closes the Monitor window.

4. Go to the **Action** section at the bottom of the page to select the hardware **Device** and add the **Function** to the **Commands** list, as explain in the steps that follow.

![Action section of the user interface]  

**Note:** For more information about Functions, see **Button / Slider Bar / Dial Kit Actions**, page 130.
5. First select the hardware under Devices.

6. Under Function, double-click a command to add it to the Commands list. This is the Command that initiates when the Condition is met. For details on what each function does, see Device Functions, page 135 and Advanced Functions, page 138.

Note: If you have configured the controller as a TCP server, add TCP Feedback Raw (ASCII) or TCP Feedback Raw (HEX) command to provide feedback to the TCP client.

7. You can also add a Macro, Link, Set Flag or Monitor’s Condition.

8. After adding all the functions to the Commands list, the Switch monitor is complete.
Creating a Bypass Monitor

Follow the steps below to create a bypass monitor.

1. Select **Bypass** from the drop-down menu and enter a name for the monitor.

2. Configure the following settings.
   - **Query frequency**: sets how frequently the monitor checks the device for a signal. Valid values range from 100 ms to 1 second.
   - In the second drop-down list, select one of the following:
     - **Listen to port**: actively listens for a message from the specified device.
     - **Query port**: when a setting is changed on the specified device, the device sends a feedback message to the controller, informing the latest setting.
   - In the last drop-down list, select the port or the device to be monitored.

3. Configure the actions.
   a) Select **Set Variable**.
   b) Double-click the variable you wish to update when controller detects a change for the specified device setting.
   c) For a variable, double-click the command and select **Bypass**.
Creating a While Loop Monitor

Follow the steps below to create a while loop monitor.

1. Select **While Loop** from the drop-down menu and enter a name for the monitor.

2. Use the Query Frequency drop-down menu to define the frequency at which the device checks for signals.

3. From the Device list, select a device.

4. (Optional) Select an advanced option. For details, see *Advanced Functions*, page 138.

5. Double-click a function to added it to the **Commands** list. For details, see *Device Functions*, page 135 and *Advanced Functions*, page 138.

6. Configure the added commands if required.
Creating a Professional Monitor

Example: Keep track of the assigned sources by indicating the input port number of the assigned source on each of the four screens on a Viewer page, as illustrated below.

For the controller to print the port number of the assigned source on each screen and keep this information up-to-date, the controller needs to:

- constantly keep track of the assigned source
- constantly print the port number on each screen icon
Follow the steps below to create a professional monitor.

1. In Configurator, click **Library** and click **Monitor**.

2. Click **+** to create a new monitor.

3. Configure the following settings.
   - From the Type drop-down menu, select **Professional**.
   - Name the monitor.
   - Define the query frequency.

4. Configure the condition settings.
   - In this example, the controller VK2100 is set to query the input and output ports of the Matrix Switch, VM6404H, that connects to the controller every 0.1 second.
   - Add the condition(s) that must be met for initiating actions. For details on conditions, see *Condition Types*, page 160.
   - Select a **Trigger Mode** for the added conditions.
     - **And**: Only initiate the added actions (commands) if the values of all specified inputs change.
• **Or:** Initiate the added actions (commands) if the value of any specified input changes.
• **Independent:** Use this option when you have multiple sets of actions. The added actions (commands) initiate if the corresponding set of inputs change in value.
• **Always:** Initiate the added actions (commands) at the specified frequency.

5. Configure the Action settings.

   a) Click **Edit** to script the codes.

**Note:**

• This editor follows Lua's programming rules. ATEN suggests using Notepad++ to script the codes before adding them to the Editor.
• For details on built-in commands, see **Built-in Commands**, page 175.
• When scripting codes for I/O inputs, use lower case “l” to represent the close status (e.g. `input_io == 'l'`), and “h” to represent open status (e.g. `input_io == 'h'`).

In this example, use Script Editor to:

• Convert data format.
• Create four variables representing the assigned input for each screen. In this example, `InputNToOutput1`, `InputNToOutput2`, `InputNToOutput3`, and `InputNToOutput4` are created.
• Load the input number of the assigned source to the created variables.

Below is sample of the scripts used for this scenario:

```lua
function vk_parser(input)
    local vminput = vk_hex_toascii(input)
    if vminput == nil or vminput == '''' then
        return
    end

    local map = {}
    for vmout, vmin in string.gmatch(vminput, "o([0-9]*)i([0-9]*) video[^ ]* audio[^ ]* \[\[\[\]"'']") do
        map[vmout] = vmin
    end

    local vk_var_1_InputNToOutput1 = map["01"]
    local vk_var_2_InputNToOutput2 = map["02"]
    local vk_var_3_InputNToOutput3 = map["03"]
    local vk_var_4_InputNToOutput4 = map["04"]

    vk_docommands_1_VMRead(vk_var_1_InputNToOutput1, vk_var_2_InputNToOutput2, vk_var_3_InputNToOutput3, vk_var_4_InputNToOutput4)
end
```
b) Add actions.

In this example, add four Change Button Name commands:

For details, see Device Functions, page 135 and Advanced Functions, page 138.

**Built-in Commands**

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>jsonobj</td>
<td>Converts JSON strings to tables.</td>
</tr>
<tr>
<td>vk_ascii_to_hex</td>
<td>Converts strings from ASCII to Hex.</td>
</tr>
<tr>
<td>vk_docommands_ID_name</td>
<td>Defines the commands to be executed, e.g., vk_docommands_1_output. A the user should define his/her own commands and their corresponding IDs. As long as the ID does not change, the command name can change. The same ID cannot be used for two different commands. The same applies to command names.</td>
</tr>
<tr>
<td>vk_hex_to_ascii</td>
<td>Converts strings from Hex to ASCII.</td>
</tr>
</tbody>
</table>
| vk_parser(input1, input2)| • Use this command to indicate a start to a set of scripts.  
• The brackets should contain equal number of inputs that you added in the Professional Monitor setup.  
• If the Trigger Mode is set to independent, the script should contain only one input, but the number of parsers should match the number of inputs added to the Monitor, e.g. vk_parser_1(input), vk_parser_2(input). |
| vk_var_ID_name           | Create a variable. |
Macros allow you to create a button that will initiate a sequence of actions across the same or different hardware devices. This saves time by allowing multiple devices to initiate actions all at once from one button. For example, you can create a macro to start a video presentation by adding functions to: dim lights, power on source, power on display, lower screen and play source. You can also add time delays between actions in a macro. Each project can store up to 128 macros.

When you click + from the Library’s Macro tab, the window opens:
To create a macro:

1. Select **Macro** and click +.
2. Enter a **Name** and select a **Viewer** from the drop-down menu, then click **OK**.
3. Go to the **Actions** section at the bottom of the page to select hardware under **Device** and add the **Function** to the **Commands** list:

   ![Macro configuration](image)

   **Note:** For more information about adding Functions, see **Button / Slider Bar / Dial Kit Actions**, page 130.

4. After adding all the functions to the **Commands** list, the macro is complete.
5. In **Create Viewer & Design**, create a button and add a macro to the **Button Action** properties (see page 130) by selecting **Macro** under **Devices** (see **Device Functions**, page 135 for details).
Scheduled Events

You can automate ATEN Control System to perform one or a series of tasks on recurring schedule. Each project can store up to 60 scheduled events.

To create a new event, follow the steps below.

1. Click \( \text{Add} \) and then click \( \text{+} \).

2. Name the event.

3. Click \( \text{Add Schedule} \) to specify a recurring schedule for the event.

4. Configure event actions.
   a) In the Device column, select a device.
   b) In the Function column, double-click the desired functions. The corresponding commands appear in the Commands column. For details on what each function does, see Device Functions, page 135.
   c) In the Commands column, double-click each command to configure the settings.

5. Optionally add system functions. For detailed information, see Applications of Advanced Functions, page 140.

6. These commands will initiate in the listed order. To change the order of the commands, click \( \text{Change Order} \).

178
Variables

Understanding Variables

A Variable is a value holder that stores a single device setting (e.g. speaker volume) and can be assigned to multiple UI components (e.g. a slider button, a maximum volume button, and a minimum volume button). This way, when a device setting is adjusted via a Viewer object, the new setting will be loaded into this Variable and then reflected to all Viewer objects that use this Variable. Each project can store up to 128 Variables.

This feature is useful for automatic synchronization of device settings, especially when you have two or more objects in a Viewer controlling a single device setting. Take the example of controlling a speaker volume on a Viewer. On your Viewer, you may have a slider bar which you use to adjust the volume, a button that sets the speaker to its maximum volume, and another button for minimum volume. When you tap the maximum volume button, you would like the following status changes reflected on the Viewer:

- The maximum volume button shows a toggle-on status
- The minimum volume button synchronized with this setting and shows a toggle-off status
- The slider bar synchronizes with this setting and moves to its highest volume
Creating a Variable for Devices that Return Feedback Messages

Follow the steps below to configure a Variable if the Variable (device setting) is for a device that returns feedback messages to the controller.

1. Create a Variable for the device setting (e.g. speaker volume).
   
a) In the Design tab, click Library.
   
b) Click the Variable icon and then click.
   
c) Configure the following settings.
      • Name: Type a name for the Variable.
      • String format: Select the string format for the target device.
      • Setting range: Type two numbers to define the range for the variable. Valid numbers include negative numbers and numbers that contain one decimal place.
        Note: If one of the numbers contains a decimal place (e.g. -5.0), make sure to specify the other number in the same format (e.g. 10.0).
      • Default value: Type a default for the setting.

   Your settings may look like this:

   ![Variable Configuration Example]

2. Configure control components for the Viewer. For details, see Design, page 102.
   
a) In the Design tab, add control components to your Viewer.

   **Note:** The Variable function is only applicable to toggle buttons, basic-mode slider bars, and radio groups of normal buttons. Configure the Mode setting before you proceed.

   ![Control Component Example]
b) For a slider bar component, click it in the Viewer page and configure the Value settings in Properties.

c) In Properties, click Set Sync Condition and select the variable you created using the drop-down list.

3. Create a Monitor to set up the conditions for which the device sends its latest setting to the variable. For detailed steps, see Creating a Bypass Monitor, page 170.
Creating a Variable for Devices that Do Not Return Feedback Messages

Follow the steps below to configure a Variable if the Variable (device setting) is for a device that does not return feedback messages to the controller.

1. Create a Variable for the device setting (e.g. speaker volume).

   a) In the Design tab, click Library.

   b) Click the Variable icon and then click +.

   c) Configure the following settings.

      - **Name**: Type a name for the Variable.
      - **String format**: Select the string format for the target device.
      - **Setting range**: Type two numbers to define the range for the variable. Valid numbers include negative numbers and numbers that contain one decimal place.

        **Note**: If one of the numbers contains a decimal place (e.g. -5.0), make sure to specify the other number in the same format (e.g. 10.0).

      - **Default value**: Type a default for the setting.
      - **Select a command execution type.**
**Execute commands with no conditions:** Execute the command (action) when the specified Variable changes.

**Execute commands with the specified conditions:** Execute the corresponding command (action) when the Variable matches.

2. Configure control components for the Viewer.
   
a) Add a control component to the Viewer. For details, see Design, page 102.
   
   **Note:** Make sure to configure the component mode before proceeding to the next step.
   
b) For a slider bar component, click it and configure value settings in Properties.
   
c) Click **Set Variable**, and then double-click the Variable you created in step 1.
   
d) In Properties, click **Set Sync Condition** and select the Variable you created using the drop-down list.

3. Repeat steps (a) to (d) with each of the components. If you select **Execute commands with the specified conditions**, follow the steps below to add commands.
   
a) Refer to step 4 to first configure the UI components.
   
b) Click Library, click the **Variable** icon, and then click the Variable you created in step 1.
   
c) Click the drop-down list below the Execute commands with the specified conditions option and select a condition.
d) Add an action (command) when this condition is met. Select a device, double-click a desired function, and then double-click the command to configure the setting.

In the case of speaker volume, when the volume changes to 0 (i.e. the condition is \textbf{Variable = 0}), the action will be “to change the speaker volume to 0”, as illustrated below.

![Variable Value](image)

e) Repeat steps 2(c) and 2(d) to add one or more actions to each condition.

4. If you select \textbf{Execute commands with no conditions}, follow the steps below to add commands.

a) In the \textbf{Device} list, click to select the device. In this example, the mixer, \textbf{840T-1(Serial)}, is selected.

b) Double-click the action (command) and change the value type to \textbf{Variable Value}.
Chapter 4. ATEN Configurator (VK6000)

Upload

The *Upload* page allows you to upload Viewers and/or back up projects to controllers.

To back up a project and its Viewers to a controller:

1. Browse for the ATEN controller where you wish to save the configured Viewers.
   - Auto Search: Browses for controllers on the same LAN with the Configurator.
   - Search by IP address: Use this function to browse for controllers that are on different LANs to the Configurator.
2. Verify the selected controller and viewer and configure the selection if required.

- Controller highlighted black: This is the controller that is found in the network and its ID matches the one you specified in this project file. The viewers created for the controller are listed below this item.
- Controller highlighted gray: This is the controller that also exists in the network, but does not match the controller ID specified in this project file.

3. Optionally click on the following to configure password authentication settings.

**Note:** Due to security concerns, the access key of any ATEN controller will need to be modified at least once before the controller can be accessed for any of its functions. If you have not modified the access key, the upload will not be performed. To resolve this issue, log in to the controller’s web interface and follow the on-screen prompt to modify the access key.

- **Edit Access Key:** Click to edit the access key you entered for uploading Viewers to the controller and download Viewers from a mobile device.
Chapter 4. ATEN Configurator (VK6000)

- 🔒: An access key is required to upload Viewers to the controller and download Viewers from a mobile device.

- 🔄: An access key is not required to upload Viewers to the controller and download Viewers from a mobile device.

- 🔒: The access key has been changed on the controller’s web interface (Dashboard). To change the lock status, click on the icon and type the new access key to proceed.

4. Click **Upload to Controller**.

**Note:** By default, the project file is uploaded along with your selected Viewers. To only upload the selected Viewers, click **Also upload project file** to disable the function.
Viewing Controller Information

Click  to view the controller’s information.

- **IP Address**: Displays the IP address.
- **MAC Address**: Displays the MAC address.
- **License**: Displays the number of licenses available and in use.
  - **Select License**: Allows you to load a new license file.
  - **Reset License**: Resets all license(s) in use by mobile devices. This will disconnect all mobile device connections to the controller.
- **Firmware Version**: Displays the firmware version.
  - **Select Firmware**: Allows you to load a firmware upgrade file to update the firmware.
- **Capacity**: Displays the amount of space available for uploading Viewers.
- **Viewers**: Lists the Viewers currently stored on the controller.
  - **Remove Viewer**: Click the trash can icon to remove the Viewer stored on the controller.
- **Project**: Lists the project file currently stored in the controller.
Overview

The ATEN Database Generator is a repository that allows you to establish and store commands for operating devices managed by ATEN Control System, and reuse them when configuring Viewers.

Accessing the Database Generator

In ATEN Configurator, use the menu bar to select Tools → Database Generator. The following window appears with the Add Device to My Library dialog box opened if you are accessing the Database Generator for the first time.
### Menu

<table>
<thead>
<tr>
<th>Menu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add New Device</td>
<td>Configure a custom hardware device to add to My Library.</td>
</tr>
<tr>
<td>Add Device from ATEN Device Library</td>
<td>Add devices from the ATEN Device Library to My Library.</td>
</tr>
<tr>
<td>Add Device from Driver File</td>
<td>Add devices from a database file (*.vkd) to My Library.</td>
</tr>
<tr>
<td>Check Box</td>
<td><strong>Click Do not show this dialog again</strong> to prevent the dialog from appearing when the Database Generator is opened. Use the Preferences menu option to bring the dialog window back.</td>
</tr>
<tr>
<td>Close</td>
<td><strong>Click the Close</strong> button to exit the dialog window.</td>
</tr>
<tr>
<td>Add New Device</td>
<td>Configure a custom hardware device to add to My Library.</td>
</tr>
</tbody>
</table>
My Library

My Library allows you to create custom hardware devices which can be selected to configure ports on the controller. My Library lists all the hardware devices that you have created, added, and edited using the Database Generator. You can create new hardware devices or add existing devices from the ATEN Device Library (page 213). These devices can then be selected from My Device Library for use.
Function Tabs
More functions can be accessed from the function tabs toward the top of the My Library window. Refer to the table below for information about each function.

<table>
<thead>
<tr>
<th>Tab</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>File</td>
<td>The <em>File</em> menu provides options to:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Add New Device</strong>: Configure a custom hardware device to add to Device Library.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Add Device from ATEN Device Library</strong>: Add devices from the ATEN Device Library to My Library.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Add Device from Driver File</strong>: Add devices from a database file (*.vkd) to My Library.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Export My Library</strong>: Saves My Library as a database file (*.vkd) that can be imported later.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Export Selected Device</strong>: Saves the selected device(s) as a database file (*.vkd) that can be imported later.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Controller Connection</strong>: Searches for a controller to test the connection or run the learning mode for the IR port.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Quit</strong>: Exits the program.</td>
</tr>
</tbody>
</table>
### Chapter 5. ATEN Database Generator

#### Edit
The *Edit* menu provides options to:
- **Delete**: Deletes the selected devices from the database.
- **Duplicate**: Makes a copy of the selected device(s) and adds them to the library with the extension "-Copy"
- **Preferences**: Provides options to:
  - Set the *Language*
  - *Show Add Device dialog on startup*
  - *Show IR Learning tips*
  - Set the *IR Learning Timeout* - how long to attempt a connection to an IR device before IR learning stops.

#### Library
Provides a list of the Libraries that you can open to select devices from and edit or add to My Library. The libraries that are listed here appear when you select a database using *Add Device from Driver File*.

#### Help
Provides support and software version information.

<table>
<thead>
<tr>
<th>Tab</th>
<th>Description</th>
</tr>
</thead>
</table>
| Edit    | The *Edit* menu provides options to:  
- **Delete**: Deletes the selected devices from the database.  
- **Duplicate**: Makes a copy of the selected device(s) and adds them to the library with the extension "-Copy"  
- **Preferences**: Provides options to:  
  - Set the *Language*
  - *Show Add Device dialog on startup*
  - *Show IR Learning tips*
  - Set the *IR Learning Timeout* - how long to attempt a connection to an IR device before IR learning stops. |
| Library | Provides a list of the Libraries that you can open to select devices from and edit or add to My Library. The libraries that are listed here appear when you select a database using *Add Device from Driver File*. |
| Help    | Provides support and software version information. |
Controls on the My Library Window

You can add new devices by creating a new device, duplicating an existing device, selecting a device from the ATEN Library or importing a driver file. Use the check boxes to select individual devices or All to select the entire list.

Click to add a new custom device to the database.

Select a device and click this icon to create a duplicate.

Click to add and edit a device from the ATEN Device Library.

Click to add a device from the driver file.

Select a device and click Edit to change the settings.

Key in word strings then click Search to find a device.
Chapter 5. ATEN Database Generator

- Click All, Serial, IR, DO, Relay or Ethernet to filter the list by type.
- Click Brand, Category, Model, Type or Version to sort the devices.
- Click Export Selected Device to save the selected devices.
- Click Delete Selected Devices to remove the selected devices.
Editing / Adding a New Device

To edit or add a device to My Library, do the following:

1. From the menu select **File → Add New Device**, or select a device from My Library and click **Edit**.

2. Under **General**, use the drop-down menus or type in the **Brand Name**, **Category**, **Model** and **Version**.
   
   **Note:** The **Category** determines what buttons are auto generated when a Viewer page is created for the device.

3. Use the **History** button to open the **Version History** editor and make notes about the updates being made to the device configuration. You can create and use different versions of the same device and track the changes. The version history can be viewed and different versions selected from the ATEN Configurator, under device **Properties**.

4. Check the hardware type and configure the device. ATEN database generator supports serial, IR, digital output, relay, and Ethernet devices. For more information about configuring each of these device type devices, refer to the following sections.
   - Serial: See **Serial Device**, page 197.
   - IR: See **IR Device**, page 201.
   - Relay: See **Relay Device**, page 204.
   - Ethernet: See **Ethernet Device**, page 205.
Serial Device

Click to add an Action.

Click to create a duplicate of the Action.

Click to delete the selected action.

Click to enter a string within () which allows the text to be edited from the VK6000 in the Button Action - Commands list (see page 132).

Click to add a drop menu into a Command string, then enter the number sequence in the brackets []. The Function name must include an asterisk (*) for each drop menu in the Command string. The drop-down menu will appear where the (*) is entered in the Function name.

Click to add an Enter into the Command string.
Right-click one or more serial commands to copy and paste them as Ethernet commands of all protocols (except HTTP/HTTPS):

- **Settings** – Use the drop-down menus to set the: *Baud Rate, Data Bit, Stop Bit, Parity, Flow Control and Mode* settings.
- **Listen** – Use this function to create a list of device parameters that you want the controller to monitor by receiving notifications on setting or status changes of the specified parameters.

**Note:** To set up queries for the status of a device parameter, go to the Function List and click + to add the querying action as a command.

- **Advanced**
  - **Delay Interval** – Sets a time delay for each command before they are sent to the device.
  - **Feedback Timeout** – Sets the maximum interval that the controller allows in between parts of a feedback message. If the controller has not received any feedback for longer than the specified Feedback Timeout, the controller identifies the last bit of the received information as the end of a feedback message.
  - **Receive Duration** – Sets the allowed duration of time for the serial device to receive a complete message from the controller.
  - **Keep Connection Alive** – Specify an interval that the controller waits before sending the specified command to test if the connection to the serial device is up or down.

- **Function List** – Use this section to configure the device functions by adding actions to the list.
  - **String Format** – Use the buttons to select HEX or ASCII. To use HEX strings with ASCII one, select ASCII and type `\x` before typing the HEX strings.

  **Note:** HEX strings are also supported under the ASCII format.
Function – Lists the actions created for a device. A Function name must include an asterisk (*) if you are adding a drop menu to the Command string. Double-click to edit the function name.

Command – Shows the command string created for the action. Double-click to edit the string.

Message – The Message column is used to create and store feedback and/or queries for the corresponding command.

- For more information about adding feedback, see Testing Commands, page 209.
- For more information about creating queries, see Configuring Queries, page 211.

Click Send to connect to a controller and test the typed command.

- Click to select a controller from the list. Use the Refresh button to refresh the list. To browse for controllers in the LAN, click the Intelligent Search button or type the IP address of the controller.
- Click OK to proceed to test the command. For details, see Testing Commands, page 209.
Text Command Tools

The following formats allow you to enter command strings with text that provide special features. These formats work in Serial and Ethernet commands.

- () entering text in () allows the command to be edited in the VK6000.
  
  **Example:** *(A1 A9) (A8 B6)* – this command string will provide two editable text boxes from the VK6000 in the **Button Action - Commands** list which allow you to change the command string:

  ![Commands](image1)

- = using the equals sign before a text command allows you to type in words which will show up in a drop-down menu to describe the command, rather than show the text command itself.
  
  **Example:** *[Power On=0A,Power Off=0B,Standby Mode=0C]* – this command string will provide a drop-down menu with three choices using the text before the equal signs to describe each command – from the VK6000 in the **Button Action - Commands** list:

  ![Commands](image2)

- "" quotation marks allow three symbols (, = @) to be added to a command that uses the equal sign as described in the example above. Three symbols not allowed within the quotation marks include ("" () []). Quotation marks can be used to the left of = in a **HEX** command; on either side of = in a **ASCII** command; and anywhere in an **Ethernet** command.

  **HEX Example:** ["Power=On”=0A,"POWER=Off”=0B]

  **ASCII Example:** ["Power=On”=pwn,"POWER=Off”=pwf]

  In the HEX example, “Power=On” allows the equal sign to be inserted before =0A. If the quotes are removed, the command **Power=On=0A** would fail as an **Invalid String**.
IR Device

- Click to add an Action.
- Click to create a duplicate of the Action
- Click to delete the selected action.

- **Settings** – Use the drop-down menu to set the **Repeat** setting (number of times a signal is sent): 1 Time, 2 Times or 3 Times (Default).
- **Advanced**
  - **Delay Interval** – Sets a time delay for each command before they are sent to the IR device.
  - **Receive Duration** – Sets the allowed duration of time for the IR device to receive a complete message from the controller.
- **Function List** – Use this section to configure the IR functions by adding actions to the list.
  - Quick Mode – Click to run Learning Mode for all IR actions in the Function List. When the Quick Mode window opens, click Start, a pop-up window appears to select a controller. Check a box to select a controller and click Select. Click Start a second time to run Quick Mode using the Learn instructions below.
  - **Function** – Lists the actions created for a device. Double-click to edit the Function the name.
  - **Status** – Reports the status (Tested, Failed, Learned) of the Learn and Test buttons.
  - **Learn** – Use to transfer commands from an IR remote to the Control Box. Click Learn. The Select Controller window appears.
• Click to select a controller from the list. Use the Refresh button to refresh the list. To browse for controllers in the LAN, click the Intelligent Search button or type the IP address of the controller.

• Click Learn a second time to start learning mode. When the IR Learn LED flashes green, point the IR remote at the Control Box’s front panel IR Receiver and push a button on the remote. Press the button on the remote just as you would when using it with the hardware device. If the device responds to a long hold or quick tap of the remote’s button then you must press the button in the same manner (long hold or quick tap) when using for Learning mode. The Control Box will beep and the Learn LED will light solid (then turn off) when IR learning is successful. The LED also turns off if Learning mode times out.

• Test – Use to test if commands are sent successfully to the Control Box and hardware device.

• Click Test, a pop-up window appears to select a controller and the IR port. Check a box to choose a controller and use the drop-down menu to select the IR port and then click Select.

• Click Test a second time to test if the IR data transmits successfully to the Control Box. Check the hardware device to confirm that it responded appropriately.

• The Status column reports the Learn and Test results.
Digital Output Device

Click to add an Action.

Click to create a duplicate of the Action

Click to delete the selected Action.

- Advanced – Click to use the Delay Interval drop-down menu to set a timed delay for each command before it is sent to the device.
- Function List – Use this section to configure the Digital Output device functions by adding actions to the list.
  - Function – Lists the actions created for a device. Double-click to edit the Function name.
  - Command – Shows the command selected for the action. Click the drop-down menu to select an action (Open, Close, Toggle, Pulse).
Relay Device

Click to add an Action.

Click to create a duplicate of the Action

Click to delete the selected Action.

- **Advanced** – Click to use the *Delay Interval* drop-down menu to set a timed delay for each command before it is sent to the device.

- **Function List** – Use this section to configure the Relay device functions by adding actions to the list.
  
  - **Function** – Lists the actions created for a device. Double-click to edit the Function name.
  
  - **Command** – Shows the command selected for the action. Click the drop-down menu to select an action (Open, Close, Toggle, Pulse).
Click to add an Action.

Click to create a duplicate of the Action.

Click to delete the selected action.

Click to enter a string within () which allows the text to be edited from the VK6000 in the Button Action - Commands list (see page 132).

Click to add a drop menu into a Command string, then enter the number sequence in the brackets []. The Function name must include an asterisk (*) for each drop menu in the Command string.

Click to add an Enter into the Command string.

Right-click one or more Ethernet commands (except HTTP/HTTPS) to copy and paste them as serial commands:

For special command string tools, see Text Command Tools, page 200.
### Settings
- **Protocol** – Click the drop-down list to select a protocol for the device
- **Port** – Type the port number for the device.
- **Advanced** – Click to access the following settings. The supported settings may vary depending on the device protocol and authentication type.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delay Interval</td>
<td>Sets a time delay for each command before they are sent to the device.</td>
</tr>
<tr>
<td>Delay Time after Login</td>
<td>Sets a time interval that the controller waits to request for login credentials of a device after establishing connection with the device.</td>
</tr>
<tr>
<td>Receive Duration</td>
<td>Sets the allowed duration of time for the Ethernet device to receive a complete message from the controller.</td>
</tr>
<tr>
<td>Send command after successful connection</td>
<td>Enter a First and Second Command to send to the device after a successful connection has been established.</td>
</tr>
<tr>
<td>Auth Type</td>
<td>Sets the authentication type for the device.</td>
</tr>
<tr>
<td>Timeout</td>
<td>Specifies the maximum time that the device allows for receiving each feedback message from the device before timing out.</td>
</tr>
<tr>
<td>Login</td>
<td>Sets the command for logging in to the device.</td>
</tr>
<tr>
<td>Parameter</td>
<td>Sets the parameters (keys) of the device that are required for the controller to connect to the device. For example, the device username and password are required when connecting to the device, and the valid values are <code>admin</code> and <code>123456</code> respectively.</td>
</tr>
<tr>
<td>Keep Connection Alive</td>
<td>Specify an interval during which the controller sends the specified command to make sure the it is connected to the Ethernet device.</td>
</tr>
<tr>
<td>Automatically reconnect if no return message is received</td>
<td>Check this box if you want to continue reconnection attempts when no return message is received from the device.</td>
</tr>
<tr>
<td>Use Default</td>
<td>Click this button to restore to default settings.</td>
</tr>
</tbody>
</table>
Chapter 5. ATEN Database Generator

- **Function List** – Use this section to configure the device functions by adding actions to the list.
- **String Format** – Use the buttons to select *HEX* or *ASCII*. (TCP only)
- **Function** – Lists the actions created for a device. A Function name must include an asterisk (*) for each drop menu you add to the Command string. Double-click to edit the function name. The drop-down menu will appear where the (*) is entered in the Function name
- **Command** – Shows the command string created for the action.
  - To edit a command for a Telnet, PJLINK, ONVIF, or TCP compliant device, double-click the **Command** field (green area in the interface).
  - To edit a command for an HTTP or HTTPS compliant device, click the **Edit** button. The Edit HTTP Command window appears.

![Edit HTTP Command Window]

- **Feedback** – Stores return messages generated by testing the command strings. Double-click to manually add or remove stored messages. This function is not applicable for ONVIF devices.
- **Send** – Click this button to test the command for the function. The return messages can be saved to Feedback.
This screen appears when **Send** is clicked. Select a controller for the device to connect and configure the fields such as device IP address.

### Intelligent Search
Click to locate controller without specifying an IP address. This option only searches for controllers on the same local area network. For controllers across a network device, such as a router or switch, you must specify the IP address.

### Search by IP address
Enter the IP address and click **Search** to locate a controller.

### Controller ID
Use the check box to select the Controller, fill in the IP Address, Username and/or Password and then click **OK**. Next use the instructions below this table.

### Refresh
Click this button to refresh the Controller ID list.

### IP Address
Type the IP address of the device.

### Username
Type the device’s username.

### Password
Type the device’s password to grant access right to the controller.

### Receive message for
Specifies the maximum allowed time that the device receives messages from the selected controller.

**Note:** The username and password are not required for UDP and TCP devices, and the username is not required for PJLINK devices.
Chapter 5. ATEN Database Generator

Testing Commands

After selecting a controller for the device and configure the required settings (if any) in the select controller window, click **OK** to proceed to test the typed command. The Test Command window appears.

```
<table>
<thead>
<tr>
<th>Function</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add Speaker to All Speaker List</td>
<td>Waiting</td>
</tr>
</tbody>
</table>
```

Select which device to send command to by choosing **Send to all** or **Send to specific** and then click **Send Test Command**. This window appears.

Select which device to send command to by choosing **Send to all** or **Send to specific** and then click **Send Test Command**. This window appears.
The test results will appear in the yellow area of the window and the feedback messages listed in the Feedback column.

- **Add** – Click to save a feedback message in the Saved Feedback message window.
- **Pause / Continue** – Click to pause sending/receiving the command/return message.
- **Save & Exit** – Save the feedback messages to the list and close the window.
Configuring Queries
You can set up queries to actively monitor parameters of a serial or Ethernet device and store the obtained value into a variable for reuse in a control system project.

Take the example of querying the cumulative number of hours that a projector lamp has been used to be able to estimate the remaining lifespan and plan for replacement in advance.

1. In Database Generator, click **Edit** to enter the settings page for the projector.

2. Add a command by clicking **+** and double-click the command column to type the command of requesting for the cumulative lamp usage (hour). Consult the user manual for the device to find out the operation command.

3. Set up a variable to store the queried value.
   a) In the Message column, click **Edit**. The Edit Messages window appears.
   b) Click the **Script** tab and click **+Add Script** and name the script.
c) Write up a script to create a variable that stores the requested value, in this case, the cumulative lamp hour.

![Image of script editor](image)

- Add Script

- Configure Variable

- Name: Lamp Hour
- Type: Int
- Range: [0, 255]
- Default: 0

- Click Save.
ATEN Library

The ATEN Library is accessed on the Library menu bar selection and provides the complete list of hardware devices available in the database. You can add any device in the ATEN Library to My Library. Once a device is added to My Library, the device settings can be edited as needed.

- Use the check boxes to select devices to add to My Library. Check All to select all devices in the list.
- Key in word strings then click Search to find a device.
- Click All, Serial, DO, IR, Relay or Ethernet to filter the device list by type.
- Click Brand, Category, Model, Type or Version to sort the devices.
- Click Add to My Library to add the selected devices to My Library.
- Click Cancel to return to My Library.
Chapter 6
Remote PC Control

Overview

While being capable of controlling serial, IR, I/O, and relay equipment, ATEN controllers also support remote control of computers. This control is achieved with a program, ControlAssist, that grants control right to a specified ATEN controller via the network. When a computer is installed with ControlAssist, you can remotely perform the following:

- Control PowerPoint slides
- Control media files through Windows Media Player
- Initiate actions on third-party programs using hotkeys that have been defined for the programs
- Perform system control such as shutting down the computer, execute command prompt, set system volume, and run a program

**Note:** For a full list of supported actions, see *Supported PC Control Actions*, page 225.

Specifications

- Supported computers
  - Only Windows-based computers are supported for remote control.
  - Each computer is deemed as an Ethernet device to the ATEN controller, and therefore follows the specification that each controller can support up to 25 Ethernet devices.
- To use ATEN Viewers on a Windows platform, make sure to install Internet Explorer version 11 or later.
- PowerPoint File Control
  - ControlAssist only supports PowerPoint files that contain 200 slides or less, and are created using Microsoft Office 2007/2010/2013, or WPS Office.
  - ControlAssist only supports the following PowerPoint file formats: pps, ppt, and pptx.
Media File Control

- ControlAssist only supports media files created using Windows Media Player.
- When a media file is remotely enabled and controlled using an ATEN Viewer, the file opens in Windows Media Player and this setting can not be changed.
- If you encounter any issues playing a media file, try install a third-party video codec.
- ControlAssist only supports control of the following media file formats:

<table>
<thead>
<tr>
<th>Category</th>
<th>File Formats</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows Media format</td>
<td>asf, wma, wmv, wmv</td>
</tr>
<tr>
<td>Windows Media Metafiles</td>
<td>asx, was, wvx, wmx, wpl</td>
</tr>
<tr>
<td>Microsoft Digital Video Recording</td>
<td>dvr-ms</td>
</tr>
<tr>
<td>Windows Media Download Package</td>
<td>wmd</td>
</tr>
<tr>
<td>Audio Visual Interleave</td>
<td>avi</td>
</tr>
<tr>
<td>Moving Pictures Experts Group</td>
<td>mpg, mpeg, m1v, mp2, mpa, mpe, m3u</td>
</tr>
<tr>
<td>Musical Instrument Digital Interface</td>
<td>mid, midi, rmi</td>
</tr>
<tr>
<td>Audio Interchange File Format</td>
<td>aif, aifc, aiff</td>
</tr>
<tr>
<td>Sun Microsystems and NeXT</td>
<td>au, snd</td>
</tr>
<tr>
<td>Audio for Windows</td>
<td>wav</td>
</tr>
<tr>
<td>CD Audio Track</td>
<td>cda</td>
</tr>
<tr>
<td>Indeo Video Technology</td>
<td>ivf</td>
</tr>
<tr>
<td>Windows Media Player Skins</td>
<td>wmx, wms</td>
</tr>
<tr>
<td>QuickTime movie file</td>
<td>mov</td>
</tr>
<tr>
<td>MP4 audio file</td>
<td>m4a</td>
</tr>
<tr>
<td>MP4 video file</td>
<td>mp4, m4v, mp4v, 3g2, 3gp2, 3gp, 3gpp</td>
</tr>
<tr>
<td>Windows audio file</td>
<td>aac, adt, adts</td>
</tr>
</tbody>
</table>
Chapter 6. Remote PC Control

Setting Up Remote PC Control

Follow the steps below to install the required programs on the target computers, configure the associated controller, and customize the Viewer for remote PC control.


2. Install ControlAssist on the computer you wish to control. For detailed steps, see Installing ControlAssist on Target Computers, page 217.

3. Add the computer into the control system. For detailed steps, see Adding Target Computers to the Control System, page 220.

4. Create a control interface to be used on a licensed mobile device.
   ♦ For detailed steps, see Configuring a Control Interface, page 222.
   ♦ For details on licenses, see Licenses for Mobile Control, page 61.

Installing ControlAssist on Target Computers

Follow the steps below to install ControlAssist on the computers you wish to control.

1. Download ControlAssist.
   a) Visit the ATEN download page: https://www.aten.com/global/en/products/professional-audiovideo/control-system/controlassist/
   b) Search for “VK6000”. A list of downloads for VK6000 appears.
   c) Click ControlAssist_Vx.x.x.x.zip to download.

2. From the downloaded file, double-click ControlAssist_Setup to install the program. An installation wizard appears.

3. Follow the on-screen instruction to complete the installation.
4. When the installation is complete, ControlAssist runs in the system tray.

**Note:** Keep the ControlAssist program enabled in the system tray to allow the controller to establish connection with the computer.

5. To configure ControlAssist, right-click in the system tray and select **Settings**. This window appears.

![ControlAssist Settings Window](image)

Click the **Basic Settings**, **Certification & Private Key**, or **About ATEN ControlAssist** to access the following settings/information.

<table>
<thead>
<tr>
<th>Control</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Basic Settings</strong></td>
<td></td>
<td>The settings with which an ATEN controller needs to establish connection with the computer and to gain control right.</td>
</tr>
<tr>
<td>Username</td>
<td>admin</td>
<td>The credentials required for an ATEN controller to establish connection with the computer. <strong>Note:</strong> To change the username and password, make sure to log in the computer using an Administrator account.</td>
</tr>
<tr>
<td>Password</td>
<td>password</td>
<td></td>
</tr>
<tr>
<td>Port</td>
<td>6277</td>
<td>The port through which ATEN Configurator establishes connection with the ControlAssist-installed computer.</td>
</tr>
</tbody>
</table>
### Session timeout

<table>
<thead>
<tr>
<th>Control</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>N/A</td>
<td>3600</td>
<td>The maximal time allowed for the controller to establish connection with ControlAssist.</td>
</tr>
</tbody>
</table>

### Root Folder

<table>
<thead>
<tr>
<th>Control</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>N/A</td>
<td>N/A</td>
<td>This field specifies the computer path under which files are displayed in the PowerPoint Control and Media templates' file lists. To display files at the computer’s partition level, type <code>%MY_COMPUTER%</code> in this field.</td>
</tr>
</tbody>
</table>

### Upload SSL Certificate and Private Key

Upload an SSL certificate and its private key to secure sessions between the computer and the connected controller.

<table>
<thead>
<tr>
<th>Control</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Certificate</td>
<td>Default</td>
<td>Click <strong>Choose a file from...</strong> to browse for an SSL certificate.</td>
</tr>
<tr>
<td>Private key</td>
<td>Default</td>
<td>Click <strong>Choose a file from...</strong> to browse for a private key SSL certificate.</td>
</tr>
</tbody>
</table>

### About ATEN ControlAssist

<table>
<thead>
<tr>
<th>Control</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Version</td>
<td>N/A</td>
<td>Indicates the release version.</td>
</tr>
<tr>
<td>Visit Official Website</td>
<td>N/A</td>
<td>Click to open the official website for more information.</td>
</tr>
</tbody>
</table>

**Note:** If the text in the ControlAssist window appears oversized, change the desktop font size to its default, and then log in the computer again to resolve the issue.
Adding Target Computers to the Control System

After you have installed ControlAssist on the computers you wish to control, follow the steps below to establish connection between the controller and the target computers.

1. From ATEN Configurator, locate and open your project file.
2. Click the Device tab, and from the Ethernet device type category, click on a blank device or click Add More Devices to add one.
3. Click Library. This window appears.
4. Use the search box to search for “controlassist” to load the ControlAssist database. This screen appears.

![Search for controlassist](image)

5. Click **Add to Project**. This computer, identified as an Ethernet device installed with ControlAssist, appears in the Device Configuration List.

![Device Configuration List](image)

6. Select the newly added device and configure the Properties settings on the right of the interface.

   **Hint:** If you have more than one computers installed with ControlAssist, change the device name to distinguish these PCs.

   For details on Properties settings, see *Ethernet Device Properties*, page 98.
Configuring a Control Interface

Example 1:

Follow the steps below to create a control interface that allows you to browse and play any file from the specified root folder (see page 217) in the target computer. You can follow the same logic for creating a media control page.

1. In the Design tab, make sure your home page contains a presentation button and the Viewer contains a PowerPoint page.

2. Configure the button to have it link to the PowerPoint page if pressed in the Viewer.
   a) Click the presentation button.
   b) Select Link and then double-click the PowerPoint page.
3. Configure the PowerPoint page if you did not use a built-in Viewer template.

   a) In the left sidebar, click **PowerPoint**.

   b) In the PowerPoint page, right-click any blank spot and select **PowerPoint Control Template**. A pre-made screen is added.

   ![PowerPoint Control Template](image)

   c) In the Properties column, use the **Select Device** drop-down menu to select the PC that stores the PowerPoint files you want to play.
Example 2:

Follow the steps below to create a quick access button for opening and playing a specific PowerPoint file. You can follow the same logic to create a button for opening and playing a specific media file.

1. Create an outlook for the interface.
   a) In ATEN Configurator, click the Design tab.
   b) Click Add Page and rename the page to “presentation”.
   c) Customize the interface and add control buttons using the Properties settings in the right-hand column. For details, see Design, page 102.

2. Define the action of each button. For example, for the PowerPoint button to open and start a slide show when pressed, do the following:
   a) In the preview pane, click the PowerPoint button.
   b) Select ControlAssist (LAN).
   d) Configure the commands and arrange them in the order of execution.

   **Tip:** The asterisk (*) at the end of a Function indicates that it requires configuration in the Commands column.

   For details on supported control actions, see Supported PC Control Actions, page 225.

3. From the Upload tab, deploy and back up the project to the controller. For details, see Upload, page 185.
# Chapter 6. Remote PC Control

## Supported PC Control Actions

<table>
<thead>
<tr>
<th>Command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Note:</strong> Commands indicated with an asterisk require configuration after being added to the Commands column in the Configurator.</td>
<td></td>
</tr>
</tbody>
</table>

### [Media Control]

**Note:** The commands in this group apply to Windows Media Player only.

<table>
<thead>
<tr>
<th>Command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Close</td>
<td>Closes the player.</td>
</tr>
<tr>
<td>Next</td>
<td>Plays next in the playlist.</td>
</tr>
<tr>
<td>Open file*</td>
<td>Opens and plays the specified file in Windows Media Player.</td>
</tr>
<tr>
<td>Open playlist*</td>
<td>Opens and plays the specified playlist in Windows Media Player.</td>
</tr>
<tr>
<td>Pause</td>
<td>Pauses the playback.</td>
</tr>
<tr>
<td>Play</td>
<td>Plays the opened file in Windows Media Player.</td>
</tr>
<tr>
<td>Previous</td>
<td>Plays previous in the playlist.</td>
</tr>
<tr>
<td>Set volume to*</td>
<td>Sets the player to a specified volume.</td>
</tr>
<tr>
<td>Stop</td>
<td>Stops the playback.</td>
</tr>
<tr>
<td>Switch to full screen mode*</td>
<td>Enables or disables the player to full-screen display.</td>
</tr>
<tr>
<td>Switch to mute mode*</td>
<td>Enables or disables mute mode.</td>
</tr>
<tr>
<td>Switch to repeat mode*</td>
<td>Enables or disables repeated play.</td>
</tr>
<tr>
<td>Volume*</td>
<td>Adjusts the player’s volume up or down.</td>
</tr>
</tbody>
</table>

### [PowerPoint Control]

<table>
<thead>
<tr>
<th>Command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open file*</td>
<td>Opens the specified PowerPoint file.</td>
</tr>
<tr>
<td>Start presentation</td>
<td>Starts the slide show of the specified PowerPoint file.</td>
</tr>
<tr>
<td>End presentation</td>
<td>Ends the slide show of the specified PowerPoint file.</td>
</tr>
<tr>
<td>Close</td>
<td>Closes the opened PowerPoint file.</td>
</tr>
<tr>
<td>Go to next slide*</td>
<td>Goes to the next slide.</td>
</tr>
<tr>
<td>Go to previous slide</td>
<td>Goes to the previous slide.</td>
</tr>
<tr>
<td>Go to slide</td>
<td>Goes to a specified slide number.</td>
</tr>
</tbody>
</table>

### [System Control]

<table>
<thead>
<tr>
<th>Command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open file*</td>
<td>Opens a specified file saved in the target computer.</td>
</tr>
<tr>
<td>Open URL*</td>
<td>Opens a specified URL.</td>
</tr>
<tr>
<td>Run program*</td>
<td>Runs an application.</td>
</tr>
<tr>
<td>Shut down PC</td>
<td>Shuts down the computer.</td>
</tr>
<tr>
<td>Command</td>
<td>Function</td>
</tr>
<tr>
<td>---------------------------</td>
<td>--------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Set volume*</td>
<td>Adjusts the computer’s volume.</td>
</tr>
<tr>
<td>Execute Command Prompt*</td>
<td>Executes the specified command via Command Prompt.</td>
</tr>
<tr>
<td>Bring application to top*</td>
<td>Keeps the window of the specified program on top of other windows that are open on the desktop.</td>
</tr>
</tbody>
</table>

**[Hotkey Control]**

- **Create action**
  - Executes the associated hotkey(s) on the program that opens topmost on the computer desktop.
  - For example, if you have “Ctrl + f” defined as the hotkey for extending a program to full screen in the program itself, to remotely simulate this action, you should have one Create action command associated with two Select key commands, one defined as “Ctrl”, and the other as “f”.

- **Select key**
  - Use this command to specify the hotkey as defined in the target program. If the hotkey involves pressing two or more keys at the same time, you will have two or more Select key commands associated to one Create action command. See the example in the Create action command above.

**Note:** Adhere to the following guidelines when specifying file paths:
- Include the file name and file extension of the target file.
- Use double backward slashes between folder levels.
- If the file path contains space, put the file path in double quotations.
- The following are examples of valid file paths:
  - “C:\ControlAssist\Presentation.pptx”
  - “C:\ControlAssist\Presentation Demo.pptx”
Chapter 7

ATEN Control System App

Overview

The ATEN Control System App is a platform that allows you to operate your control system using pre-made Viewers on mobile devices with an iOS, Android, or Windows platform.

Requirements

Make sure your mobile device uses a supported version of the mobile operating system listed below before installing the app.

<table>
<thead>
<tr>
<th>Mobile Operating System</th>
<th>Supported Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>iOS</td>
<td>10.0 or later</td>
</tr>
<tr>
<td>Android</td>
<td>8.0 or later</td>
</tr>
<tr>
<td>Windows</td>
<td>7 or later</td>
</tr>
</tbody>
</table>

Installing the App

To install the ATEN Control System App on a mobile device, do the following:

1. From the mobile device, tap the App Store or Google Play icon.
2. In the search box, type “aten control”.
3. Tap ATEN Control System, and then download and install the app.
4. The ATEN Control System icon appears on the mobile device. Tap the icon to open the app.

Button Sounds

After you install the app, go to the mobile device Settings and find the ATEN Control so that you can enable/disable the Button Sound setting.
The ATEN Control System App

When you open the ATEN Control System app for the first time, the default Welcome screen appears:

Tap Demo to try the ATEN Control System app. Tap Start to find a controller and download Viewers (see Welcome, page 232).

Note: The default Welcome screen appears until a Viewer is downloaded to the mobile device. After a Viewer is downloaded, the default Welcome screen will reappear only if the app is reinstalled, which will also delete all Viewers.
Demo

The Demo page provides a preview of the ATEN Control System app with two sample rooms. Tap either room to view the controls of different hardware devices. Tap Quit Demo at the top right corner to exit.

Select a Viewer or press any of the buttons on the Welcome page to demo the app. The first Viewer’s name will depend on the OS of the device.

WinViewer1 / iPad / Android1

This demo shows a Conference call interface with controls for a Projector, Screen and Lighting. Tap any of the device icons to open the control page.
Control Pages

The images above show the Main page and pages for the Projector, Screen and Lights.

Demo

This demo shows different buttons that can be pressed to control the Projector, Lights, Video Wall and Camera. Tap the icons to view control pages for each device. Tap the Quit Demo icon to return to the previous page, or press on the background until the logout dialog appears.
Control Pages

The images above show control pages for the **Projector, Lights, Video Wall** and **Camera** in *Demo*. Tap the **Home** icon in the lower left corner to return to the previous page, or press on the background until the logout dialog appears.
Welcome

The Welcome screen is the home screen of the ATEN Control System app. It lists the Viewers and provides administrative options. Tap a Viewer to open the controls for a room (see Design, page 102), or use the administrative options listed below.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="Manage Viewer" /></td>
<td><strong>Manage Viewer</strong> – Use this page to add, update, and remove downloaded Viewers. See page 234 for details.</td>
</tr>
<tr>
<td><img src="image2" alt="Manage LANDevice" /></td>
<td><strong>Manage LANDevice</strong> – Use this page to access controller’s web console or configure the network settings for controllers and the devices that they manage. See page 235 for details.</td>
</tr>
<tr>
<td><img src="image3" alt="Preference" /></td>
<td><strong>Preference</strong> – Use this page to set a password for accessing the app or configure the app’s usage settings. See page 238 for details.</td>
</tr>
<tr>
<td><img src="image4" alt="Log Report" /></td>
<td><strong>Log Report</strong> – Use this page to lookup logs to troubleshoot connectivity issues. See page 240 for details.</td>
</tr>
</tbody>
</table>
**Table:**

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Information" /></td>
<td><strong>Information</strong> – This page provides information about the ATEN Control System’s software version. See page 242 for details.</td>
</tr>
</tbody>
</table>
Manage Viewer

The Manage Viewer page allows you to add, update, and remove downloaded Viewers. To download Viewers, tap Add Viewer (see Preference, page 238).

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Add Viewer" /></td>
<td>Tap <strong>Add Viewer</strong> to download Viewers. See page 243 for details.</td>
</tr>
<tr>
<td><img src="image" alt="Information" /></td>
<td>Tap the <strong>Information</strong> icon to view the <strong>MAC Address</strong>, <strong>IP Address</strong>, and <strong>Controller ID</strong> of the controller associated with the Viewer.</td>
</tr>
<tr>
<td><img src="image" alt="Update" /></td>
<td>Tap <strong>Update</strong> to connect to the controller and download an updated version of the Viewer. After the update, the &quot;Downloaded Successfully&quot; prompt will appear.</td>
</tr>
<tr>
<td><img src="image" alt="Remove" /></td>
<td>Tap <strong>Remove</strong> to delete the Viewer. A dialog box will appear to confirm deletion of the Viewer. Tap <strong>Delete</strong> to remove the Viewer, or <strong>Cancel</strong> to cancel the deletion. <strong>Note:</strong> Viewers are only deleted on the mobile device, and will still be available on the controller.</td>
</tr>
<tr>
<td><img src="image" alt="Done" /></td>
<td>Tap <strong>Done</strong> to return to the Welcome page.</td>
</tr>
<tr>
<td><img src="image" alt="Add Viewer" /></td>
<td>Tap <strong>Add Viewer</strong> to download Viewers. See page 243 for details.</td>
</tr>
</tbody>
</table>
**Manage LAN Device**

The Manage LAN Device page allows you to edit network settings for the controllers and LAN devices added in the Configurator software (see Device Library, page 101).

Tap to expand controllers to view connected LAN devices.

Tap to open the web GUI (see Browser Operation, page 57).
Depending on the LAN device you select, different options are available. Tap on a device to open the settings page. Use **Edit** to change settings, **Apply** to save or **OK** to exit.

### Controller

![Controller settings](image)

### PJLink Projector

![PJLink Projector settings](image)

### Telnet

![Telnet settings](image)
Chapter 7. ATEN Control System App

ONVIF

ONVIF

ONVIF

TCP

TCP

UDP

UDP
The *Preference* page provides the following settings.

- **Seconds to press before the exit dialog appears**: This sets the duration of idle time. When the app idles for the specified duration, an Exit dialog appears to check if the user wants to close the app.
- **Enable Password**: Enable password authentication for accessing the app.
- **Allow keyboard usage when this app is in full screen**: Enable this option to allow keyboard operation when the app is in full screen.
- **Notify me when this app disconnects from the Internet**: Select this option to notify the user when the app disconnects from the Internet.
- **Connect to ATEN Control System devices based on the Manage Device IP list**: Select this option for the app to identify and connect to controllers by IP address instead of the controller ID. This is useful when
you create projects by duplication, in which case you do not need to reconfigure the controller ID in each project.

- **Always open viewers in full screen**: This setting is only available when using the app on a Windows platform. Enable this setting to open Viewers (i.e., control pages, for examples see page 230) in full screen.

- **Show minimize, maximize, and close buttons**: This setting is only available when using the app on a Windows platform. Enable this setting to show the minimize, maximize, and close buttons at the top-right corner of a Viewer (i.e., control page, for examples see page 230).

- **Show alert messages for Ethernet devices managed by the controller**: This setting is only available when using the app on an iOS platform. Enable this setting to receive status notifications for the managed Ethernet devices.
Log Report

The Log Report page lists information and errors which can be used to troubleshoot issues. Tap and drag the list to scroll through the logs. Tap Back to exit.

Tap Save to save the log file.

Tap Report History to view saved logs (see page 241).

Tap Delete to delete the log information.

Tap Back to exit.
Report History

When you tap **Report History**, you can view and export logs. Saved log files are listed by date in the left column. Tap a log file to view it in the window to the right. Tap and drag the list to scroll through the logs. Tap **Back** to exit.

![Log History]

Tap **Export** to send the log as an e-mail attachment.
The *Information* page displays the ATEN Control System’s version.
Download Viewer

The Download Viewer page allows you to search for controllers and download Viewers. This page is accessed from Welcome → Manage Viewer → Add Viewer.

- **Search by IP Address**: Tap to enter a controller’s IP address, then tap the Search icon to find it. When controllers are found on the network, they are listed in the Add Viewer box. A Search History drop-down menu will appear for previously searched IP addresses.

- **Auto Search**: Auto Search allows you to search for controllers without specifying an IP address. The controller must be powered on and connected to the same local network.

- **Add Viewer**: This panel lists the controllers that have been found on the network. Each controller lists Viewers that can be downloaded to the mobile device. To upload Viewers to a controller, see Upload, page 185.

- **Back Icon**: Back returns you to the Welcome page.

- **Download**: After you select the Viewers you want to download, click Download to start the process.
Downloading Viewers
When controllers are found, they appear in the Add Viewer panel. Check the boxes of the Viewers you would like to download, then tap Download.

Add Viewer
The main window lists the controllers that have been found on the network. Under each controller is a list of Viewers with a check box. Use the check boxes to select the Viewers you want to download, then click Download. If the Lock icon appears, you will be prompted to enter the access key.

After Viewers download, the “Downloaded Successfully” prompt appears. Tap Done to return to the Welcome page where the Viewers will be listed.
Note: After you download a Viewers to the mobile device, the default Welcome screen no longer appears.

Access Key
When the a Viewers requires an access key a window appears prompting you to enter the key. Enter the correct access key and then click OK to download the Viewers from the controller. To set the access key, see Upload, page 185.

Tap the Information icon to view the IP Address, MAC Address and License information of the controller. The license information provides the total number of licenses available and the number in use.
Appendix

Safety Instructions

General

- Read all of these instructions. Save them for future reference.
- Follow all warnings and instructions marked on the device.
- This product is for indoor use only.
- Do not place the device on any unstable surface (cart, stand, table, etc.). If the device falls, serious damage will result.
- Caution: Risk of explosion if the battery is replaced by an incorrect type. Always dispose of used batteries according to the proper instructions.
- Do not use the device near water.
- Do not place the device near, or over, radiators or heat registers.
- The device cabinet is provided with slots and openings to allow for adequate ventilation. To ensure reliable operation, and to protect against overheating, these openings must never be blocked or covered.
- The device should never be placed on a soft surface (bed, sofa, rug, etc.) as this will block its ventilation openings. Likewise, the device should not be placed in a built in enclosure unless adequate ventilation has been provided.
- Never spill liquid of any kind on the device.
- Unplug the device from the wall outlet before cleaning. Do not use liquid or aerosol cleaners. Use a damp cloth for cleaning.
- The device should be operated from the type of power source indicated on the marking label. If you are not sure of the type of power available, consult your dealer or local power company.
- The device is designed for IT power distribution systems with 230V phase-to-phase voltage.
- To prevent damage to your installation it is important that all devices are properly grounded.
- The device is equipped with a 3-wire grounding type plug. This is a safety feature. If you are unable to insert the plug into the outlet, contact your electrician to replace your obsolete outlet. Do not attempt to defeat the purpose of the grounding-type plug. Always follow your local/national wiring codes.
Do not allow anything to rest on the power cord or cables. Route the power cord and cables so that they cannot be stepped on or tripped over.

If an extension cord is used with this device make sure that the total of the ampere ratings of all products used on this cord does not exceed the extension cord ampere rating. Make sure that the total of all products plugged into the wall outlet does not exceed 15 amperes.

To help protect your system from sudden, transient increases and decreases in electrical power, use a surge suppressor, line conditioner, or un-interruptible power supply (UPS).

Position system cables and power cables carefully; Be sure that nothing rests on any cables.

Never push objects of any kind into or through cabinet slots. They may touch dangerous voltage points or short out parts resulting in a risk of fire or electrical shock.

Do not attempt to service the device yourself. Refer all servicing to qualified service personnel.

If the following conditions occur, unplug the device from the wall outlet and bring it to qualified service personnel for repair.

- The power cord or plug has become damaged or frayed.
- Liquid has been spilled into the device.
- The device has been exposed to rain or water.
- The device has been dropped, or the cabinet has been damaged.
- The device exhibits a distinct change in performance, indicating a need for service.
- The device does not operate normally when the operating instructions are followed.

Only adjust those controls that are covered in the operating instructions. Improper adjustment of other controls may result in damage that will require extensive work by a qualified technician to repair.

Avoid circuit overloads. Before connecting equipment to a circuit, know the power supply’s limit and never exceed it. Always review the electrical specifications of a circuit to ensure that you are not creating a dangerous condition or that one doesn’t already exist. Circuit overloads can cause a fire and destroy equipment.
Appendix

Rack Mounting

- Before working on the rack, make sure that the stabilizers are secured to the rack, extended to the floor, and that the full weight of the rack rests on the floor. Install front and side stabilizers on a single rack or front stabilizers for joined multiple racks before working on the rack.
- Always load the rack from the bottom up, and load the heaviest item in the rack first.
- Make sure that the rack is level and stable before extending a device from the rack.
- Use caution when pressing the device rail release latches and sliding a device into or out of a rack; the slide rails can pinch your fingers.
- After a device is inserted into the rack, carefully extend the rail into a locking position, and then slide the device into the rack.
- Do not overload the AC supply branch circuit that provides power to the rack. The total rack load should not exceed 80 percent of the branch circuit rating.
- Make sure that all equipment used on the rack – including power strips and other electrical connectors – is properly grounded.
- Ensure that proper airflow is provided to devices in the rack.
- Ensure that the operating ambient temperature of the rack environment does not exceed the maximum ambient temperature specified for the equipment by the manufacturer.
- Do not step on or stand on any device when servicing other devices in a rack.
## Specifications

### VK2100

<table>
<thead>
<tr>
<th>Function</th>
<th>VK2100</th>
</tr>
</thead>
<tbody>
<tr>
<td>Interface</td>
<td>4 x Programmable Bi-directional RS-232/422/485 Ports (4 x DB9 Male Connectors, Configurable via Pin Assignments)</td>
</tr>
<tr>
<td></td>
<td>Baud Rate: 300 to 115200 (default: 9600)</td>
</tr>
<tr>
<td></td>
<td>Data Bit: 8 (default) or 7</td>
</tr>
<tr>
<td></td>
<td>Stop Bit: 1 (default) or 2</td>
</tr>
<tr>
<td></td>
<td>Parity: None (default), Even or Odd</td>
</tr>
<tr>
<td></td>
<td>Flow Control: None (default) RTS/CTS</td>
</tr>
<tr>
<td></td>
<td>2 x Bi-directional RS-232 Ports (2 x 3-Pole Terminal Block Connectors)</td>
</tr>
<tr>
<td></td>
<td>Baud Rate: 300 to 115200 (default: 9600)</td>
</tr>
<tr>
<td></td>
<td>Data Bit: 8 (default) or 7</td>
</tr>
<tr>
<td></td>
<td>Stop Bit: 1 (default) or 2</td>
</tr>
<tr>
<td></td>
<td>Parity: None (default), Even or Odd</td>
</tr>
<tr>
<td>IR/Serial</td>
<td>4 x Programmable IR / Uni-directional RS-232 Ports (2 x 4-Pole Terminal Block Connectors)</td>
</tr>
<tr>
<td></td>
<td>IR: TTL level (0 to 5 V)</td>
</tr>
<tr>
<td></td>
<td>Carrier Frequency: 10KHz~455KHz</td>
</tr>
<tr>
<td></td>
<td>Serial: Uni-directional RS-232 (+ - 5 V)</td>
</tr>
<tr>
<td></td>
<td>Baud Rate: 300 to 115200 (default: 9600)</td>
</tr>
<tr>
<td></td>
<td>Data Bit: 8 (default) or 7</td>
</tr>
<tr>
<td></td>
<td>Stop Bit: 1 (default) or 2</td>
</tr>
<tr>
<td></td>
<td>Parity: None (default), Even or Odd</td>
</tr>
<tr>
<td>I/O</td>
<td>4 x Programmable Digital Input / Output Channels (1 x 5-Pole Terminal Block Connector)</td>
</tr>
<tr>
<td></td>
<td>Digital Output: 250 mA sink from 12 VDC</td>
</tr>
<tr>
<td></td>
<td>Digital Input: VDC Mode</td>
</tr>
<tr>
<td></td>
<td>Input Voltage Range: 0 to 24 VDC</td>
</tr>
<tr>
<td></td>
<td>Programmable Range: 1 to 24 VDC</td>
</tr>
<tr>
<td></td>
<td>Dry Contact Mode: Pull-up 2k ohms to + 12 VDC</td>
</tr>
<tr>
<td>Relay</td>
<td>4 x Relay Channels (2 x 4-Pole Terminal Block Connector)</td>
</tr>
<tr>
<td></td>
<td>Normally Open, Isolated Relays</td>
</tr>
<tr>
<td></td>
<td>Contact Rating: Max 24 VDC, 2A</td>
</tr>
<tr>
<td>VDC</td>
<td>4 x 12 VDC Output Ports (2 x 4-Pole Terminal Block Connectors)</td>
</tr>
<tr>
<td></td>
<td>Power Supply: 12 VDC, 2A Max (Shared By 4 Ports)</td>
</tr>
<tr>
<td>Connectors</td>
<td>Ethernet 1 x RJ-45 Female, 10/100Base-T</td>
</tr>
<tr>
<td></td>
<td>USB 1 x USB Type A Female (White)</td>
</tr>
<tr>
<td></td>
<td>Power 1 x 3-prong AC power socket</td>
</tr>
<tr>
<td>Function</td>
<td>VK2100</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-------------------------</td>
</tr>
<tr>
<td><strong>Switches</strong></td>
<td></td>
</tr>
<tr>
<td>Controller ID</td>
<td>1 x 16-Segment Switch</td>
</tr>
<tr>
<td>Power</td>
<td>1 x Rocker Switch</td>
</tr>
<tr>
<td>Reset</td>
<td>1 x Semi-recessed pushbutton</td>
</tr>
<tr>
<td><strong>LEDs</strong></td>
<td></td>
</tr>
<tr>
<td>Relay</td>
<td>4 (Green)</td>
</tr>
<tr>
<td>IR / Serial</td>
<td>4 (Green)</td>
</tr>
<tr>
<td>I/O</td>
<td>4 (Green)</td>
</tr>
<tr>
<td>Serial</td>
<td></td>
</tr>
<tr>
<td>RX</td>
<td>6 (Green)</td>
</tr>
<tr>
<td>TX</td>
<td>6 (Green)</td>
</tr>
<tr>
<td>Ethernet</td>
<td></td>
</tr>
<tr>
<td>Link</td>
<td>1 (Green)</td>
</tr>
<tr>
<td>Act</td>
<td>1 (Green)</td>
</tr>
<tr>
<td>DC Output Overload</td>
<td>1 (Orange)</td>
</tr>
<tr>
<td>IR Learn</td>
<td>1 (Green)</td>
</tr>
<tr>
<td>USB</td>
<td>1 (Green / Orange)</td>
</tr>
<tr>
<td>Power</td>
<td>1 (Green)</td>
</tr>
<tr>
<td><strong>IR Receiver</strong></td>
<td></td>
</tr>
<tr>
<td>1 x IR Receiver Port</td>
<td></td>
</tr>
<tr>
<td><strong>I/P Rating</strong></td>
<td></td>
</tr>
<tr>
<td>100-240 VAC, 50-60 Hz, 1A</td>
<td></td>
</tr>
<tr>
<td><strong>Power Consumption</strong></td>
<td>40 Watt</td>
</tr>
<tr>
<td><strong>Environment</strong></td>
<td></td>
</tr>
<tr>
<td>Operating Temp.</td>
<td>0–50°C</td>
</tr>
<tr>
<td>Storage Temp.</td>
<td>-20–60°C</td>
</tr>
<tr>
<td>Humidity</td>
<td>0–80% RH, Non-condensing</td>
</tr>
<tr>
<td><strong>Physical Properties</strong></td>
<td></td>
</tr>
<tr>
<td>Housing</td>
<td>Metal</td>
</tr>
<tr>
<td>Weight</td>
<td>2.64 kg</td>
</tr>
<tr>
<td>Dimensions (L x W x H)</td>
<td>43.72 x 16.32 x 4.40 cm</td>
</tr>
<tr>
<td><strong>Licenses for mobile control</strong></td>
<td></td>
</tr>
<tr>
<td>No. of Free Licenses</td>
<td>2</td>
</tr>
<tr>
<td>Max. No. of Allowed Licenses</td>
<td>10</td>
</tr>
</tbody>
</table>
## VK1100

<table>
<thead>
<tr>
<th>Function</th>
<th>VK1100</th>
</tr>
</thead>
<tbody>
<tr>
<td>Interface</td>
<td>2 x Programmable Bi-directional RS-232/422/485 Ports (2 x DB9 Male Connectors, Configurable via Pin Assignments)</td>
</tr>
<tr>
<td></td>
<td>- Baud Rate: 300 to 115200 (default: 9600)</td>
</tr>
<tr>
<td></td>
<td>- Data Bit: 8 (default) or 7</td>
</tr>
<tr>
<td></td>
<td>- Stop Bit: 1 (default) or 2</td>
</tr>
<tr>
<td></td>
<td>- Parity: None (default), Even or Odd</td>
</tr>
<tr>
<td></td>
<td>- Flow Control: None (default) RTS/CTS</td>
</tr>
<tr>
<td>IR/Serial</td>
<td>2 x Programmable IR / Uni-directional RS-232 Ports (1 x 3-Pole Terminal Block Connectors)</td>
</tr>
<tr>
<td></td>
<td>- IR: TTL level (0 to 5 V)</td>
</tr>
<tr>
<td></td>
<td>- Carrier Frequency: 10KHz~455KHz</td>
</tr>
<tr>
<td></td>
<td>- Serial: Uni-directional RS-232 (0-5 V)</td>
</tr>
<tr>
<td></td>
<td>- Baud Rate: 300 to 115200 (default: 9600)</td>
</tr>
<tr>
<td></td>
<td>- Data Bit: 8 (default) or 7</td>
</tr>
<tr>
<td></td>
<td>- Stop Bit: 1 (default) or 2</td>
</tr>
<tr>
<td></td>
<td>- Parity: None (default), Even or Odd</td>
</tr>
<tr>
<td>Relay</td>
<td>4 x Relay Channels (2 x 4-Pole Terminal Block Connector)</td>
</tr>
<tr>
<td></td>
<td>- Normally Open, Isolated Relays</td>
</tr>
<tr>
<td></td>
<td>- Contact Rating: Max 24 VDC, 2A</td>
</tr>
<tr>
<td>VDC</td>
<td>1 x 12 VDC Output Ports (1 x 2-Pole Terminal Block Connectors)</td>
</tr>
<tr>
<td>Connectors</td>
<td>1 x RJ-45 Female, 10/100Base-T</td>
</tr>
<tr>
<td>USB</td>
<td>1 x USB Type A Female (White)</td>
</tr>
<tr>
<td>Power</td>
<td>1 x 3-prong AC power socket</td>
</tr>
<tr>
<td>Switches</td>
<td>1 x 16-Segment Switch</td>
</tr>
<tr>
<td></td>
<td>1 x Rocker Switch</td>
</tr>
<tr>
<td></td>
<td>1 x Semi-recessed pushbutton</td>
</tr>
<tr>
<td>LEDs</td>
<td>4 (Green)</td>
</tr>
<tr>
<td></td>
<td>2 (Green)</td>
</tr>
<tr>
<td></td>
<td>2 (Green)</td>
</tr>
<tr>
<td></td>
<td>2 (Green)</td>
</tr>
<tr>
<td></td>
<td>1 (Green)</td>
</tr>
<tr>
<td></td>
<td>1 (Green)</td>
</tr>
<tr>
<td></td>
<td>1 (Green)</td>
</tr>
<tr>
<td></td>
<td>1 (Green)</td>
</tr>
<tr>
<td></td>
<td>1 (Green)</td>
</tr>
<tr>
<td></td>
<td>1 (Orange)</td>
</tr>
<tr>
<td></td>
<td>1 (Green)</td>
</tr>
<tr>
<td></td>
<td>1 (Green)</td>
</tr>
<tr>
<td></td>
<td>1 (Green)</td>
</tr>
<tr>
<td></td>
<td>1 (Green)</td>
</tr>
<tr>
<td></td>
<td>1 x IR Receiver Port</td>
</tr>
<tr>
<td>I/P Rating</td>
<td>100-240 VAC, 50-60 Hz, 1A</td>
</tr>
</tbody>
</table>
### Appendix

<table>
<thead>
<tr>
<th>Function</th>
<th>VK1100</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power Consumption</td>
<td>20 Watts</td>
</tr>
<tr>
<td>Environment</td>
<td></td>
</tr>
<tr>
<td>Operating Temp.</td>
<td>0–50°C</td>
</tr>
<tr>
<td>Storage Temp.</td>
<td>-20–60°C</td>
</tr>
<tr>
<td>Humidity</td>
<td>0–80% RH, Non-condensing</td>
</tr>
<tr>
<td>Physical Properties</td>
<td></td>
</tr>
<tr>
<td>Housing</td>
<td>Metal</td>
</tr>
<tr>
<td>Weight</td>
<td>1.19 kg</td>
</tr>
<tr>
<td>Dimensions (L x W x H)</td>
<td>21.50 x 16.23 x 4.18 cm</td>
</tr>
<tr>
<td>Licenses for mobile control</td>
<td></td>
</tr>
<tr>
<td>No. of Free Licenses</td>
<td>2</td>
</tr>
<tr>
<td>Max. No. of Allowed Licenses</td>
<td>10</td>
</tr>
</tbody>
</table>
## VK0100/VK0200

<table>
<thead>
<tr>
<th>Function</th>
<th>VK0100</th>
<th>VK0200</th>
</tr>
</thead>
<tbody>
<tr>
<td>Interface</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Keypad Layout</td>
<td>Up to 14 layout variations using 4 ~ 8 buttons</td>
<td>Up to 125 layout variations using 6 ~ 12 buttons</td>
</tr>
<tr>
<td>Serial</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• 2 x Bi-directional RS-232 Port (2 x 3-Pole Terminal Block Connector)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Baud Rate: 300 to 115200 (default: 9600)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Data Bit: 8 (default) or 7</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Stop Bit: 1 (default) or 2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Parity: None (default), even or odd</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Relay</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• 2 x Relay Channel (2 x 2-Pole Terminal Block Connector)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Normally open, isolated Relays</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Contact Rating: Max 24 VDC, 1A</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Digital Input</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• 1 x Digital Input Channel (1 x 2-Pole Terminal Block Connector);</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• VDC Mode</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Input Voltage Range: 0 to 5 VDC</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Programmable Range: 1 to 5 VDC</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Dry Contact Mode</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Pull-up 2k ohms to + 5 VDC</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Ethernet</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• 1 x RJ-45 Female, 10/100Base-T</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Supported Protocol: ARP, ICMP, TCP/IP, DHCP, HTTPS, SSH</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• DHCP-enabled. The following default IP settings will be used if no IP is assigned within 30 seconds:</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• IP: 192.168.0.60</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Subnet Mask: 255.255.255.0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Switches</td>
<td>Controller ID</td>
<td></td>
</tr>
<tr>
<td></td>
<td>1 x 16-segment Switch</td>
<td></td>
</tr>
<tr>
<td>Reset Button</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>1 x Semi-recessed Pushbutton</td>
<td></td>
</tr>
<tr>
<td>Power Consumption</td>
<td>DC5V: 1.16W; DC48V: 1.375W</td>
<td>DC5V: 1.15W; DC48V: 1.44W</td>
</tr>
<tr>
<td>Environmental</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Operating</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Temperature</td>
<td>0 – 50°C</td>
<td></td>
</tr>
<tr>
<td>Storage</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Temperature</td>
<td>–20 – 80°C</td>
<td></td>
</tr>
<tr>
<td>Humidity</td>
<td>0 - 80% RH, Non-Condensing</td>
<td></td>
</tr>
<tr>
<td>Physical</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Properties</td>
<td>Housing Plastic</td>
<td></td>
</tr>
<tr>
<td>Weight</td>
<td>0.35 kg (0.77 lb)</td>
<td>0.38 kg (0.84 lb)</td>
</tr>
<tr>
<td>Dimension</td>
<td>11.63 x 7.06 x 4.84 cm</td>
<td>8.32 x 14.76 x 4.84 cm</td>
</tr>
<tr>
<td></td>
<td>(4.58 x 2.78 x 1.91 in)</td>
<td>(3.28 x 5.81 x 1.91 in)</td>
</tr>
</tbody>
</table>
licenses for mobile control

<table>
<thead>
<tr>
<th>Function</th>
<th>VK0100</th>
<th>VK0200</th>
</tr>
</thead>
<tbody>
<tr>
<td>No. of Free Licenses</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>Max. No. of Allowed Licenses</td>
<td></td>
<td>10</td>
</tr>
</tbody>
</table>
CAD Drawings

ATEN

VK0100
Panel Mount Cutout

Width of faceplate = 7.4 cm [2.92”]

Height of faceplate = 11.9 cm [4.69”]

7.2 cm [2.83”]
5.4 cm [2.13”]
8.4 cm [3.31”]
1.8 cm [0.71”]

Note: ATEN recommends a 1-gang wall box with a depth of at least 5 cm (1.97 inches) to accommodate the connectors and cables.
CAD Drawings

ATEN

VK0200
Panel Mount Cutout

Width of faceplate = 15.1 cm [5.95”]

Height of faceplate = 8.6 cm [3.39”]

10.1 cm [3.98”]

5.4 cm [2.13”]

Cutout Area

Note: ATEN recommends a 2-gang wall box with a depth of at least 5 cm (1.97 inches) to accommodate the connectors and cables.
CAD Drawings

[Diagram showing dimensions]
Panel Mount Cutout

Width of faceplate = 7.4 cm [2.92"

Height of faceplate = 11.9 cm [4.69"

Note: ATEN recommends a 1-gang wall box with a depth of at least 5 cm (1.97 inches) to accommodate the connectors and cables.

ATEN
VK108US
CAD Drawings

VK112EU
Panel Mount Cutout

Width of faceplate = 15.1 cm [5.95"]

Height of faceplate = 8.6 cm [3.39”]

10.1 cm [3.98”]

5.4 cm [2.13”]

Cutout Area

Note: ATEN recommends a 2-gang wall box with a depth of at least 5 cm (1.97 inches) to accommodate the connectors and cables.
## Datapoint Types

ATEN Control System supports the following KNX Datapoint Types (DPT):

<table>
<thead>
<tr>
<th>DPT ID</th>
<th>DPT Format</th>
<th>DPT Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.001</td>
<td>B1</td>
<td>DPT_Switch</td>
</tr>
<tr>
<td>1.002</td>
<td>B1</td>
<td>DPT_Bool</td>
</tr>
<tr>
<td>1.003</td>
<td>B1</td>
<td>DPT_Enable</td>
</tr>
<tr>
<td>1.004</td>
<td>B1</td>
<td>DPT_Ramp</td>
</tr>
<tr>
<td>1.005</td>
<td>B1</td>
<td>DPT_Alarm</td>
</tr>
<tr>
<td>1.006</td>
<td>B1</td>
<td>DPT_BinaryValue</td>
</tr>
<tr>
<td>1.007</td>
<td>B1</td>
<td>DPT_Step</td>
</tr>
<tr>
<td>1.008</td>
<td>B1</td>
<td>DPT_UpDown</td>
</tr>
<tr>
<td>1.009</td>
<td>B1</td>
<td>DPT_OpenClose</td>
</tr>
<tr>
<td>1.010</td>
<td>B1</td>
<td>DPT_Start</td>
</tr>
<tr>
<td>1.011</td>
<td>B1</td>
<td>DPT_State</td>
</tr>
<tr>
<td>1.012</td>
<td>B1</td>
<td>DPT_Invert</td>
</tr>
<tr>
<td>1.013</td>
<td>B1</td>
<td>DPT_DimSendStyle</td>
</tr>
<tr>
<td>1.014</td>
<td>B1</td>
<td>DPT_InputSource</td>
</tr>
<tr>
<td>1.015</td>
<td>B1</td>
<td>DPT_Reset</td>
</tr>
<tr>
<td>1.016</td>
<td>B1</td>
<td>DPT_Ack</td>
</tr>
<tr>
<td>1.017</td>
<td>B1</td>
<td>DPT_Trigger</td>
</tr>
<tr>
<td>1.018</td>
<td>B1</td>
<td>DPT_Occupancy</td>
</tr>
<tr>
<td>1.019</td>
<td>B1</td>
<td>DPT_Window_Door</td>
</tr>
<tr>
<td>1.021</td>
<td>B1</td>
<td>DPT_LogicalFunction</td>
</tr>
<tr>
<td>1.022</td>
<td>B1</td>
<td>DPT_Scene_AB</td>
</tr>
<tr>
<td>1.023</td>
<td>B1</td>
<td>DPT_ShutterBlinds_Mode</td>
</tr>
<tr>
<td>1.100</td>
<td>B1</td>
<td>DPT_Heat/Cool</td>
</tr>
<tr>
<td>2.001</td>
<td>B2</td>
<td>DPT_Switch_Control</td>
</tr>
<tr>
<td>2.002</td>
<td>B2</td>
<td>DPT_Bool_Control</td>
</tr>
<tr>
<td>2.003</td>
<td>B2</td>
<td>DPT_Enable_Control</td>
</tr>
<tr>
<td>2.004</td>
<td>B2</td>
<td>DPT_Ramp_Control</td>
</tr>
<tr>
<td>DPT ID</td>
<td>DPT Format</td>
<td>DPT Name</td>
</tr>
<tr>
<td>--------</td>
<td>------------</td>
<td>------------------------</td>
</tr>
<tr>
<td>2.005</td>
<td>B₂</td>
<td>DPT_Alarm_Control</td>
</tr>
<tr>
<td>2.006</td>
<td>B₂</td>
<td>DPT_BinaryValue_Control</td>
</tr>
<tr>
<td>2.007</td>
<td>B₂</td>
<td>DPT_Step_Control</td>
</tr>
<tr>
<td>2.008</td>
<td>B₂</td>
<td>DPT_Direction1_Control</td>
</tr>
<tr>
<td>2.009</td>
<td>B₂</td>
<td>DPT_Direction2_Control</td>
</tr>
<tr>
<td>2.010</td>
<td>B₂</td>
<td>DPT_Start_Control</td>
</tr>
<tr>
<td>2.011</td>
<td>B₂</td>
<td>DPT_State_Control</td>
</tr>
<tr>
<td>2.012</td>
<td>B₂</td>
<td>DPT_Invert_Control</td>
</tr>
<tr>
<td>3.007</td>
<td>B₃</td>
<td>DPT_Control_Dimming</td>
</tr>
<tr>
<td>3.008</td>
<td>B₃</td>
<td>DPT_Control_Blinds</td>
</tr>
<tr>
<td>4.001</td>
<td>A₈</td>
<td>DPT_ASCII</td>
</tr>
<tr>
<td>4.002</td>
<td>A₈</td>
<td>DPT_Char_8859_1</td>
</tr>
<tr>
<td>5.001</td>
<td>U₈</td>
<td>DPT_Scaling</td>
</tr>
<tr>
<td>5.003</td>
<td>U₈</td>
<td>DPT_Angle</td>
</tr>
<tr>
<td>5.004</td>
<td>U₈</td>
<td>DPT_Percent_U8</td>
</tr>
<tr>
<td>5.005</td>
<td>U₈</td>
<td>DPT_DecimalFactor</td>
</tr>
<tr>
<td>5.006</td>
<td>U₈</td>
<td>DPT_Tariff</td>
</tr>
<tr>
<td>5.010</td>
<td>U₈</td>
<td>DPT_Value_1_Ucount</td>
</tr>
<tr>
<td>6.001</td>
<td>V₈</td>
<td>DPT_Percent_V8</td>
</tr>
<tr>
<td>6.010</td>
<td>V₈</td>
<td>DPT_Value_1_Count</td>
</tr>
<tr>
<td>6.020</td>
<td>B₉N₃</td>
<td>DPT_Status_Mode3</td>
</tr>
<tr>
<td>7.013</td>
<td>U₁₆</td>
<td>DPT_Brightness</td>
</tr>
<tr>
<td>8.011</td>
<td>V₁₆</td>
<td>DPT_Rotation_Angle</td>
</tr>
<tr>
<td>9.001</td>
<td>F₁₆</td>
<td>DPT_Value_Temp</td>
</tr>
<tr>
<td>18.001</td>
<td>B₄R₁U₆</td>
<td>DPT_SceneControl</td>
</tr>
<tr>
<td>20.100</td>
<td>N₈</td>
<td>DPT_FuelType</td>
</tr>
<tr>
<td>20.101</td>
<td>N₈</td>
<td>DPT_BurnerType</td>
</tr>
<tr>
<td>20.102</td>
<td>N₈</td>
<td>DPT_HVACMode</td>
</tr>
<tr>
<td>20.103</td>
<td>N₈</td>
<td>DPT_DHWMode</td>
</tr>
<tr>
<td>20.104</td>
<td>N₈</td>
<td>DPT_LoadPriority</td>
</tr>
<tr>
<td>DPT ID</td>
<td>DPT Format</td>
<td>DPT Name</td>
</tr>
<tr>
<td>---------</td>
<td>------------</td>
<td>-------------------------------</td>
</tr>
<tr>
<td>20.105</td>
<td>N8</td>
<td>DPT_HVACContrMode</td>
</tr>
<tr>
<td>20.106</td>
<td>N8</td>
<td>DPT_HVACEmergMode</td>
</tr>
<tr>
<td>20.107</td>
<td>N8</td>
<td>DPT_ChangeoverMode</td>
</tr>
<tr>
<td>20.108</td>
<td>N8</td>
<td>DPT_ValveMode</td>
</tr>
<tr>
<td>20.109</td>
<td>N8</td>
<td>DPT_DamperMode</td>
</tr>
<tr>
<td>20.110</td>
<td>N8</td>
<td>DPT_HeaterMode</td>
</tr>
<tr>
<td>20.111</td>
<td>N8</td>
<td>DPT_FanMode</td>
</tr>
<tr>
<td>20.112</td>
<td>N8</td>
<td>DPT_MasterSlaveMode</td>
</tr>
<tr>
<td>20.113</td>
<td>N8</td>
<td>DPT_StatusRoomSetp</td>
</tr>
<tr>
<td>23.001</td>
<td>N2</td>
<td>DPT_OnOff_Action</td>
</tr>
<tr>
<td>23.002</td>
<td>N2</td>
<td>DPT_Alarm_Reaction</td>
</tr>
<tr>
<td>23.003</td>
<td>N2</td>
<td>DPT_UpDown_Action</td>
</tr>
<tr>
<td>23.102</td>
<td>N2</td>
<td>DPT_HVAC_PB_Action</td>
</tr>
</tbody>
</table>
Windows OS Button Limitation

When adding buttons to a Viewer page for use on a Windows mobile device there is a Windows OS limitation for overlapping buttons. When two buttons are layered (A) on top of (B), the top most button (A) can not be pressed – instead (B) is activated each time. To resolve this issue, duplicate the top most button (A) and add it (C) directly under (A) and below (B) on the Viewer page.

When the top button (A) is pressed, the lowest button (C) will execute the action.
Technical Support

International

- For online technical support – including troubleshooting, documentation, and software updates: http://eservice.aten.com
- For telephone support, see Telephone Support, page iii:

North America

<table>
<thead>
<tr>
<th>Online Technical Support</th>
<th>Troubleshooting Documentation Software Updates</th>
<th><a href="https://eservice.aten.com">https://eservice.aten.com</a></th>
</tr>
</thead>
<tbody>
<tr>
<td>Email Support</td>
<td><a href="mailto:support@aten-usa.com">support@aten-usa.com</a></td>
<td></td>
</tr>
<tr>
<td>Telephone Support</td>
<td>1-888-999-ATEN ext 4988</td>
<td></td>
</tr>
</tbody>
</table>

When you contact us, please have the following information ready beforehand:

- Product model number, serial number, and date of purchase.
- Your computer configuration, including operating system, revision level, expansion cards, and software.
- Any error messages displayed at the time the error occurred.
- The sequence of operations that led up to the error.
- Any other information you feel may be of help.
Limited Warranty

ATEN warrants its hardware in the country of purchase against flaws in materials and workmanship for a Warranty Period of two [2] years (warranty period may vary in certain regions/countries) commencing on the date of original purchase. This warranty period includes the LCD panel of ATEN LCD KVM switches. Select products are warranted for an additional year (see A+ Warranty for further details). Cables and accessories are not covered by the Standard Warranty.

What is covered by the Limited Hardware Warranty

ATEN will provide a repair service, without charge, during the Warranty Period. If a product is defective, ATEN will, at its discretion, have the option to (1) repair said product with new or repaired components, or (2) replace the entire product with an identical product or with a similar product which fulfills the same function as the defective product. Replaced products assume the warranty of the original product for the remaining period or a period of 90 days, whichever is longer. When the products or components are replaced, the replacing articles shall become customer property and the replaced articles shall become the property of ATEN.

To learn more about our warranty policies, please visit our website: